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Introduction
This chapter provides an overview of the HP Universal CMDB (UCMDB) - HP ServiceManager
(SM) integration (also referred to as the Universal CMDB (UCMDB) integration or UCMDB-SM
integration throughout this document).

This chapter includes:

l "Who Should Read this Guide" below

l "Purpose of the Integration" below

l "How CI information is Synchronized Between UCMDB and ServiceManager" on page 16

Who Should Read this Guide
This guide is intended for a system implementer or system administrator who will be establishing
andmaintaining a connection between the UCMDB and ServiceManager systems. This guide
assumes that you have administrative access to both systems. The procedures in this guidemay
duplicate information available in your UCMDB and ServiceManager help systems, but is provided
here for convenience.

Note: This document replaces the following documents that have been published before this
release:

l HP Universal CMDB Integration Guide (for ServiceManager 9.30, dated July 2011)

l UCMDB-SM Integration Standards and Best Practices Guide (dated 31May 2010)

Purpose of the Integration
An integration between HP Universal CMDB (UCMDB) and HP ServiceManager enables you to
share information about the actual state of a configuration item (CI) between your UCMDB system
and a ServiceManager system. CIs commonly include IT services, hardware and software. Any
organization that wants to implement the best practices ConfigurationManagement and Change
Management ITIL processes can use this integration to verify that CIs actually have the attribute
values the organization has agreed to support.

You can use this integration to automate the creation of ServiceManager change or incident
records to update or rollback CIs that have unexpected attribute values. ServiceManager allows
you to programmatically define what actions you want to take whenever a CI’s actual state does
not match the expected state as defined in the CI record.

The integration offers several different ways for users to view CI actual state information:

l By default, the integration automatically updates themanaged fields of ServiceManager CI
records as part of the regular UCMDB synchronization schedule. You can choose the option to
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configure the integration to automatically create change or incident records instead.

l A ServiceManager user can view the current actual state of a CI by looking at the Actual State
section in the CI record. When you open the Actual State section, ServiceManager makes a
web services request to UCMDB and displays all CI attributes the request returns. Service
Manager only makes the web service call when you open this section.

l A ServiceManager user can use theView in UCMDB option to log in to the UCMDB system
and view the current CI attributes from UCMDB. The ServiceManager user must have a valid
UCMDB user name and password to log in to the UCMDB system.

Supported Use Cases
This section describes use cases that are supported by the UCMDB-SM integration. The supported
use cases provide the core business processes that are enabled by the UCMDB-SM integration.

There are four main business use cases supported by the UCMDB-SM integration. They are as
follows:

l Planned Change: A change created in SM through the formal SM change process.

l Unplanned Change: A change or incident that occurred in SM and does not conform to the formal
SM change process.

l Retrieving SM Ticket Information: The ability to view SM ticket information in UCMDB.

l Actual State: The ability to view the UCMDB CI information in SM.

All of the use cases provide important functionalities that enable the user to perform ITIL (IT
Infrastructure Library) processes. The ITIL processes refer to a set of best practices that define and
outline how organizations shouldmanage their IT.

Enabling ITIL Processes
By activating CI push from UCMDB to SM the user facilitates ITIL processes such as Incident,
Problem and ChangeManagement in SM.

SM utilizes the data pushed from UCMDB in the followingmodules:

l Incident Management: the Service Desk operator (SD Agent) selects the “Service” and the
“Affected CI” for the specific Incident record.

l ProblemManagement: the SD agent selects the “Service” and the “Primary CI” for the specific
Problem record.

l ChangeManagement: the SD agent selects the “Service” and the “Affected CI(s)” for the
specific Change record.

In each of the previously mentioned ITIL processes, SM utilizes CI information for Service,
Affected CIs and Primary CIs that all originate in UCMDB.

Universal Discovery Content Guide - ServiceManager Integration
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Managing Planned Changes
The purpose of the “Planned Change” use case is to provide IT organizations a formal process by
which changes to the IT infrastructure are introduced after thorough review and analysis. This is
performed according to the “ChangeManagement” process defined in ITIL v3.

A “Planned Change” is initiated by the SM user via the formal “ChangeManagement” process
module in SM. This is followed by the actual change implementation.

The actual changes are discovered by a discovery tool such as HP DDMA, and then updated in
UCMDB and the relevant modifications are pushed to SM. Once the user has validated the change,
the user closes the relevant planned change in SM.

Managing Unplanned Changes
The purpose of the “Unplanned Change” use case is to provide IT organizations a formal process by
which all changes that occur to the IT infrastructure are both logged and conventionalized through
the organizations formal approval process.

An “Unplanned Change” is a change that is recognized by a Discovery tool such as DDMA. The
change is first updated and visible in UCMDB and then the data is pushed to SM. SM recognizes
the change and as a result an “Incident” or “Change” record is generated.

These Changes are seen also in the SM “Pending Changes” section in the Configuration Item form,
once approved they aremoved to the SM “Historic Changes” section.

Retrieving Service Manager Ticket Information
Retrieving SM ticket information from within UCMDB provides all HP Software applications users
with access to this information by using UCMDB's federation capabilities and supporting APIs.
These applications include Business ServiceManagement (BSM), Asset Manager (AM),
Operations Orchestration (OO), etc.

SM ticket data is accessed from within UCMDB using UCMDB federation capabilities. SM ticket
data includes Incident, Problem and Change records as well as a key set of their attributes.

UCMDB enables users to create reports/views that combine the federated ticket data from SMwith
CI information from UCMDB.

Retrieving Actual State of UCMDB CIs
The purpose of “Actual State” is to enable SM users insight into CIs’ current state as detected by
“Discovery Tools” and populated in UCMDB. This state provides up-to-date information that may
vary from the information displayed in SM both in content and in scope.

The “Actual State” of the CI is displayed in SM in order to enable the user to validate the current
state of the CI that resides in UCMDB or in another data repository.

SM users retrieve the Actual State of CIs from UCMDB or additional data sources by viewing the
CI's Actual State section in the SM Configuration Item form.
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Accessing UCMDB CIs from Service Manager
SM users can open the UCMDB User Interface in the context of a specific CI, by clicking theView
in UCMDB button in the SM CI record. When the user clicks theView in UCMDB button, a
UCMDB login screen displays; After the user enters a UCMDB username and password, UCMDB
displays a topological view of the specific CI together with all related CIs that are linked to it.

Tip: You can configure Lightweight Single Sign-On (LW-SSO) for the integration, so that
ServiceManager web client users can bypass the UCMDB login screen after clicking theView
in UCMDB button. For more information, see "How to Enable Lightweight Single Sign-On
(LW-SSO) Configuration" on page 93.

If the UCMDB Browser URL is specified in the SM System Information Record, this button is
replaced by theView in UCMDB Browser button. When you click theView in UCMDB Browser
button, a UCMDB Browser login screen displays; After you enter a UCMDB Browser username
and password, the CI is displayed in the UCMDB Browser UI.

Core Features
This section explains the rudimentary concepts behind the Federation, Push, and Population
features as they pertain to the integration.

This section includes:

l "Push" below

l "Federation" on the next page

l " Population" on the next page

Push
UCMDB can automatically discover most types of CIs available in ServiceManager. This
integration enables you to push these types of CIs from UCMDB to ServiceManager.

The following figure shows how data is pushed from UCMDB to ServiceManager (SM). The data is
physically pushed (copied) from UCMDB to SM. Once the data is physically located in SM, the
data is utilized by the SM user that consumes this information in various SM processes.

Note: CI Type and Attribute Push
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Only information that is physically present in UCMDB can be pushed to SM.

Federation
With the federation feature, UCMDB pulls various ticket information (for example, Incident,
Problem, and Change ticket information) from SM. This enables users to see Ticket information in
UCMDB as Ticket CIs that are connected to the relevant Nodes.

When data is federated (reflected or mirrored) from SM to UCMDB, the data is not physically
present in UCMDB, instead it is passed over to UCMDB viaWeb Services.

Population
You can also use this integration to populate those types of CIs that UCMDB cannot automatically
discover or CIs that have been created in ServiceManager before you have a UCMDB system
deployed. For more information, see "When do I Need the Population Feature" on page 96.

Population is the reverse of Push. The following figure shows how data is populated from SM to
UCMDB. One SMCI record with multiple attributes is transferred to UCMDB as multiple CI
records.

How CI information is Synchronized Between
UCMDB and Service Manager

This section explains how CI information is transferred between the UCMDB and ServiceManager
systems.

This section includes:

l "CI Information Usage" on the next page

l "High-Level Components of the Integration" on the next page

l "Relationships Between Integration Components" on page 18

l "What Information is Stored in UCMDB" on page 18

l "What Information is Stored in ServiceManager" on page 19
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CI Information Usage
When referring to the concept of CI information it is important to make the distinction between a
UCMDB CI and a ServiceManager (SM) CI. The UCMDB model represents a topology that
contains a number of CI types and relationships.

The UCMDB topology can be represented in ServiceManager as a single entity. Multiple CIs from
UCMDB and their attributes aremerged into a single record in SM and the relevant UCMDB
attributes aremapped to their appropriate counterparts in the SM record.

The above figure shows the correlation between the UCMDB topological model and its
representation of the Computer Instance together with its parallel representation in SM. The SM
computer CI contains all of the UCMDB information that is passed through the integration.

In the push flow, in the UCMDB topological view several CIs such as Node, IP, Interface, Location,
File System, CPU, Disk Device and their Relationships are converted into a single SM computer
record with the IP, MAC Address and Location, File System, CPU and Disk Device attributes.

In the population flow, the conversion is reversed.

High-Level Components of the Integration
The following diagram shows the high-level components of the UCMDB integration, and illustrates
the interactions between UCMDB and ServiceManager.
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Relationships Between Integration Components
The following figure illustrates the relationships between the ServiceManager Adapter components
in UCMDB and the associated components in ServiceManager.

The ServiceManager Adapter includes configuration files, which are used tomapUCMDB entities
to their counterparts in ServiceManager during data push, as well as map ServiceManager CIs to
UCMDB entities during population.

The configuration files utilize UCMDB TQL queries that define a superset of data relevant for the
integration.

What Information is Stored in UCMDB
Your UCMDB system stores the actual state of CIs and CI relationships as CI attributes. Typically,
UCMDB uses one or more integrations and discovery mechanisms (feeders) to automatically
detect CI attribute values. The UCMDB-SM integration only uses a subset of the CI attributes
available in a UCMDB system.

For more information, see "Tailoring the Integration" on page 110.
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What Information is Stored in Service Manager
Your ServiceManager system stores themanaged or expected state of CIs and CI relationships as
attribute values in a CI record. To be part of the integration, a CI attribute in your UCMDB system
must map to amanaged field in the ServiceManager CI record. You can add, remove, or update the
managed fields that are part of the integration by tailoring the ServiceManager web services that
manage the integration.

ServiceManager runs according to a set of rules that define what actions you want the system to
take whenever a CI’s actual state does not match the expected state as defined in the CI record.
You define these rules from the Discovery Event Manager (DEM) in ServiceManager where you
can do the following:

l Automatically update a CI record tomatch the attribute values listed in the actual state. (This is
the default behavior.)

l Automatically create a change record to review the differences between the actual state and the
managed state.

l Automatically create an incident record to review the differences between the actual state and
themanaged state.
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Integration Setup
Before implementing the integration in your production environment, you can set up the integration
in a test environment using the out-of-the-box integration configurations. This chapter describes the
basic integration setup tasks without any tailoring or multi-tenancy configurations. It covers the
following topics:

l "Integration Requirements" below

l "How to Upgrade Your Integration" on the next page

l "Integration Setup Overview" on page 26

l "HP ServiceManager Setup" on page 27

l "HP Universal CMDB Setup" on page 29

l "Populating UCMDB with ServiceManager CI Data" on page 34

l "Pushing UCMDB CI Data to ServiceManager" on page 38

l "Federating SM Ticket Data to UCMDB" on page 44

Tip: Before you proceed to implementing the integration in your production environment, you
can refer to the following chapters for further information:

l "Multi-Tenancy (Multi-Company) Setup" on page 60, which describes how you set up the
integration in multi-tenancy mode.

l "Standards and Best Practices" on page 79, which describes best practices for
implementing the integration and also provides Frequently-Asked-Questions information.

l "Tailoring the Integration" on page 110, which describes how you can tailor the integration to
better suit your business needs.

l "Troubleshooting" on page 211, which provides information on troubleshooting data push
and population issues.

Integration Requirements
The supported product versions of this integration are listed in the following table.
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Service Manager UCMDB

9.30 + UCMDB Integration Content Pack
9.30.0 1

10.01 CP12 2, 10.10 CP13

9.31, 9.32 10.01 CP12, 10.10 CP13

Supported product versions

Youmust set up the following required components to establish an integration between UCMDB
and ServiceManager.

l HP Universal CMDB installation
Add a UCMDB Probe for the population feature if you do not already have one.

l HP ServiceManager installation
Add the UCMDB URL to the System Information Record. See "How to Add the UCMDB
Connection Information" on page 28.

l Network connection between the HP Universal CMDB andHP ServiceManager systems.

For instructions on installing and configuring your systems, see the UCMDB and ServiceManager
documentation.

How to Upgrade Your Integration
The UCMDB Integration Enhancement Content Pack 9.30.0 for ServiceManager 9.30 is already
included in the ServiceManager 9.32 applications, except for several code changes, which are not
included in order for backward compatibility. This means, to take advantage of the integration
enhancement in SM 9.32, extra steps are required to upgrade your existing SM-UCMDB integration
after you upgrade to ServiceManager applications 9.32. This section describes these upgrade
tasks.

Note: If you have already applied the UCMDB Integration Enhancement Content Pack 9.30.0
for ServiceManager 9.30, the integration has been upgraded and you need to do nothing. If you
do not want to upgrade your existing integration, you need to do nothing and your integration
can continue to work as before.

This task includes the following steps:

1The UCMDB Integration Content Pack 9.30.0 is available from the HP Live Network at:
https://hpln.hp.com. For instructions on installing the content package, see theServiceManager
9.30 Applications PatchManager Guide for Content Patches shipped with the content pack
release.
2CI data replication (push) from UCMDB to ServiceManager is supported for certain versions of
UCMDB earlier than 9.x with less content and limited error handling; however CI data population is
supported only for UCMDB 9.05 or later. For this reason, this document does not cover information
about integrating ServiceManager with earlier versions of UCMDB. For such information, see the
HP Universal CMDB to HP ServiceManager Integration Guide for ServiceManager version 9.20,
which is available from http://h20230.www2.hp.com/selfsolve/manuals.
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l "Modify the definitions of certain CI types in ServiceManager." below

l "Copy data to the joinnode table" on page 24

l "Align the SM CI relationship datamodel with the UCMDB datamodel." on page 25

l "Update the cirelationship dbdict." on page 26

1. Modify the definitions of certain CI types in Service Manager.

The SM-UCMDB integration enhancement uses the joinnode table for datamappings of the
following CI types: mainframe, networkcomponents, storage, and computer. The new data
mappings require certain changes bemade to these CI types in ServiceManager 9.32, as
described in the following tables.

Note: For backward compatibility, the definitions of all out-of-box CI types in Service
Manager 9.32 are identical to those in ServiceManager 9.30.

Field Old Value New Value
Removed
Subtypes

Format Name configurationItem configurationItemNode LPAR

Attr File networkcomponents node

Join Def joinnetworkcomponents joinnode

Bulk Update
Format Name

device.mainframe.bulkupdate device.node.bulkupdate

Changes required for Mainframe CI types

Added subtypes for Mainframe are:

n Logical Partition

n CPC

Field Old Value New Value
Removed
Subtypes

Format Name configurationItem configurationItemNode LB

Attr File networkcomponents node

Join Def joinnetworkcomponents joinnode

Bulk Update
Format Name

device.mainframe.bulkupdate device.node.bulkupdate

Changes required for Network Components CI types
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Added subtypes for Network Components are:

n LoadBalancer

n BandwidthManager

n CSU/DSU

n Ethernet

n FDDI

n KVM Switch

n Multicast Enabled Router

n Token Ring

n Voice Gateway

n Voice Switch

n VPN Gateway

n Wireless Access Point

Field Old Value New Value
Removed
Subtypes

Format Name configurationItem configurationItemNode N/A

Attr File storage node

Join Def joinstorage joinnode

Bulk Update
Format Name

device.storage.bulkupdate device.node.bulkupdate

Changes required for Storage CI types

Added subtypes for Storage are:

n SAN Gateway

n SAN Router

n SAN Switch

n Storage Array
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Field Old Value New Value
Removed
Subtypes

Format Name configurationItem configurationItemNode N/A

Attr File computer node

Join Def joincomputer joinnode

Bulk Update
Format Name

device.computer.bulkupdate device.node.bulkupdate

Changes required for Computer CI types

Added subtypes for Computer is:

n Virtualized System

To use the integration enhancement, youmust modify the following device type definitions in
ServiceManager: computer, networkcomponents, mainframe, and storage:

a. Log in to ServiceManager 9.32 as a system administrator.

b. Navigate toConfiguration Management > Resources > Device Types, and then click
Search.

c. Select one of the CI types (computer, networkcomponents, mainframe, and storage), and
update its definition as described in the above tables.

d. Repeat the steps above for the rest of the four CI types.

2. Copy data to the joinnode table

This task in optional. It is required only if you want to use the joinnode-based datamappings. If
you want to use the original tables instead of joinnode (see the above tables), this task is not
needed; instead, you need tomodify the datamappings of theService Manager 9.xx adapter
in UCMDB.

To copy your data from relevant tables to the joinnode table:

a. Log in to ServiceManager 9.32 as a system administrator.

b. In DatabaseManager, in the Table field type cidatacopy, and then click Search. The
Copy CI Type Data form opens.

c. Click Search. A list of records displays: joincomputer, joinmainframe,
joinnetworkcomponents, and joinstorage.

d. Select each record from the list, update or add source/target fields as needed, and click the
Copy Data button. One of the followingmessages occurs:
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i. A message like “<XXX> records were successfully copied, and <YYY> records were
ignored within xxx ms”, where XXX and YYY represent the numbers of records copied
and ignored.

ii. An error message: “Configuration validation failed, and no records were copied.
Please check your Source Fields/Target Fields settings and run Copy Data again.”

e. If the error message occurs, correct your Source Fields/Target Fields settings, and click
Copy Data again until all of your records have been successfully processed.

3. Align the SM CI relationship data model with the UCMDB data model.

To use the integration enhancement, you need tomanually update several records in Service
Manager to align the SM CI relationship datamodel (relationship types and subtypes) with that
of UCMDB, in order for easy datamapping between the two products.

a. Log in to ServiceManager as a system administrator.

b. In Script Library, open theEnableUcmdbIntegrationUI script.

c. Click Execute. Running this script will automatically rename each record in the table below
to <record_name>.bak.932, and replace them with new records with the original record
names.

Record Type Record Name

Format CM.relationship

CM.relationship.qbe

CM.relationship.type

CM.relationship.type.qbe

dataModEventRel.relationship.detail

dataModEventRel.relationship.qbe

am.downstream.relationships.vj

am.upstream.relationships.vj

Extaccess Relationship

Format Control CM.relationship

CM.relationship.type

dataModEvent.relationship

Records replaced and renamed
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d. Verify that the CI relationship form looks like the following:

If you tailored any of these records in the above table, open the <record_name>.bak.932 record
to identify the differences, andmerge your customizations in the new record.

4. Update the cirelationship dbdict.

The data length of CI relationship name in ServiceManager is 40 characters, which is not
sufficient for the integration. If a CI relationship name exceeds this data length, either the
relationship name is truncated after push or the relationship cannot be pushed to Service
Manager due to a duplicate key error. You need tomanually increase the data length in Service
Manager:

a. Open the cirelationship table in Database Dictionary.

b. Increase the data length of the relationship.name field from 40 to an appropriate value
(recommended value: 300).

c. Save the record.

Integration Setup Overview
The integration requires setup on both the UCMDB and ServiceManager systems.

This task includes the following steps:
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1. Set up the ServiceManager system.
See "HP ServiceManager Setup" below.

2. Set up the UCMDB system.
See "HP Universal CMDB Setup" on page 29.

3. Run the UCMDB population jobs to synchronize CIs to UCMDB.
See "Populating UCMDB with ServiceManager CI Data" on page 34.

4. Run the UCMDB data push jobs to transfer CIs to ServiceManager.
See "Populating UCMDB with ServiceManager CI Data" on page 34.

HP Service Manager Setup
Youmust complete the following tasks from your ServiceManager system to support the
integration.

1. Create a dedicated integration user account in ServiceManager.
See "How to Create an Integration User Account" below.

2. Add the UCMDB connection information to the system information record.
See "How to Add the UCMDB Connection Information" on the next page.

How to Create an Integration User Account
This integration requires an administrator user account for UCMDB to connect to ServiceManager.
This user account must already exist in both UCMDB and ServiceManager.

To create a dedicated integration user account in ServiceManager:

1. Log in to ServiceManager as a system administrator.

2. Type contacts in the ServiceManager command line, and press ENTER.

3. Create a new contact record for the integration user account.
a. In the Full Name field, type a full name. For example, UCMDB905x.

b. In the Contact Name field, type a name. For example, UCMDB905x.

c. Click Add, and thenOK.

4. Type operator in the ServiceManager command line, and press ENTER.

5. In the Login Name field, type the username of an existing system administrator account, and
click Search.
The system administrator account displays.
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6. Create a new user account based on the existing one.
a. Change the Login Name to the integration account name you want (for example, ucmdb).

b. Type a Full Name. For example, UCMDB.

c. In the Contact ID field, click the Fill button and select the contact record you have just
created.

d. Click Add.

e. Select theSecurity tab, and change the password.

f. Click OK.

The integration user account is created. Later you will need to add this user account
(username/password) in UCMDB, and then specify this user account in the Credentials ID field
when creating an integration point in UCMDB. See "How to Create an Integration Point in UCMDB"
on the next page.

How to Add the UCMDB Connection Information
The integration requires the UCMDB connection information to obtain CI attribute information from
the UCMDB system, and display it in the Actual State section in the ServiceManager configuration
item form.

Caution: If you do not specify the correct connection information, an error, instead of UCMDB
CI information, will display in the Actual State section.

Note: The integration with UCMDB Browser is supported only for ServiceManager 9.31 or
later.

This task includes the following steps:

1. Log in to ServiceManager as a system administrator.

2. Click System Administration > Base System Configuration >Miscellaneous > System
Information Record.

3. Click theActive Integrations tab.

4. Select theHP Universal CMDB option.
The form displays the UCMDB web service URL field.

5. In the UCMDB webservice URL field, type the URL to the HP Universal CMDB web service
API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService
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Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

6. In UserId and Password, type the user credentials required tomanage CIs on the UCMDB
system. For example, the out-of-the-box administrator credentials are admin/admin.

7. Optionally, if you want to enable an integration to the UCMDB Browser, in the UCMDB
Browser URL field, type your UCMDB Browser URL in the following format:
http://<UCMDB browser server name>:<port>/ucmdb-browser

For example: http://myucmdbbrowserserver:8081/ucmdb-browser

The UCMDB Browser has two themes. By default, it uses the dark color theme; if you want to
use the light color theme, use this format for the UCMDB Browser URL:

http://<UCMDB browser server name>:<port>/ucmdb-browser/?theme=LIGHT

Note: If you specify the UCMDB Browser URL here, theView in UCMDB Browser
button will replace theView in UCMDB button in CI records synchronized from UCMDB;
only when you leave this field empty, theView in UCMDB button will appear.

8. Click Save. ServiceManager displays themessage: Information record updated.

9. Log out of the ServiceManager system.

10. Log back into the ServiceManager system with an administrator account.

The Actual State section and theView in UCMDB Browser or View in UCMDB button will be
available in CI records pushed from UCMDB.

HP Universal CMDB Setup
Youmust complete the following tasks from your UCMDB system to support the integration.

1. Create an integration point between UCMDB and ServiceManager.
See "How to Create an Integration Point in UCMDB" below.

2. Update the configuration files of the adapter.
See "How to Update the Time Zone and Date Format for the Integration Adapter" on page 33.

How to Create an Integration Point in UCMDB
A default UCMDB installation already includes the ServiceManagerAdapter9-x package. To use the
integration package, youmust create an integration point listing the connection properties for the
integration.

Caution: For data population, this integration supports the use of only one probe for your
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ServiceManager system. In other words, you should not run population jobs on different
probes by setting upmultiple integration points with different probes for your ServiceManager
system. Only one probe is allowed for one ServiceManager system.

To create an integration point:

1. Log in to UCMDB as an administrator.

2. Add the integration user account that you created in ServiceManager.
a. Click Administration > Users and Roles.

b. Click theAdd New User button .

c. For User Name and Password, type the user name and password you created in Service
Manager. See "How to Create an Integration User Account" on page 27.

d. Click Next, and then in the Role List select Admin.

e. Click Finish. The integration user account is added.

3. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

4. Click theNew Integration Point button .
UCMDB displays a New Integration Point properties window.

5. Complete the integration and adapter property fields as described in the following table.

Field name
Is
required? Description

Integration
Name

Yes Type the name (unique key) of the integration point. For
example, Population_CI_From_S.

Integration
Description

No Type a description of current integration point.

Integration and adapter properties (UCMDB 10.01 or later)
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Field name
Is
required? Description

Adapter Yes For UCMDB 9.05:

Select HP BTO Products or HP Software Products >
Service Manager > Service Manager 9.xx.

For UCMDB 10:

Select HP Software Products > Service Manager > Service
Manager 9.xx.

Note: This adapter, which supports CI/relationship Data
Push from UCMDB to ServiceManager, and Population
and Federation from ServiceManager to UCMDB, is
available out-of-the-box only in UCMDB version 9.05 or
later.

Is Integration
Activated

Yes Enable this option to indicate the integration point is active.

Hostname/IP Yes Type the hostname or IP address of the ServiceManager
server.

For example, localhost.

Port Yes Type the communications port of the ServiceManager server.
For example, 13080.

Integration and adapter properties (UCMDB 10.01 or later), continued
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Field name
Is
required? Description

URL
Override

No This field value (if any) supersedes the Hostname/IP and Port
settings described above.

Use this field If you want UCMDB to connect to Service
Manager in any combinations of the following ways:

n Connect to ServiceManager over HTTPS or over both HTTP
and HTTPS

n Connect to multiple ServiceManager server nodes
(vertically scaled environment)

n Connect to one single ServiceManager server node through
multiple ports (horizontally scaled environment)

For more information, see "Push in Clustered Environments" on
page 84.

Type one or more ServiceManager web services URLs
(separated by a semicolon) in this field.

The following are two example values of this field (each URL
should use this format: http
(s)://<hostname>:<port>/sc62server/ws):

n https://localhost:13443/sc62server/ws

n http://localhost:13080/sc62server/ws;
https://localhost:13443/sc62server/ws;
http://smfpe04:13080/sc62server/ws

Credentials
ID

Yes Click Generic Protocol, click theAdd button to add the
integration user account you created, and then select it. This
account must exist in both ServiceManager and UCMDB. See
"How to Create an Integration User Account" on page 27.

Probe Name Yes Select the name of the Data Flow Probe used to run population
jobs. You should have already added the data flow probe for the
integration after installing UCMDB. See "Integration
Requirements" on page 20.

Integration and adapter properties (UCMDB 10.01 or later), continued

6. Click Test Connection to make sure that a successful connection is created.

7. Click OK.
The integration point is created and its details are displayed.
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8. Click the Federation tab, and complete the following configuration.
a. In Supported and Selected CI Types, select the following CI types as needed from

Managed Object > ItProcessRecord:
i. Incident

ii. Problem

iii. Request for Change

b. For each CI type you selected (Incident, Problem, or Request for Change), in CI Type
Retrieval Mode select Retrieve CIs of selected CI Type.

9. Click thePopulation andData Push tabs, to view the default integration job details.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. If needed, you can create a new job for the integration point. For
information about creating integration jobs, see "How to Define Data Push Jobs in
UCMDB" on page 38 and "How to Define Population Jobs in UCMDB" on page 35.

10. Click theSave Integration Point button .

How to Update the Time Zone and Date Format for
the Integration Adapter

The integration uses an integration user account to connect UCMDB to ServiceManager. You
specified this user account in the Credentials ID setting when creating an integration point. See
"How to Create an Integration Point in UCMDB" on page 29. Youmust make sure that this
integration user account uses the same time zone and date format in both ServiceManager and
UCMDB. To do so, you define the same time zone and date format in the integration adapter
configuration file and in the integration user’s operator record in ServiceManager.

To update the time zone and date format for the integration adapter:

1. Check or change the time zone and date format of the integration user in ServiceManager.
a. Log in to ServiceManager as a system administrator.

b. Navigate toSystem Administration > Ongoing Maintenance > Operators. The
Operators form opens.
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c. For Login Name, type the integration user name (for example, ucmdb) you set in the
integration point (the Credentials ID field).

d. Click Search. ServiceManager displays the record of the operator.

e. Click the Login Profiles tab.

f. View or change the operator’s Time Zone and Data Format field values.

2. Set the time zone and date format for the adapter in UCMDB.
a. Log in to UCMDB as an administrator.

b. Navigate toData Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files > serviceDeskConfiguration.xml.

c. At the bottom of the file, locate the elements “<date_pattern>” and “<time_zone>”, and
update the values according to the integration user’s time zone/date format setting in
ServiceManager.

The date pattern and time zone are in java format pattern used by
java.text.SimpleDateFormat. Out-of-the-box, the date format and time zone values in
serviceDeskConfiguration.xml are: MM/dd/yy HH:mm:ss, and US/Mountain.

Populating UCMDB with Service Manager CI
Data

In addition to pushing CI data from UCMDB to ServiceManager, this integration also supports the
population of CI data (including CIs and CI relationships) from ServiceManager to UCMDB. The
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integration can then update the list of CIs in UCMDB if new CIs or new attribute values are found in
ServiceManager. The population of data from ServiceManager to UCMDB is defined in the
Integration Studio in UCMDB. You canmanually run the population jobs, however HP recommends
that you schedule these jobs to keep your CIs and CI attributes up to date.

This task includes the following steps:

1. Define CI/CI Relationship population jobs in UCMDB.
See "How to Define Population Jobs in UCMDB" below.

2. View the transferred CI/CI Relationship data in UCMDB.
See "View ServiceManager CI Data in UCMDB" on page 37.

3. Schedule CI population jobs to keep CIs and CI attributes up to date.
See "How to Schedule CI Population Jobs" on page 37.

How to Define Population Jobs in UCMDB
A CI/CI relationship population job copies certain types of CIs/CI relationships from Service
Manager to UCMDB.

To define a CI or CI relationship population job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

3. Open an integration point.

4. Click thePopulation tab, and add a new job as follows.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. The following table lists the default population jobs and their Topology
Query Language (TQL) queries. If needed, you can create, update or remove TQL queries
for each job. For information about tailoring population TQL queries, see "Create a TQL
Query to Populate the CI Type" on page 183.
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Integration Job TQL queries for CI / CI relationship population

SMConfiguration
Item Population
job

Out-of-the-box, the following TQL queries are available for this job,
which populates CI records from ServiceManager to UCMDB:

n SM Business Service Population: Populates CIs of the bizservice
type.

n SM RunningSoftware Population: Populates CIs of the
RunningSoftware type.

n SM Computer Population: Populates CIs of the computer type.

SM Relations
Population job

Out-of-the-box, the following TQL queries are defined for this job, which
populates CI Relationship records from ServiceManager to UCMDB:

n SM Biz To Biz With Containment: Populates CI relationships in
which a bizservice CI contains another.

n SM Biz To Biz With Usage: Populates CI relationships in which a
bizservice CI uses another.

n SM Biz To Computer With Containment: Populates CI
relationships in which a bizservice CI contains a computer CI.

n SM Biz To Computer With Usage: Populates CI relationships in
which a bizservice CI uses a computer CI.

n SM Computer To Computer With Connects: Populates CI
relationships in which a computer CI connects to another.

TQL queries for CI / CI relationship population

a. Click theNew Integration Job button .

b. Type a Name for the integration job. For example, CI_Population_Job1.

c. Click theAdd Query button to add existing TQL queries to the job (see the above
table).

d. Select theAllow Integration Job to delete removed data check box for the query.

e. Click OK to save the job.

5. Run the jobmanually to see if the integration job works properly.

a. To populate all relevant data for the job, click the button.

b. To populate only CI data changes since the job last ran, click the button.
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6. Wait for the job to complete, and click theRefresh buttonmultiple times as needed until the job
is completed.

Note:When the job is completed, the job status becomes one of the following:
Succeeded, Passed with failures, or Failed.

7. Click theStatistics tab to view the results, and if the job failed, click theQuery Status tab and
Job Errors tab for more information. For details, see "Troubleshooting Population Issues" on
page 237.

8. Click OK.

If the job is completed successfully, you can view the transferred CI data in UCMDB and schedule
the job so that it can run automatically.

View Service Manager CI Data in UCMDB
After a population job is successfully completed, you can search for the ServiceManager CI
records in UCMDB, and verify that their attributes are correctly populated.

The ServiceManagerCI Identifierfield is populated to theName field on the Configuration Item
Properties pane in UCMDB.

Note: To see the entire attributemappings of a CI type, you can open the CI type’s population
XSLT file (for example, business_service_population.xslt) and the root population xslt file
(cmdb_root_attributes_population.xslt), where the UCMDB attribute field names and the
mapped ServiceManager web service field caption names are defined. For more information,
see "Tailoring the Integration" on page 110
.

How to Schedule CI Population Jobs
You can schedule CI population jobs tomatch the discovery/maintenance schedule of your Service
Manager feeders. For example, if your ServiceManager feeders send CI data updates on a daily
schedule, then the population jobs should also run on a daily schedule. By using amatching
schedule you can ensure that your UCMDB system always has themost current CI data.

This task includes the following steps:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of
integration points.

3. Open an integration point.

4. Click thePopulation tab, and select a population job from the list.
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5. Click theEdit Integration Job button.

6. Select theScheduler enabled option.

7. Select the scheduling options you want to use. For example, select Repeat every: Day and
Ends: Never.

8. Select a Time Zone.

9. Click OK.

Pushing UCMDB CI Data to Service Manager
The integration requires a one-time transfer of CIs from UCMDB to ServiceManager to populate the
ServiceManager system with CIs. The integration will then update the list of CIs in Service
Manager when UCMDB discovers new CIs or new attribute values. The integration accomplishes
the push of CI data using data push jobs in the UCMDB system. HP recommends that you
schedule these jobs to keep your CIs and CI attributes up to date.

This task includes the following steps:

1. Define CI/CI Relationship data push jobs.
See "How to Define Data Push Jobs in UCMDB" below.

2. View the CI/CI Relationship data pushed from UCMDB.
See "How to View UCMDB CI Data in ServiceManager" on page 41.

3. Schedule data push jobs to keep CI/CI Relationship data up to date.
See "How to Schedule Data Push Jobs" on page 42.

How to Define Data Push Jobs in UCMDB
Data push jobs copy CI or CI Relationship records from your UCMDB system to your Service
Manager system.

To define a CI or CI relationship push job:

1. Log in to UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

3. Select the Integration Point you created for ServiceManager. For example, SM Integration.

4. Click theData Push tab.
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5. Add a new data push job as follows.

a. Click theNew Integration Job button .

Note: UCMDB creates a default data push job when creating an integration point. The
following table lists the default data push job and its Topology Query Language (TQL)
queries. If needed, you can create, update or remove TQL queries for the push job. To
access these out-of-the-box TQL queries for push, go toModeling >Modeling Studio >
Resources, select Queries for Resource Type, and then navigate toRoot > Integration
> SM Sync > 9.xx. For information about tailoring data push TQL queries, see "How to
Create a TQLQuery to Synchronize the CI Type" on page 153.

Integration
job TQL queries

Integration
job

TQL queries

TQL queries for CI / CI relationship push
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Integration
job TQL queries

SM Push
job

Out-of-the-box, the following TQL queries are available for this job, which
pushes CI/CI Relationship records from UCMDB to ServiceManager:

n SM Mainframe Push: pushes CIs of themainframe type.

n SM Network Component Push: pushes CIs of the network component
type.

n SM Running Software Push: pushes CIs of the running software type.

n SM Business Service Push: pushes CIs of the business service type.

n SM Computer Push: pushes CIs of the computer type.

n SM Storage Push: pushes CIs of the storage type.

n SM Switch Push: pushes CIs of the switch type.

n SM Net Printer Push: pushes CIs of the net printer type.

n SM Cluster Push: pushes CIs of the cluster type.

n SM Mobile Device Push: pushes CIs of themobile device type.

n SM Local Printer Push: pushes CIs of the local printer type.

Out-of-the-box, the following TQL queries are available for this job, which
pushes CI Relationship records from UCMDB to ServiceManager:

n SM Layer2 Topology Relations Push: pushes compound CI
relationships between nodes.

n SM Business Service Relations Push: pushes CI relationships whose
upstream CI type is business service.

n SM CRG Relations Push: pushes CI relationships whose upstream CI
type is cluster.

n SM Node Relations Push: pushes direct CI relationships whose
upstream CI type is node.

TQL queries for CI / CI relationship push , continued

b. In Name, type a unique name for the job. For example, CI_Push_Job1.

c. Click theAdd Query button to add existing TQL queries to the job.
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d. Select theAllow Integration Job to delete removed data option for each query.

e. Click OK to save the job.

6. Run the jobmanually to see if the integration job works properly.

Caution: If you have a huge amount of CI data in your UCMDB system, and this is your
first time to push CI /CI Relationship data to ServiceManager, it is recommended to
select the “Add the record” option instead of “Open a change” or “Open an incident” for
“Action if matching record does not exist” in each Discovery Event Manager Rules
definition. Otherwise unnecessary performance problems might occur. For details, see
"Add Discovery Event Manager Rules" on page 131.

a. To push all relevant data for the job, click the button.

b. To push only changes in the data since the job last ran, click the button.

Tip: You can stop a running push job by pressing theStops the selected job button .

7. Wait for the job to complete, and click theRefresh buttonmultiple times as needed until the job
is completed.

Note:When the job is completed, the job status becomes one of the following depending
on the results: Succeeded, Passed with failures, or Failed.

8. Click theStatistics tab to view the results; if any errors occur click theQuery Status tab and
Job Errors tab for more information. For details, see "Troubleshooting Data Push Issues" on
page 211.

9. Click OK.

If the job is completed successfully, you can view the UCMDB CI data in ServiceManager, and
schedule the job so that it can run automatically.

How to View UCMDB CI Data in Service Manager
After a push job is successfully completed, you can search for and verify the pushed CI/CI
relationship data in ServiceManager.

CI records pushed from UCMDB contains aView in UCMDB orView in UCMDB Browser
button, which enables you to access UCMDBor the UCMDB Browser to view the CI information.

Note:
l If you specified the UCMDB Browser URL in the System Information Record in SM, the

View in UCMDB Browser button displays; otherwise theView in UCMDB button
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displays.

l The UCMDB Browser is a lightweight UI designed for simple access to UCMDB
configuration information. This is a tool for searching, locating and consuming configuration
related data. It is an optional add-on to UCMDB. For more information, refer to the UCMDB
Browser documentation.

To view UCMDB CI data in ServiceManager:

1. Log in to ServiceManager as a system administrator.

2. Navigate toConfiguration Management > Search CIs.

3. Open a CI record pushed from UCMDB.

4. If theView in UCMDB button is available, view the CI record in UCMDB.
a. Click theView in UCMDB button. The UCMDB login screen opens.

b. Type a UCMDB username and password to log in.

The CI record opens in UCMDB. You can view its properties.

Note: You can enable Lightweight Single Sign-On (LW-SSO) for the integration so that
ServiceManager web client users can bypass the UCMDB login screen. For details, see
"How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 93.

5. If theView in UCMDB Browser button is available, view the CI record in the UCMDB
Browser.
a. Click theView in UCMDB Browser button. The UCMDB Browser login screen opens.

b. Type a UCMDB Browser username and password to log in. The CI record opens in the
UCMDB Browser. You can view its properties and other information.

6. Open theActual State section.
ServiceManager makes a web services request to UCMDB and displays all CI attributes the
request returns.

Note: The web services request uses the UCMDB webservice URL and account (for
example, admin/admin) defined in the System Information Record in ServiceManager.
See "How to Add the UCMDB Connection Information" on page 28.

How to Schedule Data Push Jobs
It is a best practice to schedule the data push jobs tomatch the discovery schedule of your Service
Manager feeders. For example, if your ServiceManager feeders send CI data updates on a daily
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schedule, the data push jobs should also run on a daily schedule. By using amatching schedule
you can ensure that your ServiceManager system always has themost current CI data.

UCMDB allows you to schedule updates directly from a data push job. This task includes the
following steps:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio. UCMDB displays a list of
integration points.

3. Select the integration point you created for the UCMDB-SM integration. For example, SM
Integration.

4. Click theData Push tab.

5. Select a push job. For example, SM Configuration Item Push Job.

6. Click theEdit Integration Job button .

Tip: UCMDB allows you to define two different schedules for two types of data push:
Changes Sync, and All Data Sync. For recommendations on push scheduling, see "Push
Scheduling Recommendations" on page 82.

7. Define a schedule for Changes Sync.
a. Click theChanges Sync tab.

b. Select theScheduler enabled option.

c. Select the scheduling options you want to use.
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8. Click All Data Sync tab, and select the scheduling options you want to use.

9. Click OK to save the data push job.

10. Repeat step 6 to step 9 for the rest of data push jobs of the integration point.

11. Save the integration point.

Federating SM Ticket Data to UCMDB
Federation does not physically copy SM data to UCMDB; it only retrieves SM data for displaying in
UCMDB. Out-of-the-box, the UCMDB-SM integration supports federation for the following external
CI types in UCMDB: Incident, Problem, and RequestForChange. If you have enabled these CI
types for federation when creating your integration point, in UCMDB you can retrieve the following
types of ticket data from ServiceManager: Incident, Problem, and Change.

This section includes:

l "Federation TQL queries" below

l "Examples of Using Federation" below

Note: You can tailor the integration to federatemore SM ticket attributes to UCMDB. For
details, see "How to Add an Attribute of a Supported CI Type for Federation" on page 205.

Federation TQL queries
Federation uses TQL queries to determine what data to retrieve from ServiceManager. To retrieve
specific ticket data from ServiceManager, you need to create a TQL query first. Out-of-the-box,
sample federation TQL queries are available from UCMDB:Modeling >Modeling Studio >
Resources > View > Service Desk.

Examples of Using Federation
You can use the federation feature in many different ways. The following are only examples of using
the feature.

This section includes:

l "Example 1: Federate All SM Incident Tickets" on the next page

l "Example 2: Federate SM Incident Tickets that Affect a UCMDB Business Service CI" on page
49

l "Example 3: Federate SM Incident, Change and Problem Ticket Data of UCMDB CIs" on page
54

l "Example 4: Get Related SM Ticket Data of a UCMDB CI" on page 57
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Example 1: Federate All SM Incident Tickets
This example illustrates how you retrieve information of all Incident records that exist in Service
Manager.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio > Resources.

3. For Resource Type, select Queries from the list.

4. Click New > Query.

5. On the CI Types tab, go to ItProcessRecord > Incident, and drag it to the query pane on the
right side.

6. Specify ServiceManager as the data source for the Incident query node.
a. Select the Incident query node, click theData Sources tab on the lower right pane, and

then click Edit.

b. Select theSelect integration points option, and then select your integration point name
(for example, sm_integration). Click OK.
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7. Click theSave button , and then type a query name and select a location to save the query
(for example, select theRoot > Integration > SM Query folder).
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8. Select the Incident query node, and then click theCalculate Query Result Count button .
UCMDB returns the query result count. For example, the following figure shows that there are
131 Incident records in total in ServiceManager.

9. Right-click the Incident query node, and select Show Element Instances. UCMDB displays a
list of all Incident records that exist in ServiceManager.
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10. Select an Incident ticket from the list, and click theProperties button to view its details.

Example 2: Federate SM Incident Tickets that Affect a
UCMDB Business Service CI

The following example illustrates how you federate a list of ServiceManager Incident records
whose Affected Service or Affected CI field contains a UCMDB Business Service CI.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio > Resources.

3. For Resource Type, select Queries from the list.

4. Click New > Query.

Universal Discovery Content Guide - ServiceManager Integration
Integration Setup

Page 49 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



5. On the CI Type tab, go toConfigurationItem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

6. Go to ItProcessRecord > Incident, and drag it to the query pane.

7. Click theCreate Relationship button .

8. Select the Incident query node, and drag the arrow from this node to the BusinessService node
to create a regular relationship between the nodes.
a. Select Regular Relationship, and click OK.

b. SelectMembership, and optionally enter a relationship name (for example,Membership_
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1). Click OK.

9. Specify UCMDB as the data source for the BusinessService query node.
a. Select the BusinessService query node.

b. On the lower right pane, click theData Sources tab and then click Edit.

c. Make sure that the Local data source (UCMDB only) option is selected.
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d. Click OK.

10. Similarly, specify your integration point as the data source for the Incident query node (for
example, sm_integration).
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11. Click theCalculate Query Result Count button . The number of SM Incidents and the
number of their affected UCMDB Business Service CIs display.
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12. Click thePreview button to view the query result .

13. Select each SM Incident record from either the CI Selector pane or the query pane, and click

theProperties button to view its details .

14. Select each UCMDB CI record from either the CI Selector pane or the query pane, and on the
Related CIs tab click Show Related CIs.

Example 3: Federate SM Incident, Change and Problem
Ticket Data of UCMDB CIs

The following example illustrates how you retrieve information of SM Incident, Change and Problem
tickets that affect a UCMDB Business Service CI.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio > Resources.
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3. For Resource Type, select Queries from the list.

4. Click New > Query.

5. On the CI Type tab, go toConfigurationItem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

6. Go to ItProcessRecord, and drag Incident, Problem, andRequestForChange to the query
pane.

7. Click theCreate Relationship button to create regular relationships between the
BusinessService node and the other nodes as shown in the following figure.

8. For the BusinessService node, specify UCMDB as the data source.

9. For the Incident, Problem, and RequestForChange nodes, specify your integration point as the
data source.

10. Save the query.
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11. Optionally, edit the BusinessService node properties as needed.
a. Select the BusinessServic node, and click Edit on the lower right pane.

b. Click theCardinality tab. The default Cardinality setting displays.

c. If you wish, change either or both of theAND operators toOR.

d. This will change the filter criteria and therefore the query result.

12. Click thePreview button to view the query result.
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13. Select each SM Incident record from either the CI Selector pane or the query pane, and click

theProperties button to view its details.

14. Select each UCMDB CI record from either the CI Selector pane or the query pane, and on the
Related CIs tab click Show Related CIs to view its related CIs in both SM andUCMDB.

Example 4: Get Related SM Ticket Data of a UCMDB CI
The following example illustrates how you retrieve SM ticket data related to a UCMDB CI by using
the Get Related CIs functionality.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling > IT Universe Manager.

3. On theSearch CIs tab, search for a UCMDB CI that has associated ticket(s) in Service
Manager. For example, enter bs1327232399 in the CI Name field, click Search, and double-
click the CI to open it.

4. Click theShow Get Related CIs pane button .
TheGet Related CIs pane displays.
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5. Click theSelect target Integration Points for related CIs button .

6. Select theSelect integration points option, and then select bothUCMDB and your
integration point. Click OK.
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7. Click Show Related CIs. The CI’s related SM tickets and UCMDB CIs display.

8. Select each SM ticket record from the query pane, and click theProperties button to view
its details.
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Multi-Tenancy (Multi-Company) Setup
The UCMDB-SM Integration supports amulti-tenancy configuration in which both the Service
Manager and UCMDB systems track Configuration Items (CIs) and Configuration Item
Relationships (CIRs) by company ID. In amulti-tenancy configuration, you can tailor the integration
so that each tenant only sees and works with the CIs and CIRs that match their company ID. Multi-
tenancy is intended for managed service providers (MSPs) who wish to offer Configuration
Management as a service tomultiple tenants.

This chapter includes:

l "Multi-Tenancy (Multi-Company) Support" below

l "Multi-Tenancy Requirements" on page 67

l "Setting up theMulti-Tenancy Integration in UCMDB" on page 68

l "Setting up theMulti-Tenancy Integration in ServiceManager" on page 71

Multi-Tenancy (Multi-Company) Support
Multi-tenancy is when a single instance of software runs on a server, servingmultiple client
organizations (also referred to as tenants).

Multi-tenancy contrasted with amulti-instance architecture where separate software instances or
hardware systems are set up for different client organizations.

When implementing amulti-tenant architecture, a software application is designed to virtually
partition its data and configuration so that each client organization works with a customized virtual
application instance. The following figure illustrates an examplemulti-tenant integration
deployment.

Explanation

Every tenant configured in UCMDB works with the relevant tenant in SM. If UCMDB did not
configure tenants, the tenant configurationmust be activated in order to transfer the configuration
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from SM to UCMDB automatically. This function is performed once only by the system
administrator.

In the event that UCMDB tenant configuration already exists and the SM configuration does not
exist, SM tenant must bemanually configured according to the UCMDB configuration.

Implementing Multi-Tenancy in the UCMDB-SM
Integration

SM stores the company records that describe each tenant in themulti-tenant configuration. The
ServiceManager system is the definitive source for company records and pushes all new company
IDs to the UCMDB system creating the equivalent entity in UCMDB.

SM tracks the company ID of each CI and relationship in amulti-tenant configuration. CI records
inherit the company ID of the UCMDB feeder that discovered them. Relationship records inherit the
company ID of the parent CI in the relationship.

Mandanten SM Security Layer
Mandanten is an SM software layer that is used to filter the customer ID from the CI information.
SM uses theMandanten to ensure that operators only see CI and relationship records where the
CI's company ID matches the operator's company ID. If the view is restricted with Mandanten,
then ServiceManager also restricts the view to all other related records such as change requests
and incidents.

What Multi-Tenant Information is Stored in UCMDB
Your UCMDB system stores a company ID attribute for each CI and CIR. The company ID
determines what adapter and synchronization schedule your UCMDB system uses to update CI
data. Each CI and relationship record can only have one company ID. The UCMDB system obtains
a company ID from the ServiceManager system.

If more than one tenant (company) shares the sameCI, each tenant has their own unique CI record
describing the CI. In effect, the UCMDB system creates multiple CI records to track onemanaged
asset. Each tenant’s CI record is unique to that tenant and lists the company's unique company ID.

What Multi-Tenant Information is Stored in Service
Manager

Your ServiceManager stores the company records that describe each tenant in themulti-tenant
configuration. The ServiceManager system is the definitive source of company IDs and pushes
new and updated information to your UCMDB system.

ServiceManager tracks the company ID of each CI and relationship in amulti-tenant configuration.
CI records inherit the company ID of the UCMDB feeder that discovered them. Relationship
records inherit the company ID of the parent CI in the relationship.

In a best practices implementation, ServiceManager uses Mandanten to ensure that operators only
see CI and relationship records where the CI’s company ID matches the operator’s company ID. If
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you restrict the view with Mandanten, then ServiceManager also restricts the view to all other
related records such as change requests and incidents.

Unique Logical Names
ServiceManager requires that all CIs have unique logical names. If the logical name generation
process produces a duplicate logical name value, ServiceManager appends an underscore and a
number to the end of logical name tomake it unique. For example, if two CIs would have the logical
namemytesthost, then the second CI will instead have the namemytesthost_1. A second
duplicate CI would have the namemytesthost_2.

Synchronization of Company Records
If your systemmeets all the conditions for multi-tenancy support, ServiceManager creates a
schedule record to push the company ID of the company record to your UCMDB system. Service
Manager uses the following rules to determine whether to push the company ID to your UCMDB
system.

Conditions

Tenant
information
synchronized?

Schedule record created
and action taken in
UCMDB

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You create a new company record in Service
Manager

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Add new company ID

l UCMDB-SM integration enabled

l You update an existing company record that
has not been synchronized with UCMDB

l Multi-company mode enabled in Service
Manager

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Add new company ID

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You disable the option to show a company in
multi-company lists on a company
synchronized with UCMDB

Yes Inactivate Company with
UCMDB - <UCMDB
Company ID>

l Inactivate existing
company ID

Conditions where Service Manager synchronizes company ID with UCMDB
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Conditions

Tenant
information
synchronized?

Schedule record created
and action taken in
UCMDB

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You select the option to resynchronize with
UCMDB on an existing company record

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Add new company ID

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You enable the option to show a company in
multi-company lists for an inactivated
company

Yes Synch Company with
UCMDB - <UCMDB
Company ID>

l Reactivate company
ID

l UCMDB-SM integration disabled

l Multi-company mode enabled in Service
Manager

l You update an existing company record that
has already been synchronized with UCMDB

No None

l UCMDB-SM integration disabled

l Multi-company mode enabled in Service
Manager

l You create a new company record in Service
Manager

No None

l UCMDB-SM integration enabled

l Multi-company mode enabled in Service
Manager

l You disable the option to show a company in
multi-company lists on a company not
synchronized with UCMDB

No None

Conditions where Service Manager synchronizes company ID with UCMDB, continued
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Conditions

Tenant
information
synchronized?

Schedule record created
and action taken in
UCMDB

l UCMDB-SM integration enabled

l Multi-company mode disabled in Service
Manager

l You create a new company record in Service
Manager

No None

Conditions where Service Manager synchronizes company ID with UCMDB, continued

UCMDB Customer ID
When you enable themulti-tenancy integration, ServiceManager displays a new field in each
company record called UCMDB Customer ID. In order to synchronize a company record with
UCMDB, youmust first provide a value for this field. After you provide a UCMDB Customer ID
value this field becomes read-only. You cannot change a company's UCMDB Customer ID after
you set it.

This field only accepts numeric data up to ten characters long. ServiceManager requires the field
value to be a unique positive whole number. You cannot enter duplicate values or use decimals,
negative numbers, or zero.

Your UCMDB system automatically uses the UCMDB customer ID of 1 when running in single
tenant mode. You can reuse this default value in your multi-tenant implementation by assigning a
ServiceManager company to have this UCMDB customer ID value. Out-of-the-box, no Service
Manager company has the UCMDB customer ID of 1.

UCMDB User ID and Password
When you enable themulti-tenancy integration, ServiceManager displays two new fields in each
company record called UCMDB UserId and UCMDB Password. These fields allow you to specify
the connection information you want ServiceManager to use when requesting information for the
Actual State section. Any user name and password you enter in these fields must be valid for your
UCMDB system.

The user name and password you provide in the Company Information record takes precedence
over the user name and password you provide in the System Information record. This allows
managed service providers to control access to the UCMDB system on a tenant-by-tenant basis. If
you do not provide a company-specific UCMDB user name and password, ServiceManager uses
the credentials you provided in the System Information record.

Company Code
Themulti-tenancy integration requires that each company record has a unique Company Code
(company field) value. Since Company Code is a required field, your existing company records
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should already have Company Code values. However you should ensure that each company record
has a unique Company Code value.

Caution: You should not change the Company Code value after you have enabled themulti-
tenancy integration because this will cause your ServiceManager data to become out of
synch.

CI Reconciliation Rules
Whenmulti-tenancy is enabled, ServiceManager only reconciles the CIs whose company ID
matches the company ID in the data push job. For example, when pushing CIs from company 2, the
reconciliation rules only apply to the ServiceManager CI records that have the company code
corresponding to company number 2.

Company Information Pushed to CI and CI Relationship
Records

When you enable themulti-tenancy integration, ServiceManager inserts the SM Company Code
value in CI and relationship records during data push. ServiceManager uses the UCMDB
Customer ID to look up thematching SM Company Code value.

Company Information Replicated to Incident Records
When you enable themulti-tenancy integration and select the option to create incidents when
UCMDB discovers new, updated, or deleted CIs, ServiceManager inserts the SM Company Code
value in the incident record during replication. ServiceManager uses the UCMDB Customer ID to
look up thematching SM Company Code value.

Schedule Records
ServiceManager uses the problem schedule processor to manage the synchronization of company
IDs to your UCMDB system. You canmanually enable the problem schedule processor from the
System Status form.

When the synchronization criteria aremet as described in Table "Conditions where Service
Manager synchronizes company ID with UCMDB" on page 62, ServiceManager creates a “Synch
Company with UCMDB - <UCMDB Company ID>” schedule record (for example, “Synch
Company with UCMDB - 1234567890”). If you inactivate a company, ServiceManager creates a
“Inactivate Company with UCMDB - <UCMDB Company ID>” schedule record (for example,
“Inactivate Company with UCMDB - 1234567890”). The problem schedule processor processes the
new schedule record on the next background process iteration.

If your ServiceManager system cannot connect to your UCMDB system for some reason, it will
reschedule the company synchronization at the next scheduled interval (the out-box interval is 5
minutes). The problem schedule processor updates the schedule record with the status
rescheduled. If the ServiceManager system receives any other error message while connecting to
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the UCMDB system, it updates the schedule record with the status “application failed due to error -
check msglog for possible messages.”

Tenant-Specific Discovery Event Manager (DEM)
Rules

You can implement the condition field function in order to create SM DEM rules that are specific to a
particular tenant in amulti-tenancy UCMDB-SM integration.

Tenant rules vary according to SM tenant configuration requirements, for each record information
type pushed from UCMDB to SM different tenants can configure different DEM tenant rules.

Each tenant can have its own set of unique requirements and thereforemay implement different
processes via the integration.

One tenant may require the addition of CIs directly to SM while another tenant may require opening
changes for each CI.

The following table shows a sample set of DEM rules that illustrate how to accomplish this.

DEM rule ID Action on new CI Condition

ucmdbNode_advantage Add CI company in $L.file=”advantage”

ucmdbNode_hp Create change company in $L.file=”HP”

Tenant-specific DEM rules

Note: DEM Rules

When creating DEM rules make sure to create separate DEM rules for each tenant.

Multi-Tenancy Functional Use Cases
The following table describes the necessary actions to perform in various deployment situations to
address multi-tenancy issues.
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Deployment
Integration
Type Description

UCMDB
with multi-
tenancy
rules

SM without
multi-
tenancy
rules

When implementing a UCMDB-SM deployment that has existingmulti-tenancy
rules in UCMDB and does not havemulti-tenancy rules configured in SM, the
user creates multi-tenancy rules in SMmanually and according to the rules in
UCMDB.

SM with
multi-
tenancy
rules

UCMDB
without
multi-
tenancy
rules

When implementing a UCMDB-SM deployment that has existingmulti-tenancy
rules in configured SM and does not havemulti-tenancy rules configured in
UCMDB, the user creates multi-tenancy rules in UCMDB manually as well as
according to the rules previously configured in SM.

UCMDB
without
multi-
tenancy
rules

SM without
multi-
tenancy
rules

When implementing a UCMDB-SM deployment that does not havemulti-tenancy
rules configured in UCMDB or in SM, the user configures the rules in SM.

During the configuration process using the SMmulti-tenancy wizard the user can
create corresponding tenancy configuration in UCMDB. By creating
corresponding tenancy configurations in SM the user also creates a
corresponding tenant in UCMDB.

Multi-tenancy use cases

Multi-Tenancy Requirements
Your systemmust meet the following requirements in order for the integration to support multi-
tenancy.

l HP Universal CMDB version 8.02 or later system

l HP ServiceManager version 9.20 or later system

l Integration enabled between UCMDB and ServiceManager

l Multi-company mode enabled on the ServiceManager system

l Problem schedule process running on the ServiceManager system
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For additional information about themulti-tenancy integration, you can visit the HP Software
Support Online web site or refer to the ServiceManager help.

Setting up the Multi-Tenancy Integration in
UCMDB

You need to perform the following tasks in UCMDB to set up themulti-tenancy integration.

1. Install a separate data flow probe for each tenant the integration will support.
See "How to Install Separate Data Flow Probes for Each Tenant" below.

2. Start tenant-specific data flow probes.
See "How to Start Tenant-Specific Data Flow Probes" on page 70.

3. Configure IP address ranges for tenant-specific data flow probes.
See "How to Configure IP Ranges for Tenant-Specific Data Flow Probes" on page 70.

4. Configuremulti-tenancy for population.
See "How to ConfigureMulti-Tenancy for Population" on page 70.

How to Install Separate Data Flow Probes for Each
Tenant

If you plan to support a multi-tenant configuration, youmust install a separate data probe for each
tenant. Out-of-the-box, the UCMDB installer only installs one data flow probe and service.

To install additional data flow probes and start them from your operating system command prompt:

1. Log in to the host of your UCMDB system as an administrator.

2. Insert the HP Universal CMDB SetupWindows DVD into the system disc drive.

3. Start the Data Flow Probe installer (HPUCMDB_DataFlowProbe_x.xx.exe).

4. Follow the on-screen instructions to complete the wizard, but use the following values for each
data flow probe you wish to install.
a. Type a unique path for each installation folder.

b. Use the sameUCMDB application server address for each data flow probe.

c. Type a valid data flow probe address.

d. Type a unique name for each data flow probe identifier.

e. Create a unique customer Data Flow Probe domain for each probe (Clear the Use Default
CMDB Domain option).
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f. Use the same probe gateway and probemanager settings for each probe (for example, use
combined or separate processes).

See theHP Universal CMDB Deployment Guide for complete installation instructions.

5. Repeat step 3 and step 4 for each data flow probe you wish to install.

6. Open the probe’s DiscoveryProbe.properties file in a text editor. By default, this file is
located in the following folder:
<UCMDB installation folder>\<data flow probe installation folder>\conf

For example, C:\hp\UCMDB\DataFlowProbe\conf.

Note: The <data flow probe installation folder> must be unique for each tenant.

7. Edit the following properties in the configuration file.

Property Value

serverName Verify the name of the UCMDB server

customerId Type the customer ID for the tenant this data flow
probe supports

appilog.collectors.probe.name Verify the probe name is unique such as server +
tenant ID

applilog.collectors.domain Verify the domain name of the data flow probe

appilog.collectors.local.ip Verify the data flow probe gateway name

appilog.collectors.probe.ip Verify the data flow probemanager name

appilog.collectors.rmi.port Type a unique port for each probe

appilog.collectors.rmi.gw.port Type a unique port for each probe

appilog.collectors.probe.html.port Type a unique port for each probe

appilog.collectors.local.html.port Type a unique port for each probe

appilog.collectors.ProbeUseSpecific

RMIPortFrom

Type a unique port for each probe or type 0 to have
the system automatically select it

appilog.collectors.bigBrother.port Type a unique port for each probe

Discovery Probe properties set for each tenant

8. Save the configuration file.

9. Repeat step 6 to step 8 for each tenant’s data flow probe.
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How to Start Tenant-Specific Data Flow Probes
To start tenant-specific data flow probes:

1. Open theOS command prompt and navigate to the probe’s bin folder. For example,
C:\hp\UCMDB\DataFlowProbe1\bin.

2. Type gateway console.

3. Repeat step 1 to step 2 for each data flow probe you want to start.

How to Configure IP Ranges for Tenant-Specific
Data Flow Probes

To configure IP ranges for tenant-specific data flow probes:

1. Log in to UCMDB as an administrator using the company ID of the tenant whose data flow
probe you want to configure.

2. Navigate toData Flow Management > Data Flow Probe Setup.

3. Expand the data flow probe domain containing the probe you want to start. For example,
Customer2.

4. Expand the Probe node and select the data flow probe you want to start. For example,
Probe2Customer2.

5. Click theAdd IP range button .

6. Type an IP range you want the Data Flow Probe to scan. Optionally, add any IP ranges you
want to exclude.

7. Click OK to save the IP range.

8. Repeat step 1 to step 7 for each data flow probe you want to configure.

How to Configure Multi-Tenancy for Population
To support multi-tenancy for population, you need to configure the basicQueryCondition setting for
each TQL defined in the population configuration file (smPopConfFile.xml).

To configuremulti-tenancy for population:
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1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Click the smPopConfFile.xml file.

4. For each TQL defined in this file, update the basicQueryCondition setting by adding the
following:
and company= &quot;{customerId}&quot;

For example:

basicQueryCondition="type=&quot;bizservice&quot;and company= &quot;
{customerId}&quot;"

5. Save the configuration file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

Setting up the Multi-Tenancy Integration in
Service Manager

You need to perform the following tasks in ServiceManager to set up themulti-tenancy integration.

Multi-tenancy support is an optional feature of the integration intended for Managed Service
Providers (MSPs) who want to offer ConfigurationManagement as a service to their tenants. In a
multi-tenancy configuration, each CI and CIR record has a corresponding company ID. Out-of-the-
box, ServiceManager allows all operators to view CI data regardless of the company ID. If you
wish to restrict access to CI data by company ID, youmust enableMandanten and use the
company ID field as a restricting query. See the ServiceManager help for more information about
multi-company mode andMandanten.

Youmust complete the following tasks from your ServiceManager system to enablemulti-tenancy
support for the integration.

1. Start the process schedule.
See "How to Start the Process Schedule" on the next page.

2. Configure the ServiceManager System Information Record.
See "How to Configure the ServiceManager System Information Record" on the next page.

3. Add tenant-specific UCMDB ID and password values to company records (optional).
See "How to Add Tenant-Specific UCMDB User ID and Password Values" on page 74.

4. Add UCMDB Customer ID values to existing company records.
See "How to Add UCMDB Customer ID values to Existing Companies" on page 74.
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5. Synchronize existing company records with UCMDB.
See "How to Synchronize Existing Companies from ServiceManager to UCMDB" on page 75.

6. Verify that ServiceManager synchronized company records with UCMDB (optional).
See "How to View Whether Company Information is in UCMDB" on page 76.

7. Resynchronize existing company records with UCMDB (as needed).
See "How to Resynchronize an Existing Company with UCMDB" on page 76.

8. Inactivate company records you do not want to be part of the integration (as needed).
See "How to Inactivate a Synchronized Company" on page 77.

9. Reactivate inactive company records you want to be part of the integration (as needed).
See "How to Reactivate an Inactive Company" on page 78

10. Add tenant-specific DEM rules.
See "How to Add Tenant-Specific DEM Rules" on page 78.

How to Start the Process Schedule
This integration needs the process schedule to synchronize company records from Service
Manager to UCMDB. You need tomake sure it is started before synchronizing company records.

To start the process schedule:

1. Log in to ServiceManager as a system administrator.

2. From the System Navigator, click System Status.
A list of the currently started schedules displays.

3. Click theRefresh Display button to refresh the list.

4. If the problem schedule is not in the list, do the following:
a. Click theStart Scheduler button.

b. Double-click the process schedule.

A message displays that indicates the process schedule is started.

How to Configure the Service Manager System
Information Record

To enable the integration to support multi-tenancy, youmust provide additional information in the
ServiceManager System Information Record.

Caution: In order to enablemulti-tenancy support, youmust use HP Universal CMDB version
8.02 or greater. Earlier versions of HP Universal CMDB will produce an error message if you
attempt to run them inmulti-tenancy mode.
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To provide additional information in the ServiceManager System Information Record:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration >Miscellaneous >
System Information Record.

3. Click theGeneral tab.

4. Enable theRun in Multi-Company Mode option.

5. Click theActive Integrations tab.

6. Select theHP Universal CMDB option.
The form displays the UCMDB web service URL field.

7. In the UCMDB web service URL field, type the URL to the synchronize CIs web service API.
The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

Replace <UCMDB server name>with the host name of your UCMDB server, and replace
<port>with the communications port your UCMDB server uses.

8. In UserId and Password, type the user credentials required tomanage CIs on the UCMDB
system. For example, the out-of-the-box administrator credentials are admin/admin.

9. In theMulti-tenant web service URL field, type the URL to the synchronize company IDs web
service API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/UcmdbManagementService

Replace <UCMDB server name>with the host name of your UCMDB server, and replace
<port>with the communications port your UCMDB server uses.

10. Type the user name and password required to synchronize company IDs on the UCMDB
system. For example, the out-of-the-box system administrator credentials for UCMDB 9.x are
sysadmin/sysadmin.

11. Click Save. ServiceManager displays themessage: Information record updated.

12. Log out of the ServiceManager system, and log in again with an administrator account.

13. Click System Status > Display Options > All Tasks.

14. Type k in the Command field next to the problem schedule process and click Execute
Commands. Wait a few minutes for the problem schedule process to close.

15. Click Start Scheduler.

16. Double-click the problem schedule process. The system now supports multi-tenancy for
UCMDB.
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How to Add Tenant-Specific UCMDB User ID and
Password Values

You can provide a tenant-specific UCMDB user name and password for ServiceManager to use
when requesting information for the Actual State section. If you provide no credentials, Service
Manager uses the credentials in the System Information Record for all tenants.

Note: Any credentials you provide in the company record take precedence over credentials
you provide in the System Information Record. The UCMDB UserId and UCMDB Password
fields are available only when you have enabled themulti-tenancy integration.

To add tenant-specific UCMDB user name and password:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Type the user name you want this company to use to connect to UCMDB in the UCMDB
UserId field.

6. Type the password for the UCMDB user name in the UCMDB Password field.

7. Click Save.

8. Repeat step 3 through step 7 for each company you want to provide credentials for.

How to Add UCMDB Customer ID values to Existing
Companies

You can use the following steps to add a UCMDB Customer ID value to your existing Service
Manager company records.

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Type a numeric value in the UCMDB Customer ID field for this company.
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6. Click Save.

7. ServiceManager prompts to confirm that you want to synchronize the record with UCMDB.
Click Yes if you want to synchronize the company now, or click No if you want synchronize
the company later.

8. Click Next to go to the next company in the record list.

9. Repeat step 5 through step 8 for each company in the record list.

How to Synchronize Existing Companies from
Service Manager to UCMDB

Your ServiceManager systemmay already contain company records that you want to use with the
multi-tenancy integration.

If you update any field in a company record that has not yet been synchronized to UCMDB, Service
Manager prompts whether you want to synchronize the company to UCMDB.

Note: ServiceManager will not prompt you to synchronize the company record if you have
disabled the option to show the company inmulti-company lists, or if there is a pending
schedule record associated with the company. See "How to Inactivate a Synchronized
Company" on page 77 for more information.

This task includes the following steps:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select a company record to update.

6. Update the company record.

7. Click Save. ServiceManager prompts to confirm that you want to synchronize the record with
UCMDB.

Note: ServiceManager saves the company record regardless of your synchronization
choice.
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How to View Whether Company Information is in
UCMDB

When you enable themulti-tenancy integration, ServiceManager displays a read-only field in each
company record that lists whether the UCMDB Customer ID has been synchronized with your
UCMDB system.

Note: The UCMDB Customer ID field is visible only when you enable themulti-tenant
UCMDB integration.

To view whether company information is in UCMDB:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Review the status of the Synched with UCMDB field.
If the check box is checked, then ServiceManager has already synchronized the company ID
with your UCMDB system. If the check box is unchecked, then ServiceManager has yet to
add this company to your UCMDB system.

Note: Formore information about synchronization failures, see "Schedule Records" on
page 65.

How to Resynchronize an Existing Company with
UCMDB

ServiceManager provides you ameans to resynchronize company records with your UCMDB
system in case you lose UCMDB data for some reason. For example, youmight intentionally
remove UCMDB data during integration testing, or youmight need to recover data after a disaster.
You can force ServiceManager to synchronize companies with your UCMDB system with the Re-
synch with UCMDB option.

To resynchronize an existing company with UCMDB:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.
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3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select a company record to synchronize.

6. Click theRe-synch button next to the Synched with UCMDB? check box.

Note:
TheRe-synch button is available only from company records that have already been
synchronized with UCMDB and have theSynched with UCMDB check box checked.
If your UCMDB system already has a company with this ID value, it will ignore the
resynchronization request. ServiceManager will also ignore a resynchronization request if
there is an existing schedule record to resynchronize the company with UCMDB. In this
case, it displays themessage “A schedule record has already been added to re-
synch this company with UCMDB”.

How to Inactivate a Synchronized Company
After you have synchronized a company record with UCMDB you can no longer delete the record.
Instead, you can inactivate a company record, which causes the UCMDB system to cease all
further CI updates for the company. Any existing CI data for the company remains in the UCMDB
system associated with the inactive UCMDB Customer ID, but both the company and any
associated CIs will no longer be visible from the UCMDB system.

To inactivate a synchronized company:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select a company record to inactivate.

6. Select No from Show Company inMulti-Company Lists.

7. Click Save.

8. If this company was previously synchronized with UCMDB, ServiceManager prompts you to
confirm the inactivation.

9. Click Yes to confirm the inactivation orNo to cancel your changes.
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How to Reactivate an Inactive Company
You can reactivate any inactive companies on your ServiceManager system to include them in the
multi-tenancy integration. Youmust also synchronize the company with UCMDB for UCMDB to
process any CI updates for this company.

To reactivate an inactive company:

1. Log in to ServiceManager as a system administrator.

2. Navigate toSystem Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select a company record to reactivate.

6. Select Yes from Show Company inMulti-Company Lists.

7. Click Save. ServiceManager prompts you to reactivate the company with UCMDB.

8. Click Yes. ServiceManager creates a schedule record to reactivate the company.

How to Add Tenant-Specific DEM Rules
You can use the condition field to create DEM rules that are specific to a particular tenant in amulti-
tenancy UCMDB-SM integration. For example, one tenant may want to add CIs directly to Service
Manager while another tenant may want to open changes for each CI. The following sample DEM
rules illustrate how to accomplish this.

DEM rule Id Action on new CI Condition

ucmdbNode_advantage Add CI company in $L.file=”advantage”

ucmdbNode_hp Create change company in $L.file=”HP”

Tenant-specific DEM rules

Tip: It is a best practice to create a separate DEM rule for each tenant.
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Standards and Best Practices
This chapter includes:

l "UCMDB-SM Configuration Best Practices" below

l "Frequently AskedQuestions" on page 93

l "Known Issues and Limitations" on page 106

UCMDB-SM Configuration Best Practices
This section provides best practices and recommendations for successfully implementing this
integration in various environments. This section provides you with valuable understandings and
techniques that will enhance the UCMDB-SM integration as well as solve common problems by
providing solutions and workarounds to these issues. These practices and recommendations may
vary slightly according to each implementation, as the specific system requirements and settings
alter per system environment.

This section includes:

l "CI NameMapping Considerations" below

l "Bi-Directional Data Synchronization Recommendations" on page 81

l "Push Scheduling Recommendations" on page 82

l "Push in Clustered Environments" on page 84

l "Initial Load Configurations" on page 86

l "How to Configure Differential/Delta Load DEMRules" on page 90

l "Fault Detection and Recovery for Push" on page 91

l "How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 93

CI Name Mapping Considerations
UCMDB allows duplicate CI names while ServiceManager requires unique logical names. Before
pushing UCMDB CIs, you need to define a correct CI namemapping for them. For example, many
UCMDB CIs (such as CIs of the Running Software, CRG, Switch, or Router type) have the same
display label.

To prevent duplicate CI names from occurring in ServiceManager when pushing UCMDB CIs, the
followingmappings are provided out-of-the-box:

CRG mapping
Out-of-the-box, UCMDB CRG records aremapped to ServiceManager as follows:
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l If a Cluster exists for a CRG, the CRG is mapped to this CI logical name: <Cluster display
label>_<CRG display label>;

l If the CRG does not have a Cluster, but has several IP addresses, the CRG is mapped to the
following (where the IP addresses are sorted alphabetically):
<IpAddress1>_..._<IpAddressN>.<authoritativeDnsName>_<CRG display label> (when
IpAddress.authoritativeDnsName exists)

<IpAddress1>_..._<IpAddressN>_<CRG display label> (when
IpAddress.authoritativeDnsName does not exist)

l If neither a Cluster nor an IP address exists for the CRG, it is mapped directly to <CRG display
label>.

Running Software mapping
Running Software CIs are prefixed with their root container node display label whenmapped to a
ServiceManager CI: <Node display label>_<Running Software display label>.

Switch & Router mapping
Switch or Router type CI records in UCMDB are prefixed with their MAC adresses whenmapped to
a ServiceManager CI: <MACAddress1>_..._<MACAddressN>_<Switch or Router display label>,
where theMAC addresses are sorted alphabetically.

CRG mapping
Out-of-the-box, UCMDB CRG records aremapped to ServiceManager as follows:

l If a Cluster exists for a CRG, the CRG is mapped to this CI logical name: <Cluster display
label>_<CRG display label>;

l If the CRG does not have a Cluster, but has several IP addresses, the CRG is mapped to the
following (where the IP addresses are sorted alphabetically):
<IpAddress1>_..._<IpAddressN>.<authoritativeDnsName>_<CRG display label> (when
IpAddress.authoritativeDnsName exists)

<IpAddress1>_..._<IpAddressN>_<CRG display label> (when
IpAddress.authoritativeDnsName does not exist)

l If neither a Cluster nor an IP address exists for the CRG, it is mapped directly to <CRG display
label>.

Running Software mapping
Running Software CIs are prefixed with their root container node display label whenmapped to a
ServiceManager CI: <Node display label>_<Running Software display label>.
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Switch & Router mapping
Switch or Router type CI records in UCMDB are prefixed with their MAC adresses whenmapped to
a ServiceManager CI: <MACAddress1>_..._<MACAddressN>_<Switch or Router display label>,
where theMAC addresses are sorted alphabetically.

Bi-Directional Data Synchronization
Recommendations

The UCMDB-SM integration supports bi-directional data synchronization between UCMDB and
ServiceManager (SM). HP recommends that you follow the following best practices to avoid
unnecessary problems due to improper use of the data push and population features:

l For CIs/CI Relationships that UCMDB can automatically discover, use UCMDB as the data
source. Do not make changes to them in ServiceManager, instead always let UCMDB discover
their changes and push the changes to SM.

l For CIs/CI Relationships that UCMDB cannot automatically discover, use SM as the data
source. Do not make changes to them in UCMDB, instead always make changes to them in SM
and populate the changes to UCMDB.

l For CIs/CI Relationships that are already created in SM andUCMDB can automatically
discover, run a one-time population to synchronize them to UCMDB, and then use UCMDB as
their data source.

Caution: Problems like the followingmay occur if you do not follow these best practices:

Problem 1:

[Population Adapter] After CIs/CI Relationships are pushed from UCMDB, if you directly make
changes in SM to these records without ever populating them back to UCMDB first, the
changes cannot be populated to UCMDB.

Workaround:

Changing these UCMDB records in SM is not recommended; however if you need to do so you
can do the following to solve this issue: After the records are pushed to SM, populate them
back to UCMDB first beforemaking any changes to them in SM. This way the changes can
then be populated to UCMDB.

Problem 2:

[Population Adapter] After a Composition relationship between a Node CI (node 1) and
Running Software CI is pushed to SM, if you change the upstream CI of the relationship from
node 1 to node 2 and then run a change population to populate this change, the Running
Software CI will be removed in UCMDB.

Workaround:
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It is recommended that you remove the running software in UCMDB and create a new one
instead of directly replacing the container of the running software in SM. If you cannot avoid
doing so, do the following:

After you change the upstream CI of the relationship from node 1 to node 2, do not directly run
the change population. Follow these steps to avoid this issue:

1. Update the Running Software CI in SM (or simply save it to mark it as updated).

2. Run a Running Software CI change population. This will create node 2 (if it does not
already exist in UCMDB) and a new Composition relationship between node 2 and this
Running Software CI.

3. Run a change population to synchronize the relationship change to UCMDB. The
relationship between node 1 and the Running Software CI will be removed, and the new
relationship created in step 2 will remain.

If you have run the change population after changing the upstream CI of the relationship from
node 1 to node 2, and as a result the Running Software CI has been removed in UCMDB,
follow these steps to solve this issue:

1. Update the Running Software CI in SM (or simply save it to mark it as updated).

2. Run a Running Software CI change population. This will create the Running Software CI,
node 2 (if it does not already exist in UCMDB) and a new Composition relationship
between node 2 and this Running Software CI.

Push Scheduling Recommendations
Push jobs are run using twomainmethods, the first method is by manually executing the push job
and the second is by scheduling the push job.

All push jobs can potentially produce a strain on the UCMDB and SM systems therefore; HP
recommends that you adhere to the following guidelines:

Scheduler time frames
It is important for you to understand the function of the Scheduler “time frame” concept. Running
push jobs creates an increase in system activity andmay affect application responsiveness. In
order to enable users to effectively interact with applications HP recommends the following
guidelines:

In order to reduce system strain, schedule the UCMDB to SM push to run at non-peak usage hours,
preferably when system usage is at aminimum.

Scheduler frequency
It is important to be aware of the business requirements when configuring the schedule frequency.
The scheduler frequency depends on infrastructure environment changes that must be
synchronized between UCMDB and SM.
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Define the scheduling frequency based on the business requirements for consuming up-to-date CI
information. Most implementations require a daily update. When scheduling small IT systems that
are prone to frequent changes, the scheduling frequency may need to be increased.

Push Job dependencies
UCMDB Push Jobs do not support dependencies between each other. Each “Push Job” is
considered a separate task and users cannot define job dependencies. For example, that one job is
dependent on another or upon completion before the next job is run.

It is important that both CI TQLs and their dependent Relationship TQLs exist in the same Job in
order to avoid relationships not being pushed to ServiceManager. UCMDB always pushes the CI
TQLs before their dependent Relationship TQLs.

Note: Suffix usage

The out-of-the-box job for CI push uses queries that end with the “Push” suffix, for example,
“SM Computer Push”.

Queries that create relationships between the CIs uses an extra “Relations” suffix, for
example, “SM Node Relations Push”.

Scheduler time frames
It is important for you to understand the function of the Scheduler “time frame” concept. Running
push jobs creates an increase in system activity andmay affect application responsiveness. In
order to enable users to effectively interact with applications HP recommends the following
guidelines:

In order to reduce system strain, schedule the UCMDB to SM push to run at non-peak usage hours,
preferably when system usage is at aminimum.

Scheduler frequency
It is important to be aware of the business requirements when configuring the schedule frequency.
The scheduler frequency depends on infrastructure environment changes that must be
synchronized between UCMDB and SM.

Define the scheduling frequency based on the business requirements for consuming up-to-date CI
information. Most implementations require a daily update. When scheduling small IT systems that
are prone to frequent changes, the scheduling frequency may need to be increased.

Push Job dependencies
UCMDB Push Jobs do not support dependencies between each other. Each “Push Job” is
considered a separate task and users cannot define job dependencies. For example, that one job is
dependent on another or upon completion before the next job is run.
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It is important that both CI TQLs and their dependent Relationship TQLs exist in the same Job in
order to avoid relationships not being pushed to ServiceManager. UCMDB always pushes the CI
TQLs before their dependent Relationship TQLs.

Note: Suffix usage

The out-of-the-box job for CI push uses queries that end with the “Push” suffix, for example,
“SM Computer Push”.

Queries that create relationships between the CIs uses an extra “Relations” suffix, for
example, “SM Node Relations Push”.

Push in Clustered Environments
A clustered SM environment is comprised of multiple servlets running in parallel with a load
balancer that dispatches user requests to any available servlet. Youmust configure the UCMDB-
SM integration to point to a specific servlet and not to the SM loadBalancer. In order to perform this,
youmust first create a dedicated web service listener.

This section includes:

l "DedicatedWeb Services" below

l "Step-by-Step Cluster Configuration Process" below

l "Connecting toMultiple SM Processes" on page 86

Dedicated Web Services
A ServiceManager system configured for vertical or horizontal scaling uses a load balancer to
redirect client connection requests to an available SM process. However, most Web Services
clients cannot handle a redirect request and will fail if they use the SM load balancer as the endpoint
URL.

HP recommends creating one or more SM processes dedicated toWeb Services requests. The
user must configure the relevant external web service clients to connect directly to the dedicated
ServiceManager processes.

Step-by-Step Cluster Configuration Process

How to Configure Web Clients

To configure the relevant external web clients:

1. Stop the ServiceManager service.

2. Open the sm.cfg file, and create a dedicated SM process to listen forWeb Services requests
using the -debugnode parameter.
The following entries create a dedicated process listening on ports 13085 and 13445.
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Explanation

The code excerpt illustrates the various settings for each of the SM process listeners (web
services) that enable SM clients to connect to the SM service.

Line 01 defines the load balancer port (13080).

Lines 02 and 03 define the SM ports to which non-dedicated SM clients are redirected by the
SM load balancer.

Line 04 defines the debugnode port that is utilized by the dedicated SM clients.

Note: Debugnode parameter

The debugnode parameter tells the SM load balancer not to forward any client connection
requests to this ServiceManager process. Only clients that directly connect to the process can
access this port.

How to Configure the Debugnode

To configure the debugnode:

1. Start the SM service.

2. Configure any external web service clients to connect directly to the SM processes running in
debugnode. When performing an integration using UCMDB, the UCMDBServiceManager
Adapter for SM should be configured to connect to the debugnode port.
For example, for normal connections set the endpoint URL to:

http://<fully qualified host name>:13085/SM/7/<Service Name>

and for SSL-encrypted connections set the URL to:

https://<fully qualified host name>:13445/SM/7/<Service Name>.

These clients may include UCMDB (for push purposes), Connect-It and additional
applications.
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Connecting to Multiple SM Processes
If you want to have better performance, you can connect to multiple ServiceManager processes.
The integration supports in both ServiceManager vertical or horizontal load balancer environment.

You can createmore than one SM processes dedicated toWeb Services requests, and configure
the field URLOverride of integration point with the dedicated SM processes. This field value (if any)
overrides the Hostname/IP and Port settings.

The following is an example value of this field, which connects two SM processes:

http://<fully qualified host name1>:13080/SM/7/ws;http://<fully qualified host
name2>:13082/SM/7/ws

Initial Load Configurations
Before the configuration process can begin, youmust first assess the amount of CI and
relationships data is to be transferred from UCMDB to SM and ascertain the iteration process that
is required based on the volume.

Youmust first assess whether all of the data can be pushed in a single iteration. This is ascertained
by the amount of data that is included in the push queries and the amount of time you have to push
this data.

This section includes:

l "Push Performance in a Single-Threaded Environment" below

l "ImplementingMulti-Threading" on the next page

l "Push Performance inMulti-Threaded Environments" on page 88

l "Push Performance inMultiple SM Processes Environments" on page 89

l "How to set up SM DEMRules for Initial Loads" on page 89

Note: The performance data presented in this document is based on tests that were performed
at HP and is provided for reference only. The integration performancemay significantly differ in
your environment depending on your hardware configuration.

Push Performance in a Single-Threaded Environment
The Push of 22,500 UCMDB root CIs (roots in TQLs) and/or Relationships in a single-threaded
environment takes about an hour and is performed in a linear fashion. See the following table:
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Number of root CIs/CI Relationships pushed
per hour Multi-threading settings in sm.properties

22,500 number.of.concurent.sending.threads=1

min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

Performance data in a single-threaded environment

To view or edit the sm.properties file in UCMDB, navigate toData Flow Management > Adapter
Management > ServiceManagerAdapter9-x > Configuration Files > sm.properties.

Number of Root CIs and Relationships/22,500

The push time (in hours) in any given environment is calculated as follows:

If the push of a single planned query has the potential of breaching the permitted time frame the data
must be divided into several queries. Each query must be pushed individually.

This query division is performed by creating several queries, each with different node conditions
that enable data filtering. Once all queries are pushed for the first time, the Initial Load process is
complete.

Note: Applying node conditions

When applying node conditions to the various SM Sync Queries, youmust make sure that all
of the information is included in the queries, so that all relevant data is copied to SM.

Implementing Multi-Threading
In order to improve performance, the ServiceManager Adapter utilizes multiple threads for the push
of CI and Relationship data to SM. The following section explains these settings and how to
configure them for maximum performance.

Themulti-threading configuration is defined in the sm.properties file on the UCMDB server. To view
or edit the file in UCMDB, navigate toData Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files > sm.properties.

The following are examplemulti-threading definitions in the sm.properties file:

Explanation

The code excerpt illustrates the relevant multi threading settings on the UCMDB server.

l Line 01 defines the number of parallel threads UCMDB will open to SM for CI push. Setting this
parameter to 1 disables multi-threading, while a values of 2 or higher enables multi-threading.
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l Line 02 defines theminimum number of SM objects needed to usemultiple threads as opposed
to a single thread.

l Line 03 defines the number of chunks per thread. This numbermultiplied by the number of
threads gives you the total number of CI data chunks.

l The total number of chunks = number.of.chunks.per.thread *
number.of.concurent.sending.threads

The integration implements a queuemechanism as follows:

The data passed from UCMDB to SM is divided into equal chunks, and these chunks are placed in
a queue.

Each available thread pulls the next chunk from the queue until all threads are available. Once this
process has completed, the push is complete.

Themechanism is designed tominimize idle time of each thread. As each thread processes its
chunk in parallel, some threads may finish before others and it is inefficient for them to wait for each
other.

Caution: Defining too many threads

It is ineffective to over-increase the number of threads as this causes the SM server to
overload. In enterprise environments where the SM server processing the push data is very
robust the number of threads can be increased to 10 and in some cases even 20; however, you
must take into account that increasing the number of threads raises CPU usage on the SM
server during push, whichmay reduce application performance.

Push Performance in Multi-Threaded Environments
The push of 60,000 UCMDB root CIs (roots in TQLs) and/or Relationships in an out-of-the-box
multi-threaded environment takes about an hour and is performed in a linear fashion. See the
following table:

Number of root CIs/Relationships pushed
per hour

Multi-threading settings in sm.properties
(default)

60,000 number.of.concurent.sending.threads=6

min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

Performance data in an out-of-the-box multi-threaded environment

The push time (in hours) in any given environment is calculated as follows:

Number of Root CIs and Relationships/60,000
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Push Performance in Multiple SM Processes
Environments

The Push of 190,000 UCMDB root CIs (roots in TQLs) and/or Relationships in amulti-threaded
environment with multiple SM processes takes about an hour and is performed in a linear fashion.
See the following table:

Number of root
CIs/Relationships
pushed per hour SM processes

Multi-threading settings in sm.properties
(default)

190,000 2 server hosts, with
each host running 3
processes

number.of.concurent.sending.threads=90

min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

Performance data in a multiple SM processes environment

Formore information about definingmultiple SM processes for the integration, see "How to Create
an Integration Point in UCMDB" on page 29.

The push time (in hours) in any given environment is calculated as follows:

Number of Root CIs and Relationships/190,000

How to set up SM DEM Rules for Initial Loads
SMDiscovered Event Manager Rules (DEM Rules) enable the user to define the appropriate action
to take for each event type that is reported to SM.

Each CI and relationship record pushed from UCMDB to SM is analyzed against the existing SM
records and open Change requests. SM rules define the appropriate action to be taken for each type
of CI data update sent to SM.

To view or update the SM Discovered Event Manager Rules:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Press ENTER or click theSearch button.
A list of all the Discovered Event Manager Rules displays. Each rule is usually linked to a CI
Type or a subset of CIs of the same type.

4. Click on the individual CI Discovered Event Manager Rule to view its details.

To set up DEMRules for initial loads:

Tip:When performing “Initial Loads”, HP recommends setting the SM Discovered Event
Manager Rules to add newly reported CIs as described below. This minimizes the “noise” of an
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Initial Load, that could potentially create tens of thousands of Changes/Incidents.

For each of the Discovered Event Manager Rules, perform the following steps:

1. Select the relevant Discovered Event Manager Rule.

2. Go to the “Action if matching record does not exist” section, select theAdd the record option.

3. In the “Action if record does not exist but unexpected data discovered” section, select the Log
Results and Update Record option.

4. In the “Action if record is to be deleted” section, select theDelete Record option.

5. Save the Discovered Event Manager Rule record.

How to Configure Differential/Delta Load DEM Rules

Tip: Once the “Initial Load” or “Data Load” of the CI data is completed, HP recommends
applying Differential/Delta Load settings. These settings apply to all data loaded from UCMDB
to SM.

These loads send only updates regardingmodifications discovered in the IT infrastructure from
UCMDB to SM.

To set up the SM DEMRules for Differential/Delta Loads:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Press Enter or click theSearch button.
A list of all the Discovered Event Manager Rules in SM displays.

4. For each of the Discovered Event Manager Rules, perform the following steps:
a. Select the relevant Discovered Event Manager Rule.

b. In the “Action if matching record does not exist” section, select the appropriate action
required for each newly detected CI. If uncertain, select theAdd the record option.

c. In the “Action if record does exist but unexpected data discovered” section, select the
appropriate action for each CI that was modified, resulting in an unexpected or incorrect
result. The recommended best practice is to select theOpen a Change option.

d. In the “Action if record is to be deleted” section, select the appropriate action required for
each CI that was removed/deleted. The recommended best practice is to select theDelete
Record option for CI Relationship, and select theUpdate record to the selected status
option for CI.

e. Save the Discovered Event Manager Rule record.
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Fault Detection and Recovery for Push
Universal CMDB provides a fault detection and recovery mechanism since version 9.05: individual
CI failures no longer cause the entire push to fail, and you can review all failed CIs in the Universal
CMDB studio and then re-push them.

Duplicated logical.name issue
A typical fault youmay encounter is the duplicated logical name issue because of the different
unique key fields used in Universal CMDB and ServiceManager: CI logical.name in Service
Manager is unique, and it usually maps to CI display label in Universal CMDB (which is not unique).
HP recommends that you follow the following guidelines (listed from highest to lowest priority) to
resolve this issue:

l Make sure that each display label field value in UCMDB is unique;

l If uncertain of the above, in the adapter mapping configuration (XSLT file) avoid direct mapping
between Universal CMDB display label and SM logical name.

l Map SM logical name to another Universal CMDB field that is unique;

l Add a prefix or suffix to UCMDB display label value;

Note: Out-of-the-box, the SM logical name of Running Software is mapped with a prefix of
DNS name:

<xsl:variable name="fullDNSName" select="nodes/node/@primary_dns_name"/>

<xsl:for-each select="@display_label">
<CIIdentifier><xsl:value-of select="$fullDNSName"/>_

<xsl:value-of select="."/>
</CIIdentifier>
</xsl:for-each>

l If you cannot do any of the above, you can use the UCMDB Fault Detection and Recovery
mechanism together with the “Duplication Rule” setting of DEM rules (see the following).

To set up DEMRules for duplicated logical names:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules > Duplication
Rule tab.

3. For each of the Discovered Event Manager Rules, perform the following steps:
a. Go to the “Action if logical name is duplicated” section, and select theReturn Error option.

b. Save the Discovered Event Manager Rule record.
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Note: After you run a push job, CIs with a duplicated logical name are reported as failed
CIs with a duplicated name exception. You can review the failed CIs in the Universal
CMDB studio, fix the errors by either changing the data in Universal CMDB or in the
adapter mapping configuration file (XSLT), and then re-push the failed CIs.

Duplicated logical.name issue
A typical fault youmay encounter is the duplicated logical name issue because of the different
unique key fields used in Universal CMDB and ServiceManager: CI logical.name in Service
Manager is unique, and it usually maps to CI display label in Universal CMDB (which is not unique).
HP recommends that you follow the following guidelines (listed from highest to lowest priority) to
resolve this issue:

l Make sure that each display label field value in UCMDB is unique;

l If uncertain of the above, in the adapter mapping configuration (XSLT file) avoid direct mapping
between Universal CMDB display label and SM logical name.

l Map SM logical name to another Universal CMDB field that is unique;

l Add a prefix or suffix to UCMDB display label value;

Note: Out-of-the-box, the SM logical name of Running Software is mapped with a prefix of
DNS name:

<xsl:variable name="fullDNSName" select="nodes/node/@primary_dns_name"/>

<xsl:for-each select="@display_label">
<CIIdentifier><xsl:value-of select="$fullDNSName"/>_<xsl:value-of

select="."/>
</CIIdentifier>
</xsl:for-each>

l If you cannot do any of the above, you can use the UCMDB Fault Detection and Recovery
mechanism together with the “Duplication Rule” setting of DEM rules (see the following).

Set up DEM Rules for duplicated logical names:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules > Duplication
Rule tab.

3. For each of the Discovered Event Manager Rules, perform the following steps:
a. Go to the “Action if logical name is duplicated” section, and select theReturn Error option.

b. Save the Discovered Event Manager Rule record.
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Note: After you run a push job, CIs with a duplicated logical name are reported as failed
CIs with a duplicated name exception. You can review the failed CIs in the Universal
CMDB studio, fix the errors by either changing the data in Universal CMDB or in the
adapter mapping configuration file (XSLT), and then re-push the failed CIs.

How to Enable Lightweight Single Sign-On (LW-
SSO) Configuration

You can enable LW-SSO for the integration so that users can directly view UCMDB CI records
from the ServiceManager web client by clicking theView in UCMDB button, without providing a
UCMDB username and password.

Note: LW-SSO is not supported for the ServiceManagerWindows client.

To enable LW-SSO for the integration:

1. For each ServiceManager user account that needs LW-SSO, create a user account in
UCMDB with the same username. The passwords in the two systems can be different.

2. Enable LW-SSO in the ServiceManagerWeb tier. For details, see theConfigure LW-SSO in
the ServiceManagerWeb tier topic in the ServiceManager help.

3. Enable LW-SSO in UCMDB. For details, see theHP Universal CMDB Deployment Guide.

Frequently Asked Questions
This section provides answers to frequently asked questions about the UCMDB-SM integration.

This section includes:

l "When is a New CI Created in HP ServiceManager " on the next page

l "Can I Analyze the Reason for a CI Deletion in SM" on the next page

l "How do I Monitor Relationship Changes Between UCMDB and SM" on page 95

l What Kinds of Relationships are Pushed from UCMDB to SM

l "What is a Root CI Node" on page 96

l "What is a Root Relationship" on page 96

l "What is the “friendlyType” Specified in an XSLT File" on page 96
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l "What is the “Virtual-Compound” Relationship Type Used in a UCMDB-SM Integration Query"
on page 96

l "When do I Need the Population Feature" on page 96

l "Can I Populate Physically Deleted CIs from SM to UCMDB" on page 97

l "How do I Keep theOutage Dependency Setting of a CI Relationship in SM" on page 97

l "How do I Create an XSL Transformation File" on page 99

l "How do I Use the Load Fields Button to AddMultiple Managed Fields" on page 104

l "What is the Purpose of the <container> Element in a Population XSLT File" on page 105

l "Can I Populate Sub-Item Deletions" on page 106

l "What will Happen if a Population Job Fails or Succeeds withWarnings" on page 106

When is a New CI Created in HP Service Manager
CIs are created in SM under the following circumstances:

l A CI is manually added to SM via the “ConfigurationManagement” module.

l UCMDB reports a newly discovered CI according to the following:
n When a new CI is reported and the “Discovered Event Manager Rules” are set to “Add the

Record”.

n When a new CI is reported, the “Discovered Event Manager Rules” are set to “Open an
Incident” and the Incident has been closed.

n When a new CI is reported, the “Discovered Event Manager Rules” are set to “Open a
Change” and the Change has been verified.

Can I Analyze the Reason for a CI Deletion in SM
No.

SM opens a change request on the deleted CI and includes the following information:

“Delete event for CI “CI Name” triggered by discovery”.

Workaround

An SM change request does not contain a description of the reason for deletion, however it is
possible to extract specific information about CI deletions from the UCMDB “History Database”.
UCMDB data provides information about the user or the discovery pattern that initiated the CI
deletion.
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How do I Monitor Relationship Changes Between
UCMDB and SM

To understand the relationship change in SM, a distinctionmust bemade between the various
types of Relationship Changes:

l The second endpoint of the relationship has Changed, so instead of CI X being linked to CI Y via
a relationship, now CI X is related to CI Z.

l An attribute of a relationship has changed.

The first type of Relationship change is supported by the UCMDB-SM integration, therefore, such
“Relationship Changes” can either invoke CI relationship updates, or perform the creation of
Incidents or Changes, which are then reviewed andmonitored.

The second is also supported, but it is not covered out-of-the-box; you can configure the Universal
CMDB TQL to expose such attributes of relationship, and configure the ServiceManagerWSDL to
expose themapped field, and then configure the adapter mapping configuration in the XSLT.
However such “Relationship Attribute Changes” cannot perform the creation of Incidents or
Changes, and only supports invoking CI relationship updates directly.

What kinds of relationships are pushed from UCMDB
to SM?

Any kinds of “Relationships” are pushed from UCMDB to SM under the following conditions:

l The relationship appears in a “Push TQL” located in the “SM Sync” folder in the UCMDB Query
Manager.

l The relationship is named “Root” in the Push TQL.

l The relationship is mapped to an appropriate target in SM in the UCMDB configuration files
(XML and XSLT files).

The out-of-the-box relationships that are pushed from UCMDB to SM are relationships between two
CIs such as:

l Between Business Services and Applications;

l Between Business Service and Host;

l Between an Application and a Network Component; or

l Between Host, Network Components and Printers.
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What is a Root CI Node
A “Root” Node is a TQLNode that represents the CI type that is created via push to SM from the
TQL structure. The rest of the TQL structure contains information that can be incorporated within
the “Root” CI type and is used to enrich the record in SM with additional information and or
attributes.

What is a Root Relationship
A “Root” Relationship is a Relationship within a TQL and created in SM via push. It represents a
Relationship between two Root CIs. Only the relationships marked with “Root” are pushed to SM.

What is the “friendlyType” Specified in an XSLT File
friendlyType is another name for the UCMDB “CI Type”. These “friendly-types” are usually pushed
into the SM Device subtype field/attribute.

What is the “Virtual-Compound” Relationship Type
Used in a UCMDB-SM Integration Query

Whenmore than two UCMDB CI entities are connected in series, the “Virtual-Compound”
represents the relationship between the first and last entities. This is a virtual relationship, as no
physical representation exists.

The “Virtual-Compound” relationship type is a relationship that links two CI type entities that have a
logical relationship. See the following figure:

Explanation

The illustration shows an example of a Virtual-Compound relationship. The relationship in SM is
created directly between the “Host” and the “Business Service”.

When do I Need the Population Feature
You need the population feature under any of the following circumstances:

l You have donemodeling in SM, especially when you are in the planning and design phases, and
you want your models to be reflected in UCMDB;

l Youwant to implement the UCMDB-SM integration, however you have already invested in your
SM CMDB and do not want to lose that investment;
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l Youwant to continue tomaintain some parts of the SM CMDB while maturing your
UCMDB/Discovery implementation.

Can I Populate Physically Deleted CIs from SM to
UCMDB

No.

Physical deletions of CIs are allowed in SM, but SM cannot get such “deletion changes” and the
population feature will not synchronize such changes to UCMDB.

Physical deletions of CIs can be considered as exceptions, which only occur after you create CIs
by mistake. Normally, you delete a CI by setting its status to something like “Disposed/Retired”. In
case such CIs have been populated to UCMDB, it is your responsibility to remove themmanually
from UCMDB.

How do I Keep the Outage Dependency Setting of a
CI Relationship in SM

Out-of-the-box, CI relationships that are pushed from UCMDB to SM do not have outage
dependency information by default. If you need such information, you can set the DEM rule of the
CI RelationshipWSDL as follows:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. Open the ucmdbRelationship record.

4. On the Rules tab, select Add the record, and set dependency as true.

This will set the Outage Dependency of each CI Relationship to true, and set the number of
dependent downstream CIs to 1 (because UCMDB only supports one-to-one relationships).
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If you want to set outage dependency only for some relationships, for example, if you want to
configure outage dependency for relationships that starts from Business Service, you can configure
the adapter configuration file (XSLT) andWSDL definition; you can also configure outage
dependency per relationship type (UCMDB TQL).

1. In theWSDL definition, expose fields outage.dependency and outage.threshold.

2. In the XSLT file, set the exposed outage fields. For example, if you want to set the outage
dependency to true and threshold to 1 for Business Service relationships, you simply need to
change themapping of TQL and XSLT in the smSyncConfFile.xml file:

<tql name="applicationRelationsData" xslFile="bizservice_relations.xslt">

<request type="Create" name="CreateRelationship"/>

<request type="Update" name="UpdateRelationship"/>

<request type="Delete" name="DeleteRelationship"/>

</tql>

3. In the bizservice_relations.xslt file, use the following OutageDependency and
OutageThreadhold settings:

<xsl:stylesheet version='1.0' xmlns:xsl='http://www.w3.org/1999/XSL/Transfor
m'>

<xsl:template match="/relation">

<model>

<keys/>

<instance>

<ParentCI><xsl:value-of select="@parentID"/></ParentCI>

<ChildCIs>

<ChildCIs><xsl:value-of select="@childID"/></ChildCIs>
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</ChildCIs>

<RelationshipType>Logical</RelationshipType>

<RelationshipSubtype><xsl:value-of select="@friendlyType"/
></RelationshipSubtype>

<OutageDependency>true</OutageDependency>

<OutageThreadhold>1</OutageThreadhold>

</instance>

</model>

</xsl:template>

</xsl:stylesheet>

How do I Create an XSL Transformation File
You create an XSL transformation file in Adapter Management. You can copy the content of an
existing XSL transformation file to the new file and thenmake necessary edits.

To create an XSL transformation file:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management. ServiceManagerAdapter9-x
> Configuration Files.

3. Click theCreate new resource button .

4. Select New Configuration File.

5. Enter a name for the file. The file name should use this format: <AdapterID>/<filename>. For
example: ServiceManagerAdapter9-x/test_relation_population.xslt.

6. In the Package field, select the adapter name. For example, ServiceManagerAdapter9-x.

7. Click OK. A file extension warning dialog displays.

8. Click Yes to continue.
UCMDB creates the new XSL transformation file in the Configuration Files folder of the
adapter. For example, ServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/test_relation_population.xslt.

9. Copy the content of an existing XSL transformation file to the new file. For example, for
population you can copy the content of an out-of-the-box population XSL transformation file.

10. Make necessary edits to the new file.
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Caution: Invalid XML

When removing XSL elements from an XSLT file, keep inmind that the remaining XML should
be a valid XML file, which will be used to translate the UCMDB Query Definition. See the
following for an example.

Out-of-the-box, the businessservice_to_computer_containment_population.xslt file is
as the following:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transfor
m">

<xsl:template match="/Retrievecirelationship1to1ListResponse">

<topology>

<xsl:for-each select="instance">

<xsl:choose>

<xsl:when test="upstreamci.subtype='Infrastructure Servic
e'">

<ci class="infrastructure_service">

<attribute name="name" type="String"><xsl:value-of s
elect=
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">

<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>
</attribute>

</ci>

</link>

</ci>

</xsl:when>

<xsl:when test="upstreamci.subtype='Application Service'">

<ci class="business_application">
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<attribute name="name" type="String"><xsl:value-of s
elect=
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">

<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>
</attribute>

</ci>

</link>

</ci>

</xsl:when>

<xsl:otherwise>

<ci class="business_service">

<attribute name="name" type="String"><xsl:value-of s
elect=
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">

<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>
</attribute>

</ci>

</link>

</ci>

</xsl:otherwise>
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</xsl:choose>

</xsl:for-each>

</topology>

</xsl:template>

</xsl:stylesheet>

The file becomes an invalid XML file if you change it to the following:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transfor
m">

<xsl:template match="/Retrievecirelationship1to1ListResponse">

<topology>

<xsl:for-each select="instance">

<xsl:choose>

<xsl:when test="upstreamci.subtype='Infrastructure Service'">

<ci class="infrastructure_service">

</xsl:when>

<xsl:when test="upstreamci.subtype='Application Service'">

<ci class="business_application">

</xsl:when>

<xsl:otherwise>

<ci class="business_service">

</xsl:otherwise>

</xsl:choose>

<attribute name="name" type="String"><xsl:value-of sele
ct="upstreamci.logical.name"/>
</attribute>

<attribute name="sm_id" type="String"><xsl:value-of sel
ect="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">

<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>
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<attribute name="sm_id" type="String"><xsl:v
alue-of select=
"downstreamci.id"/></attribute>

</ci>

</link>

</ci>

</xsl:for-each>

</topology>

</xsl:template>

</xsl:stylesheet>

Sample usages of XSLT

For your reference, the following are some samples of using XSLT functionalities in this
integration.

Using choose to set CI subtypes:

<Type>switch</Type>

<xsl:variable name="prefix" select="'Value&gt;'"/>

<xsl:variable name="suffix" select="'&lt;/Value'"/>

<Subtype>

<xsl:choose>

<xsl:when test="contains(@node_role,concat($prefix,'atm_switch',$suffix))">A
TM Switch</xsl:when>

<xsl:when test="contains(@node_role,concat($prefix,'frame_relay_switch',$suf
fix))">Frame Relay Switch</xsl:when>

<xsl:when test="contains(@node_role,concat($prefix,'lan_switch',$suffix))">L
an Switch</xsl:when>

<xsl:otherwise><xsl:value-of select="@friendlyType"/></xsl:otherwise>

</xsl:choose>

</Subtype>

Getting the substrings from a string:

<xsl:variable name="calculatedLocation" select="@calculated_location"/>

<Building>
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<xsl:value-of select="substring-after($calculatedLocation,' Building:')"/>

</Building>

<Floor>

<xsl:value-of select="substring-before(substring-after($calculatedLocation,'Fl
oor:'),' Building:')"/>

</Floor>

<Room>

<xsl:value-of select="substring-before(substring-after($calculatedLocation,'Ro
om:'),' Floor:')"/>

</Room>

Reading the value mappings from an XML file:

The SM_CIT_Subtype_list.xml file defines the valuemappings for subtypes:

<lists>

<list name="CIType_bizservice">

<entry ucmdb="BusinessApplication" sm="Application Service"/>

<entry ucmdb="BusinessService" sm="Business Service"/>

<entry ucmdb="InfrastructureService" sm="Infrastructure Service"/>

</list>

</lists>

The business_service_push.xslt file uses this mapping definition XML file:

<xsl:variable name="CIlists" select="document('SM_CIT_Subtype_list.xml')/list
s"/>

<xsl:variable name="CIT" select="@bdmType"/>

<xsl:for-each select="$CIlists/list[@name='CIType_bizservice']">

<Subtype><xsl:value-of select="entry[@ucmdb=$CIT]/@sm"/></Subtype>

</xsl:for-each>

Tip: Formore information about XSL transformations, visit the following site:
http://www.w3schools.com/xsl/

How do I Use the Load Fields Button to Add Multiple
Managed Fields

ServiceManager stores the list of managed fields in the ucmdbIntegration web service, which
consists of a number of web services objects. You can addmoremanaged fields to DEMRules so
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that ServiceManager canmonitor changes inmore CI attributes in UCMDB and trigger the actions
defined in relevant DEM Rules.

You canmanually addmanaged fields that are exposed in associatedWSDL definitions to DEM
Rules; however, you can use the Load Fields button to automatically (and therefore correctly) add
managed fields to DEMRules.

1. Click theManaged Fields tab of the DEMRule.

2. Click the Load Fields button.

3. If the table (in the Table Name field) of the DEM rule record has only oneWSDL definition
associated to it, all fields exposed in theWSDL definition are immediately added to the
Managed Fields list.
A message displays: <XX> new fields loaded.

4. If the table has more than oneWSDL definition associated to it, theManaged Fields Importing
wizard opens, and a list of WSDL definitions (ucmdbIntegration web service objects) displays.
a. Select one or more objects, and click Next.

b. All new fields that can be added from the selected web service objects display.

c. If you want to add all of the fields, click Finish; if you want to ignore some of them, change
their Action value fromAdd to Ignore, and then click Finish.
A message displays: <XX> new fields loaded.

5. Save the DEMRule record.

What is the Purpose of the <container> Element in a
Population XSLT File

Out-of-the-box, in the runningsoftware_population.xslt file, there is a container element:

<link direction="incomming" linkType="composition">

<ci class="node">

<container tql="SM Computer Population" keyFields="CIIdentifier">

<linkTql>SM Computer To Software With Composition</linkTql>

<linkRetrieveCondition>downstreamci.logical.name=&quot;<xsl:value-o
f select="CIIdentifier"/>
&quot;</linkRetrieveCondition>

<linkValueFields>upstreamci.logical.name</linkValueFields>

</container>

</ci>

</link>
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l In UCMDB, RunningSoftware CIs must exist together with a Root Container (Node), however
ServiceManager allows RunningSoftware CIs without a Node.

l The current integration adapter synchronizes CIs and Relationships separately; when populating
a RunningSoftware CI, the integration has no chance to check if a relationship exists between
the CI and a Node.

With the <container> element, the integration populates RunningSoftware CIs together with a
container.

Can I Populate Sub-Item Deletions
Yes.

ServiceManager and UCMDB store CI information in different data structures, and therefore one
SM CI may be synchronized to UCMDB as several CIs. For example, during population, an SM
computer CI record is synchronized to a Node CI in UCMDB, and the computer CI’s attributes to
CIs such as IP, Interface, Location, etc (which are referred to as sub-items of the Node CI.). In this
case, the Node CI is the root CI.

The integration allows you to populate sub-item deletions to UCMDB (for example, if you delete the
IP Address attribute value of a computer, the corresponding IP CI record in UCMDB will be deleted
too). To do so, you need to specify a root in the CI type’s population xslt file, using parameter
isRoot="true". For example, for Computer CIs, the “node” should be specifed as the root.

Out-of-the-box, only the computer_population.xslt file requires the “node” CI be specified as the
root, as shown below:

<ci class="node" isRoot="true">

What will Happen if a Population Job Fails or
Succeeds with Warnings

When a population job fails:

The failure prevents the remaining population tasks from running. The next job run will start from the
last Success time. If pagination occurs (that is, the tasks are divided intomultiple pages), the tasks
will run again and again within the first page from the last “Success” time (once the end of the first
page is reached, no new tasks will be executed).

When a population job succeeds with warnings:

A warning does not prevent the remaining population tasks from running. The next job run will run all
tasks again starting from the last Success time. If pagination occurs (the tasks are divided into
multiple pages), the tasks on all pages will be re-run (including those that were successfully
completed last time).

Known Issues and Limitations
The following table lists the known issues and limitations of this integration.
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Global ID Known Issue/Limitation Workaround

QCCR1E7224
6

[Population Adapter] Cannot
populate deleted CIs in a full
population.

While you run a full population, if
there are CIs that have been
deleted since the last job run in
ServiceManager, the deleted CIs in
ServiceManager will not be
populated to UCMDB.

However, the data push feature first
pushes deleted CIs while running a
full push.

In UCMDB, manually delete all CIs that
were populated from SM by using
appropriate filter criteria and then run a
full population.

Warning: Youmust be very careful
when using this workaround.

QCCR1E7222
2

NodeRole is case-sensitive when
mapping Node's NodeRole in
UCMDB to Node's Subtype in SM.

Steps to reproduce this issue:

1. Create a Node in UCMDB.

2. Set the Node's NodeRole
property to "Printer".

3. Run a data push in UCMDB to
push Node CIs.

4. Check the CI's attributes in
SM.

Result: The CI's subtype is
"Node", which should be "Net
Printer".

When the NodeRole is "printer", the
result is correct.

Use lower-case names for NodeRole
(printer).

Known Issues and Limitations
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Global ID Known Issue/Limitation Workaround

QCCR1E7232
7

When you run a full population for
the first time to synchronize a large
amount of CIs, if some of the CIs
have an invalid attribute value (for
example, IP address), the
population job will ignore such CIs
and run to completion with a Failed
status and with errors logged on the
Job Errors tab; In addition, the last
job execution time will not be
logged because the job is run for the
first time but fails.

As a result, after fixing the invalid
attribute values in Service
Manager, you will not have a
chance to re-populate the failed CIs
through a change (delta) population.
This is because when you run a
change population, a full population
will be executed instead (because
the last job execution time is null).

Not available at this time.

QCCR1E8436
4

When “Run inMulti-Company
Mode” is enabled in the System
Information Record in Service
Manager (SM), the UCMDB
integration fails to create changes
or incidents in SM because the
configuration item datamodification
event fails. The following error
occurs:

ERROR TypeError:
lib.uCMDBConfiguration.isEnab
le is not a function at char
1

To solve this issue, manually update a
JavaScript:

1. Log in to ServiceManager as a
system administrator.

2. Go to Tailoring > Script Library,
and open the discoveryEvent
script.

3. In this file, replace all instances of
string
lib.uCMDBConfiguration.isEnab
lewith
lib.uCMDBConfiguration.isEnab
led.
Note:You can find the string in lines
43, 86 and 405.

4. Click Compile to make sure the
code is correct, and then click Save.

5. Log off and log back in.

Known Issues and Limitations, continued
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Global ID Known Issue/Limitation Workaround

QCCR1E7251
1

If you set the use.global.id
parameter in the adapter's
sm.properties file to True, the
federation feature does not work.

Set the parameter to False to solve this
issue.

l When you deploy the adapter on the
UCMDB standalone server (which is
defined as a global-id generator by
default), globalId and ucmdbId are the
same thing. For this reason, setting
this parameter to false canmeet all of
your needs satisfied by setting the
parameter to true.

l When you deploy the adapter on a
non-standalone UCMDB (for
example, BSM's RTSM), setting this
parameter to true is not supported. In
addition, HP does not recommend
integrating the non-standalone CMDB
(for example, BSM's RTSM) with
ServiceManager.

QCCR1E7257
8

The data length of CI relationship
name in ServiceManager is 40
characters, which is not sufficient
for the integration. Installing this
content pack does not
automatically increase this data
length in ServiceManager.

If a CI relationship name exceeds
the data length, either the
relationship name is truncated after
push or the relationship cannot be
pushed to ServiceManager due to a
duplicate key error.

Manually increase the data length in
ServiceManager:

Open the cirelationship table in Database
Dictionary, and increase the data length
of the relationship.name field from 40 to
an appropriate value (recommended
value: 300).

QCCR1E7300
4

Double quotes in UCMDB CI
names (for example: "laptop - 003")
are removed when the CIs are
synchronized to SM.

Not available at this time.

Known Issues and Limitations, continued
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Tailoring the Integration
You can tailor the HP Universal CMDB integration tomeet your business needs by adding or
removingmanaged CI types, attributes, and relationship types. This chapter describes the
integration architecture and tailoring options for data push, population, and federation.

This section includes:

l "Integration Architecture" below

l "Integration Tailoring Options" on page 123

Integration Architecture
Before you tailor the integration, you should understand how the following components of the out-of-
the-box integration work.

l "Integration Class Model" below

l "Integration TQLQueries" below

l "ServiceManagerWeb Services" on page 115

l "ServiceManager Reconciliation Rules" on page 119

l "ServiceManager Discovery Event Manager Rules" on page 121

Integration Class Model
UCMDB 9.x or later no longer uses a private class model of CI types tomanage integration CIs, as
was required in prior versions. Instead, the integration uses the standard UCMDB managed objects
andmaps them to ServiceManager CI types and attributes with queries and transformation files.

Integration TQL Queries
This section describes out-of-the-box Topology Query Language (TQL) queries used for data push,
Actual State, and population.

This section includes:

l "TQLQueries for Push" on the next page

l "TQLQueries for Actual State" on page 113

l "TQLQueries for Population" on page 113

l "TQLQuery Requirements" on page 114
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TQL Queries for Push
For the push feature, the integration uses a collection of TQL queries to gather CI attribute
information from Universal CMDB and send it to the ServiceManager system.

To access the out-of-the-box data push queries, navigate toModeling >Modeling Studio, select
Queries for Resource Type, and then navigate to theRoot > Integration > SM Sync > 9.xx folder.

If you want to change what CI/Relationship types or attributes are part of the integration, youmust
also edit the integration queries to support your updated CI/CI Relationship types and attributes.

Query
name Description

SM
Running
Software
Push

This query gathers CI attributes from Running Software CIs.

SM
Business
Service
Push

This query gathers CI attributes from business service CIs.

SM
Business
Service
Relations
Push

This query gathers relationships between the following components:

l Business service and Running Software CIs

l Business service and node CIs

l Two ormore business services

The query includes compound relationships because the relationships can extend
through a group.

SM
Computer
Push

This query gathers CI attributes from the node CI type with NodeRole containing
“desktop”, “server”, “virtualized_system” or not set.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Switch
Push

This query gathers CI attributes from the node CI type with NodeRole containing
“atm_switch”, “frame_relay_switch”, or “lan_switch”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

Out-of-the-box TQL queries for data push
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Query
name Description

SM
Storage
Push

This query gathers CI attributes from the node CI type with NodeRole containing
“san_switch”, “san_gateway”, “san_router” or exact CI type equal to “storage
Array”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Net
Printer
Push

This query gathers CI attributes from the node CI type with NodeRole containing
“printer”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM
Mainframe
Push

This query gathers CI attributes from the node CI type with exact CI type equal to
“Mainframe Logical Partition”, or “MainframeCPC”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SMMobile
Device
Push

This query gathers CI attributes from the node CI type with NodeRole containing
“pda_handheld”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM
Network
Component
Push

This query gathers CI attributes from the node CI type with NodeRole containing
“router”, “adsl_modem”, “appletalk_gateway”, “bandwith_manager”, “cable_model”,
“csu_dsu”, “ethernet”, “fddi”, “firewall”, “hub”, “kvm_switch”, “load_balancer”,
“multicast_enabled_router”, “nat_router”, “token_ring”, “undefined_network_
component”, “voice_gateway”, “voice_switch”, or “vpn_gateway”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Cluster
Push

This query gathers CI attributes from the node CI type with exact CI type equal to
“ClusterResourceGroup”.

It also gathers related CI attributes from the following CI types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, Location, and
Cluster.

SM Node
Relations
Push

This query gathers relationships between the following components:

l Node and Printer CIs

l Node and RunningSoftware CIs

The root class of the relationship is composition.

Out-of-the-box TQL queries for data push, continued
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Query
name Description

SMCRG
Relations
Push

This query gathers relationships between the following components: Node and
Cluster Resource Group CIs.

The query includes compound relationships because the relationships can extend
through a group.

SM Layer2
Topology
Relations
Push

This query gathers relationships between the following components: Two ormore
nodes.

The query includes compound relationships because the relationships can extend
through a group.

SM Local
Printer
Push

This query gathers CI attributes from printer CIs.

It also gathers related CI attributes from the Node CI type.

Out-of-the-box TQL queries for data push, continued

TQL Queries for Actual State
Out-of-the-box, the following TQL queries (see the table below) are used for retrieving CI
information from UCMDB to the Actual State section of the ServiceManager Configuration Item
(CI) form. ServiceManager retrieves CI Actual State information by calling a UCMDB web service
that retrieves CI data according to these queries.

The queries are located in the Integration > SM Query folder in the UCMDB Modeling Studio.

Query name Description

localPrinterExtendedData This query gathers real-time extended information from Printer
CIs in UCMDB.

applicationExtendedData This query gathers real-time extended information from
RunningSoftware CIs in UCMDB.

businessServiceExtendedData This query gathers real-time extended information from
business service CIs in UCMDB.

hostExtendedData This query gathers real-time extended information (such as
Asset, Party, Location, LogicalVolume, WindowsService,
Printer, InstalledSoftware, FileSystem, IPAddress, Interface,
DiskDevice, and Cpu) from the node CI type in UCMDB.

Out-of-the-box TQL queries for Actual State

TQL Queries for Population
For CI/CI Relationship population, the integration does not need TQL queries to save CI/CI
Relationship attribute information to Universal CMDB; however in the population configuration file
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the following TQL query names aremapped to relevant population XSL transformation files (see the
following table).

Query name Description

SM Business Service
Population

This query defines the CI store structure of business service CIs.

SM Computer To
ComputerWith
ConnectM Running
Software Population

This query defines the CI store structure of running software CIs.

SM Computer Population This query defines the CI store structure of computer CIs.

SM Biz To Biz With
Containment

This query defines the CI store structure of CI relationships in which
a bizservice CI contains another.

SM Biz To Biz With
Usage

This query defines the CI store structure of CI relationships in which
a bizservice CI uses another.

SM Biz To Computer
With Containment

This query defines the CI store structure of CI relationships in which
a bizservice CI contains a computer CI.

SM Biz To Computer
With Usage

This query defines the CI store structure of CI relationships in which
a bizservice CI uses a computer CI.

SM Biz To SoftwareWith
Containment

This query defines CI store structure of CI relationships in which a
bizservice CI contains a RunningSoftware CI.

SM Biz To SoftwareWith
Usage

This query defines CI store structure of CI relationships in which a
bizservice CI uses a RunningSoftware CI.

SM Computer To
ComputerWith Connects

This query defines the CI store structure of CI relationships in which
a computer CI connects to another.

SM Computer To
SoftwareWith
Composition

This query defines the CI store structure of CI relationships in which
a RunningSoftware CI is contained within a computer CI and the
RunningSoftware CI cannot exist without the container.

CLIP Down Time
Population

This query defines the CI store structure of ScheduledDowntime
CIs.

CI To Down TimeCI With
Connection

This query defines the CI store structure of CI relationships in which
a ScheduledDowntime CI connects to an affected CI.

TQL queries for population

TQL Query Requirements
The integration requires that any custom TQL queries you createmeet certain formatting
conditions. Any TQL queries that you want to include in the integrationmust meet these conditions:
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l To query CIs, a query must contain one CI type labeledRoot. The Root node is themain CI that
the UCMDB synchronizes. All other CIs are contained CIs of the Root CI.

l To query relations, a query must contain one or more relationships labeledRoot.

l A query must contain only the Root CI and CIs that are directly connected to it. The Root CI is
always the top node of the TQL hierarchy.

l A TQL graph cannot have cycles.

l If a query synchronizing relationships has cardinality, it must be cardinality 1...*. Additional
cardinality entries must have anOR condition between them.

l If you only want the integration to synchronize specific CIs, youmust configure the condition on
the TQL query to filter such CIs.

Service Manager Web Services
ServiceManager uses web services messages to get and receive CI information from your
UCMDB system. Out-of-the-box, UCMDB sends more CI attribute information than the Service
Manager system actually manages. ServiceManager users can view all of the CI attribute
information the UCMDB system sends from the Actual State section of the CI record.

ServiceManager publishes several web services for use by the UCMDB-SM integration. The
UCMDB system uses the web services tomapUCMDB CI types and CI attributes to web services
objects the ServiceManager system recognizes. If you add UCMDB CI types or CI attributes that
you want ServiceManager to manage, then youmust update one or more of these web services to
define them as web services objects. See theServiceManagerWeb Services Guide for more
information about publishing web services.

Managed Fields

Note: Managed fields are used only for the data push feature.

A ServiceManager managed field is a field where the system compares the CI attribute value in the
incoming UCMDB web services message to the value in a ServiceManager CI record. If the values
in the web services message do not match those in the CI record, ServiceManager runs a
Discovery Event Manager (DEM) rule to determine what action to take. The DEM rule determines
which of the fields that are published as web services objects are fields managed by the integration.
Only value changes inmanaged fields trigger the DEM rule.

ServiceManager stores the list of managed fields in the ucmdbIntegration web service. The
ucmdbIntegration web service consists of a set of web services objects. Out-of-the-box, the
integration uses only part of them (see theMappings between ServiceManager web service
objects, tables, and DEM rules table), some of them (along with their relevant DEM Rules) have
been deprecated (see the Deprecated ucmdbIntegration web service objects for data push table),
and some are used for population or federation (see the ucmdbIntegration web service objects used
for population or federation table).
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This web service object Publishes fields from this table And uses this DEM rule ID

Relationship cirelationship ucmdbRelationship

ucmdbRunningSoftware device ucmdbRunningSoftware

ucmdbBusinessService joinbizservice ucmdbBusinessService

ucmdbNode joinnode ucmdbNode

Mappings between Service Manager web service objects, tables, and DEM rules

This web service
object

Publishes fields from this
table

Recommended replacement
(object)

ucmdbApplication device ucmdbRunningSoftware

ucmdbComputer ucmdbComputer ucmdbNode

UcmdbDevice device ucmdbRunningSoftware

ucmdbNetwork joinnetworkcomponents ucmdbNode

ucmdbPrinter joinofficeelectronics ucmdbNode

Deprecated ucmdbIntegration web service objects for data push

This web service
object

Publishes fields from this
table

And is used
for

Requires a DEM
Rule?

cirelationship1to1 cirelationship1to1 Population No

ucmdbIDPushBack device Population No

UcmdbChange cm3r Federation No

UcmdbChangeTask cm3t Federation No

UcmdbIncident probsummary Federation No

UcmdbProblem rootcause Federation No

ucmdbIntegration web service objects used for population or federation

The following sections list the fields published as web services objects used for data push (see the
Mappings between ServiceManager web service objects, tables, and DEM rules table) and
indicate whether they aremanaged fields in an out-of-the-box ServiceManager system. You can
use this reference to determine if you need to publish a field as a web service object, and also if you
need to create a DEM rule for the object.

Object Name: Relationship

ServiceManager publishes the following fields from the cirelationship table:
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Field published as web
service object

Caption used in web service
messages

Is the field a managed
field?

relationship.name RelationshipName

logical.name ParentCI

related.cis ChildCIs Yes

relationship.subtype RelationshipSubtype

Web service and managed fields of the Relationship object

Object Name: ucmdbRunningSoftware

ServiceManager publishes the following fields from the device table:

Field published as web
service object

Caption used in web service
messages

Is the field a managed
field?

ucmdb.id UCMDBId

ci.name ApplicationName Yes

type Type

subtype Subtype

company CompanyId

logical.name CIIdentifier Yes

product.version ProductVersion

vendor Vendor

version Version

id1 CIName

Web service and managed fields of the ucmdbRunningSoftware object

Object Name: ucmdbBusinessService

ServiceManager publishes the following fields from the joinbizservice table:

Field published as web
service object

Caption used in web service
messages

Is the field a managed
field?

ucmdb.id UCMDBId

ci.name ServiceName Yes

Web service and managed fields of the ucmdbBusinessService object

1This attribute is used only for the population feature.

Universal Discovery Content Guide - ServiceManager Integration
Tailoring the Integration

Page 117 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



Field published as web
service object

Caption used in web service
messages

Is the field a managed
field?

type Type

subtype Subtype

company CustomerId

logical.name CIIdentifier Yes

vendor ServiceProvider

id1 CIName

Web service and managed fields of the ucmdbBusinessService object, continued

Object Name: ucmdbNode

ServiceManager publishes the following fields from the joinnode table:

Field published as web
service object

Caption used in web service
messages

Is the field a managed
field?

ucmdb.id UCMDBId

type Type

subtype Subtype

company CustomerId

logical.name CIIdentifier Yes

default.gateway DefaultGateway Yes

network.name DNSName Yes

building Building Yes

room Room Yes

floor Floor Yes

location Location

addlIPAddr[addlIPAddress] AddlIPAddress Yes

addlIPAddr[addlSubnet] AddlSubnet Yes

addlMacAddress AddlMacAddress Yes

Web service and managed fields of the ucmdbNode object

1This attribute is used only for the population feature.
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Field published as web
service object

Caption used in web service
messages

Is the field a managed
field?

bios.id BIOSId Yes

operating.system OS Yes

os.version OSVersion Yes

physical.mem.total PhysicalMemory Yes

serial.no. SerialNo

vendor Vendor

cpu[cpu.id] CpuID

cpu[cpu.name] CpuName

cpu[cpu.clock.speed] CpuClockSpeed

file.system[mount.point] MountPoint

file.system[disk.type] DiskType

file.system[file.system.type] FilesystemType

file.system[disk.size] DiskSize

asset.tag AssetTag

machine.name HostName Yes

disk.device[model.name] ModelName

disk.device[disk.vendor] DiskVendor

disk.device[disk.name] DiskName

id1 CIName

isVisualization IsVisualization

istatus AssetStatus

Web service and managed fields of the ucmdbNode object, continued

Service Manager Reconciliation Rules
ServiceManager reconciliation rules allow the integration to identify CI records in your Service
Manager system that match CIs in your UCMDB system. ServiceManager attempts to reconcile
CI records with every push of CI attributes from your UCMDB system. The integration uses the
following workflow tomatch UCMDB CIs with ServiceManager CIs.

1This attribute is used only for the population feature.
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1. The UCMDB system sends a web servicemessage to ServiceManager containing the latest
CI attribute data.

2. ServiceManager scans the web servicemessage for the CI ucmdb.id value.

Note: Out-of-the-box, ServiceManager does not display the ucmdb.id field on CI record
forms to prevent users from changing the value. If you want to add this value to your
forms, you can find the ucmdb.id field defined in the device table. HP recommends that
youmake this a read-only field.

3. ServiceManager searches for an existing CI record that has the same ucmdb.id value.

4. If ServiceManager finds a CI with amatching ucmdb.id value, no reconciliation is needed.
ServiceManager compares the UCMDB CI attributes to the ServiceManager managed fields
and runs the appropriate Discovery Event Manager (DEM) rules as needed.

5. If ServiceManager cannot find a CI with amatching ucmdb.id value, it runs the reconciliation
rules.

6. ServiceManager searches for an existing CI record with the same reconciliation field values.

7. If ServiceManager finds a CI with amatching reconciliation field value, it updates the CI record
with the ucmdb.id value of matching UCMDB CI. ServiceManager compares the UCMDB CI
attributes to the ServiceManager managed fields and runs the appropriate DEM rule as
needed.

8. If ServiceManager cannot find a CI with amatching reconciliation field value, it runs the DEM
rule for “Action if matching record does not exist.” Out-of-the-box, the DEM rule has Service
Manager create a new CI record. ServiceManager creates the CI record using the ucmdb.id
value of incoming UCMDB CI.

Performance Implications
Because ServiceManager attempts to reconcile CIs with every push, the number of reconciliation
fields you have will affect the integration’s performance. Themore reconciliation rules you have, the
more searches ServiceManager must perform tomatch CIs. To improve the performance of
reconciliation searches, you should choose reconciliation fields that are unique keys of the
underlying ServiceManager table. For example, if you want to reconcile CI records in the device
table, use the logical.name field as a reconciliation field because it is a unique key. See "How to
Add DEMReconciliation Rules" on page 128 to create a reconciliation rule.

Dependence on DEM Rules
ServiceManager uses the “Action if matching record does not exist” DEM rule whenever it cannot
reconcile CIs. You should review the DEM settings and decide if they meet your business
standards prior to the initial push of CIs from UCMDB to ServiceManager. For example, you can
have ServiceManager create a change request for every CI in the initial CI push by selecting the
“Open a change” option.
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Service Manager Discovery Event Manager Rules
You only need to create Discovery Event Manager (DEM) rules if you want to accomplish any of the
following custom actions:

l "Change the Conditions UnderWhich a DEMRule Runs" below

l "Change the Action the DEMRule Takes" below

l "Update the List of Managed Fields for a CI Type" on the next page

l "Create Custom JavaScript to Open Change or Incident Records" on the next page

Change the Conditions Under Which a DEM Rule Runs
ServiceManager will run a DEM rule only if the condition field evaluates to true. Out-of-the-box, no
DEM rule has a condition statement that restricts when the rule runs, and all the integration DEM
rules will always run by default.

You can update a DEM rule's condition statements if you want to restrict when ServiceManager
runs your DEM rules. For example, adding the following condition to the ucmdbNode DEM rule
restricts the rule to desktop CIs.

subtype in $L.file=”Desktop”

You can also use the condition field to createmultiple DEM rules that apply to the same table name.
For example, the following DEM rules both apply to the joinnode table.

DEM rule Id Table Name Condition

ucmdbNode joinnode subtype in $L.file!=”Desktop”

ucmdbDesktop joinnode subtype in $L.file=”Desktop”

DEM rules using different conditions to affect the same table

Typically, you will only need to add conditions if your business processes require the integration to
take different actions with certain CI types or SLAs.

Change the Action the DEM Rule Takes
Out-of-the-box, the integration DEM rules take the following actions:

l Add a CI record when the UCMDB data does not match an existing ServiceManager CI record

l Open a Change or log results and update a CI record when the UCMDB CI attribute data does
not match the CI attribute data in the ServiceManager CI record

l Delete a CI record when the UCMDB data specifies that the CI has been deleted
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You can change the integration DEM rules tomeet your business processes. For example, you
could use the ucmdbNode DEM rule to open a change when the integration finds a non-desktop CI
with unexpected data, and use the ucmdbDesktop DEM rule to log results and update the record
when the integration finds a desktop CI with unexpected data.

Caution: If you want to use the ChangeManagement verification and ChangeManagement
validation features of the integration, your DEM rules must use theOpen a Change option for
the “Action if record exists but unexpected data discovered” event.

Update the List of Managed Fields for a CI Type
If you add CI attributes to your UCMDB system that you want to include in the integration, you
must also creatematchingmanaged fields in ServiceManager. Eachmanaged field must have a
corresponding web services object definition in order to receive CI attribute updates from your
UCMDB system. See "How to Add a CI Attribute to the Integration for Data Push" on page 135 and
"How to Add a CI Type to the Integration for Data Push" on page 149 for information on how to add
managed fields.

Create Custom JavaScript to Open Change or Incident
Records

ServiceManager uses the discoveryEvent JavaScript to create CI names and to set the values of
required fields when opening change or incident records. Out-of-the-box, the script uses the
following default values.

Default values to create a new CI

You can update the createCIName and populateNewCI functions to set the following CI values.

CI attribute Default value defined in discoveryEvent

record.logical_name System generated ID number

record.assignment AUTO

record.istatus Installed

record.os_name Value in record.operating_system

Default values used to create a new CI

Default values to create a new change

You can update the populateChange function to set the following change values.
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CI attribute Default value defined in discoveryEvent

change.category Unplanned Change

change.reason Value in reason

change.initial_impact 3

change.severity 3

change.coordinator Change.Coordinator

change.requested_by discovery

change.status initial

Default values used to create a new change

Default values to create a new incident

You can update the populateIncident function to set the following incident values.

CI attribute Default value defined in discoveryEvent

incident.category incident

incident.subcategory hardware

incident.product_type missing or stolen

incident.assignment Hardware

incident.initial_impact 3

incident.severity 3

incident.logical.name Value of id

incident.site_cateogry C

incident.contact_name ANALYST, INCIDENT

incident.affected_item MyDevices

Default values used to create a new incident

Integration Tailoring Options
The integration offers the following tailoring options:

l "How to Update the Integration Adapter Configuration File (sm.properties)" on the next page

l "How to Add DEMReconciliation Rules" on page 128
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l "Add Discovery Event Manager Rules" on page 131

l "How to Add a CI Attribute to the Integration for Data Push" on page 135

l "How to Add a CI Type to the Integration for Data Push" on page 149

l "How to Add a CI Type’s Relationship Types to the Integration for Data Push" on page 172

l "How to Add Custom TQLQueries to Data Push Jobs" on page 178

l "How to Add a CI Attribute to the Integration for Population" on page 179

l "How to Add a CI Type to the Integration for Population" on page 182

l "How to Add a CI Type’s Relationship Types to the Integration for Population" on page 198

l "How to Customize UCMDB ID Pushback for a CI Type" on page 202

l "How to Add Custom TQLQueries to Integration Population Jobs" on page 204

l "How to Add an Attribute of a Supported CI Type for Federation" on page 205

How to Update the Integration Adapter Configuration
File (sm.properties)

The integration uses a properties file (sm.properties) as a configuration file of the adapter. Out-of-
the-box, this file has been set up based on best practices, so usually you can keep the default
parameter values. Optionally, you can update the parameter values to better suit your needs.

To update the sm.properties file:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Click the properties configuration file: sm.properties.

4. Update the parameter values as needed. For a list of the parameters, see the following table.

Parameter Default value Comment

timeout.minutes 10 The integration connection
timeout value (in minutes).

Parameters in the sm.properties file
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Parameter Default value Comment

number.of.concurent.sending.threads 6 The number of concurrent
threads used for the data push
feature.

n 1: Disabled

n 2 or higher: Enabled

Note: If you are
connecting tomultiple
ServiceManager
instances to improve the
CI data push performance
(see the URLOverride
configuration in "How to
Create an Integration
Point in UCMDB" on page
29), you are
recommended to increase
this value for optimized
performance. For
example, set it to 12 if you
are connecting to two
ServiceManager
instances.

min.objects.for.concurent.sending 50 Theminimum number of
ServiceManager objects that
is required to use concurrent
sending instead of single
thread sending.

Note: It is used for the
push feature.

number.of.chunks.per.thread 3 The number of chunks per
thread used for the push
feature.

Parameters in the sm.properties file, continued
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Parameter Default value Comment

number.of.cis.per.request 1000 Themaximum number of
objects retrieved from Service
Manager by ID.

Note: It is used for the
population and federation
features. Do not set it to
a number greater than
1000 in case the request
has a 64K limit.

use.global.id false If set to true, globalId instead
of ucmdbId is used in the
integration. For more
information about the
differences between UcmdbID
andGlobalID, see the
UCMDB documentation.

type.of.expand.enum 2 It configures the value
mapping rule for the UCMDB
enum type.

n 0: The feature will be
disabled

n 1: The enum type will
expand to “{value}”

n 2: The enum type will
expand to “{index}-{value}”

Note: It is used for the
push feature.

Parameters in the sm.properties file, continued
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Parameter Default value Comment

use.type.label true It configures whether the
generated source XML uses
the real CI/Relationship type
directly or uses the label that
is defined in the TQL.

If set to false, the real type is
used directly instead of the
label.

op.pagination.switch on It indicates if pagination (client
driven) is enabled.

n on: Enabled.

n off: Disabled.

Note: It is used for the
population feature.

pop.pagination.recordcount 1000 Themaximum number of
records displayed on each
page when pagination is
enabled.

Note: It is used for the
population feature.

pop.createci.key sm_id The UCMDB field of a CI
record that stores the Service
Manager CI ID.

Note: It is used for the
population feature.

Parameters in the sm.properties file, continued
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Parameter Default value Comment

ucmdbid.pushback.request UpdateucmdbID
PushBackRequest

The web service request for
pushing the UCMDB ID back
to ServiceManager.

Note: It is used for the
population feature.

ucmdbid.pushback.xslt ucmdbid_
pushback.xslt

The xslt configuration file for
pushing the UCMDB ID back
to ServiceManager.

Note: It is used for the
population feature.

check.sm.connections false It indicates whehter to check
the SOAP connections to
ServiceManager instances
before running a job.

You can enable it under any of
the following circumstances:

n Your ServiceManager is
running in High Availability
mode (with load balancing),
and you want to connect
UCMDB tomultiple Service
Manager instances.

n Youwant UCMDB to not
run a job when no
integration connections are
available, rather than run
the job and then report a
failure.

Parameters in the sm.properties file, continued

How to Add DEM Reconciliation Rules
It is possible that your ServiceManager system already contains CI records that match CIs in your
UCMDB system. Rather than add duplicate CI records to your ServiceManager system, you can
configure ServiceManager to reconcile CI records between the two systems based on the values
of specific fields.
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ServiceManager always attempts to reconcile CI records based on the unique key field of the
ServiceManager table and the ucmdb.id field. You can specify additional fields to reconcile on
from the DEMReconciliation Rules form. If ServiceManager finds amatching value in any one of
these fields, it updates the ServiceManager CI record with the attributes from the incoming
UCMDB record.

Whenmulti-tenancy is enabled, ServiceManager only reconciles the CIs whose company ID
matches the company ID in the data push job. For example, when pushing CIs from company 2, the
reconciliation rules only apply to the ServiceManager CI records that have the company code
corresponding to company number 2.

In order to specify reconciliation fields, you will need to be familiar with the table and field names in
both your ServiceManager and UCMDB systems. If you want to reconcile on a particular attribute
from the UCMDB system, you should verify that there is a corresponding ServiceManager
managed field for the attribute. Without such amapping, ServiceManager will not know to search
for matching values in the CI record.

Note: Not all UCMDB attributes have a corresponding field in ServiceManager. Youmay need
to tailor your ServiceManager system to add amatching field if one does not already exist.

Using join tables for reconciliation
When setting reconciliation rules, if the device type you are reconciling has a joindef definition (as
defined in the devtype table), use the join table name instead of the device table. For example, if
you want to reconcile computer CIs, use the joincomputer table instead of the device table.

Sequence of reconciliation
A reconciliation rule specifies what ServiceManager table and field you want to search for matching
CI values. It also specifies the sequence in which you want ServiceManager to process
reconciliation rules. By default, ServiceManager processes rules in alphabetical order by field
name. For example, ServiceManager will reconcile CIs against the asset.tag field before
reconciling CIs on the ci.name field.

To change the order in which ServiceManager reconciles CIs, you can add a numeric value to the
sequence field. For example, the following reconciliation rules ensure that ServiceManager
processes CIs by the ci.name field prior to reconciling them against the asset.tag field.

Table Name Field Name Sequence

joincomputer ci.name 1

joincomputer asset.tag 2

Sample reconciliation rules ordered by sequence

A Discovery Event Manager (DEM) reconciliation rule allows you to specify which ServiceManager
fields you want to use to determine if an existing CI recordmatches a CI in a UCMDB system. An
administrator typically specifies reconciliation rules prior to starting UCMDB data push jobs so that
ServiceManager will not create duplicate CI records.

To create a DEM reconciliation rule:

Universal Discovery Content Guide - ServiceManager Integration
Tailoring the Integration

Page 129 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring > Web Services > DEM Reconciliation Rules. ServiceManager
displays the DEMReconcile Record form.

3. In Table Name, type the name of the ServiceManager table containing the field you want to
reconcile on.

4. In Field Name, type the name of the ServiceManager field containing the values you want to
reconcile on.

5. In Sequence, type a number to specify what order you want ServiceManager to run this rule.

Note: If you do not specify a sequence value, ServiceManager will process field names
alphabetically.

6. Click New. ServiceManager creates the reconciliation rule.

Using join tables for reconciliation
When setting reconciliation rules, if the device type you are reconciling has a joindef definition (as
defined in the devtype table), use the join table name instead of the device table. For example, if
you want to reconcile computer CIs, use the joincomputer table instead of the device table.

Sequence of reconciliation
A reconciliation rule specifies what ServiceManager table and field you want to search for matching
CI values. It also specifies the sequence in which you want ServiceManager to process
reconciliation rules. By default, ServiceManager processes rules in alphabetical order by field
name. For example, ServiceManager will reconcile CIs against the asset.tag field before
reconciling CIs on the ci.name field.

To change the order in which ServiceManager reconciles CIs, you can add a numeric value to the
sequence field. For example, the following reconciliation rules ensure that ServiceManager
processes CIs by the ci.name field prior to reconciling them against the asset.tag field.

Table Name Field Name Sequence

joincomputer ci.name 1

joincomputer asset.tag 2

Sample reconciliation rules ordered by sequence

A Discovery Event Manager (DEM) reconciliation rule allows you to specify which ServiceManager
fields you want to use to determine if an existing CI recordmatches a CI in a UCMDB system. An
administrator typically specifies reconciliation rules prior to starting UCMDB data push jobs so that
ServiceManager will not create duplicate CI records.

To create a DEM reconciliation rule:
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1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring > Web Services > DEM Reconciliation Rules. ServiceManager
displays the DEMReconcile Record form.

3. In Table Name, type the name of the ServiceManager table containing the field you want to
reconcile on.

4. In Field Name, type the name of the ServiceManager field containing the values you want to
reconcile on.

5. In Sequence, type a number to specify what order you want ServiceManager to run this rule.

Note: If you do not specify a sequence value, ServiceManager will process field names
alphabetically.

6. Click New. ServiceManager creates the reconciliation rule.

Add Discovery Event Manager Rules
ServiceManager uses the Discovery Event Manager (DEM) to define which actions the system
should perform when the actual state of an incoming configuration item (CI) record differs from the
managed state of a CI record in HP ServiceManager. The DEM rules allow you to define whether
the ServiceManager system adds, updates, or deletes CI records based on incoming UCMDB
data.

For CI records only, the DEM rules also allow you to define how ServiceManager should handle
duplicated logical names.

This section includes:

l "DEM Rules" below

l "Duplication Rules" on page 134

l "CI Attributes Displayed in Change and Incident Records" on page 135

l "Searching for Change and Incident Records Opened by the Integration" on page 135

DEM Rules
ServiceManager offers the following rules options:

Action if matching record does not exist

This is the action you want ServiceManager to take if it cannot find amatching CI record.
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l Add the record:(Default) ServiceManager will add a CI record when it cannot find amatching
record. See "How to Add DEMReconciliation Rules" on page 128 to define what fields Service
Manager uses tomatch CI records.

l Add the record, and set dependency as true: This option is available only for synchronization
of CI relationship data. ServiceManager adds the CI relationship record and enables outage
dependency for the record by doing the following:
n Checks the Outage Dependency check box;

n Sets the number of dependent downstream CIs to 1. This is because UCMDB only supports
one-to-one CI relationships.

l Open an Incident:ServiceManager opens an incident for someone to review the new CI record.
The incident enables someone to investigate whether the new CI record is compliant with your
business practices.

l Open a Change:ServiceManager opens an unplanned change for someone to review the new
CI record. The change allows you to investigate whether the new CI record is compliant with
your business practices. If the CI record is compliant, the change can be approved. If the CI
record is not compliant, then the change can be denied and the CI record removed. The change
record lists both the current and proposed attribute values.

Action if record exists but unexpected data discovered

This is the action you want ServiceManager to perform if it does not find amatching CI attribute
value.
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l Open a Change: (Default) ServiceManager opens an unplanned change to review the actual
state of the CI record. The change allows someone to investigate whether the new attribute
value is compliant with your business practices. If the value is compliant, the change can be
approved. If the value is not compliant, then the change can be denied and the CI attribute value
reverted to its managed state.

l Log Results and update record:ServiceManager logs the results of the actual state of the CI
record, and then updates the CI record.

l Open an Incident:ServiceManager opens an Incident to investigate the actual state of a CI
record and determines what actions must be performed or initiated to bring the record into
compliance with ServiceManager.

Action if record is to be deleted

This is the action you want ServiceManager to perform if an external event specifies that the record
needs to be deleted.

l Delete record: (Default for CI Relationship records) This option is available for synchronization
of both CI and CI Relationship records. ServiceManager automatically deletes the CI/CI
Relationship record.

l Open an Incident: This option is available only for synchronization of CI Relationship records.
ServiceManager opens an incident to investigate the deleted record and determines which
actions must be performed or initiated to bring the record into compliance with ServiceManager.

l Open a Change: This option is available only for synchronization of CI Relationship records.
ServiceManager opens an unplanned change to review the deleted record. The change allows
someone to investigate whether the deleted record is compliant with your business practices. If
the record is compliant, the change can be approved. If the record is not compliant, then the
change can be denied and the record added back to the system.

l Update record to the selected status: (Default for CI records) This option is available only for
synchronization of CI records. ServiceManager updates the status of the CI record to a value
selected from the drop-down list (for example, Retired/Consumed), rather than delete the
record permanently.

Note: Values available from the drop-down list are defined in the ICM Status global list.

l Open a Change to update record to the selected status: This option is available only for
synchronization of CI records. ServiceManager opens an unplanned change to update the CI
record’s status to a value selected from the drop-down list (for example, Retired/Consumed).
The change allows someone to investigate whether the requested status change is compliant
with your business practices. Once the change has been approved and closed, ServiceManager
automatically changes the CI record to the selected status. If the change has been denied,
ServiceManager makes no changes to the CI record.
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l Open an Incident to update record to the selected status: This option is available only for
synchronization of CI records. ServiceManager opens an incident to update the record’s status
to a value selected from the drop-down list (for example, Retired/Consumed). Once the
incident has been closed, ServiceManager automatically updates the CI record to the selected
status.

Duplication Rules
UCMDB may create two completely separate yet legit CI records that happen to have the same
“name”. The UCMDB name field is mapped to the logical.name field (whichmust be unique) in
ServiceManager. Pushing the two CI records to ServiceManager would cause a duplicate logical
name problem. You have several ways to avoid this problem. See the following table.

Product
side Solution

UCMDB Change the names directly in UCMDB or change the UCMDB reconciliation rule to
make sure the names are not the same.

This is highly recommended.

In the integration adapter mapping configuration (xslt) file, avoid mapping the UCMDB
name field to the SM logical name field directly in either of these ways:

l Map another UCMDB unique attribute to the SM logical.name field, andmap the
UCMDB name field to another SM field;

l Add a prefix to the name. The following are examples.
n UCMDB switches or routers are simply named as “Router” or “Switch” and

identified by their underlyingMACs. You can configure their “SM logical name”
to be “<MAC> + <name>”.

n UCMDB databases often have the same name (due to the implementation of
clusters andOracle RACs). You can configure their “SM logic name” to be “<full
DNS name> + <name>”.

Service
Manager

Use the duplication rule options in DEM Rules in ServiceManager.

Solutions to the duplicate logical name problem

ServiceManager offers the following duplication rule options on the Duplication Rule tab in each
DEM rule with a Table Name other than “cirelationship”:

l Action if logical name is duplicated (CI with different uCMDB ID): This is the action you
want ServiceManager to perform if the logical name is already used by another CI record when a
CI record is added or updated.
n Rename to <name>_[RENAMED]_1/2/3: (Default) ServiceManager changes the logical

name by adding a suffix.

n Return Error: ServiceManager returns a duplicate key error to UCMDB.
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CI Attributes Displayed in Change and Incident Records
ServiceManager displays a Change Details section on the corresponding change or a CMDB
Changes section on the corresponding incident when you configure DEM to open either change
records or incident records when it discovers CI attribute changes through the UCMDB-SM
integration. ServiceManager only displays a tab for CI attributes when the UCMDB-SM integration
is enabled and you have defined a rule in the Discovery Event Manager to create a change or
incident record when a CI is added, updated, or deleted.

Both the Change Details and CMDB Changes sections display the current CI attribute values
alongside the actual attribute values discovered by UCMDB. You can use this information to
approve or deny a change or escalate an incident to the proper assignment group.

Searching for Change and Incident Records Opened by
the Integration

You can use the following search criteria to find change and incident records opened by the
UCMDB-SM integration.

Record type Search option available

Change Search for records with the category unplanned change.

Incident Search for records using the generated by the UCMDB integration option.

Search options available for change and incident records

How to Add a CI Attribute to the Integration for Data
Push

You can use the following steps to add a CI attribute to the integration.

1. Does the CI attribute already exist in the UCMDB class model?
Yes. Go to Step 3.

No. Go to Step 2.

2. Add the CI attribute to the UCMDB class model.
See "How to Add the CI Attribute to the UCMDB Class Model" on the next page.

3. Add the CI attribute to the TQL layout.
See "How to Add the CI Attribute to the TQL Layout" on page 137.

4. Add the CI attribute to the ServiceManager table.
See "How to Add the CI Attribute to the ServiceManager Table" on page 139.
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5. Create a web service field to support the CI attribute.
See "How to Create aWeb Service Field to Support the CI Attribute" on page 140.

6. Add amanaged field to monitor changes in the CI attribute.
See "How to Add aManaged Field to Support the CI Attribute" on page 142.

7. Map the CI attribute to a web service field.
See "How toMap the CI Attribute to aWeb Service Field" on page 144.

How to Add the CI Attribute to the UCMDB Class Model
The integration only uses a subset of the CI attributes available from your UCMDB system. Out-of-
the-box, the integration consists of CI attributes that are typically managed from a ServiceManager
system such as host name and host DNS name. Before creating a new UCMDB CI attribute, you
should determine if there are any existing CI attributes in your UCMDB system that provide the
data you want. In most cases, there is an existing attribute tracking the data you want to add to the
integration. For example, if you review the attributes of the Node CI type, you see that there are
many attributes available to be added to the integration.

The following steps illustrate how to add a new CI attribute to an existing CI type. This scenario is
not the expected typical case. Typically, you would add an existing CI attribute to the integration.

Note: The integration does not require any special steps to add a CI attribute to the UCMDB
class model. You can use the standard CI attribute creation procedures to add a CI attribute.
For more information on CI attribute creation, see theHP Universal CMDB CI Attribute
Customization Guide.

To add a CI attribute to the UCMDB class model:
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1. Log in to UCMDB as an administrator.

2. Navigate toModeling > CI Type Manager.

3. Select the CI type to which you want to add a new CI attribute from the CI Types navigation
tree. For example, ConfigurationItem > InfrastructureElement > RunningSoftware >
Database.

4. Click theAttributes tab.

5. Click theAdd button.
The Add Attribute window opens.

6. In Attribute Name, type the unique name you want to use for the new CI attribute. For example,
database_owner.

Caution: The name cannot include any of the following characters: ‘ / \ [ ] : | <

> + = ; , ? *.

7. In Display Name, type the name you want UCMDB to display in the interface. For example,
Database Owner.

8. In Description, type a description of the new CI attribute. This is an optional field. For example,
System user who owns the database.

9. In Attribute Type, select either Primitive or Enumeration/List. For example, select Primitive
and select string.

10. In Value Size, type themaximum character length the attribute can have. For example, 300.

11. In Default Value, type the value to be used when no other value is available. For example,
leave the default value blank.

12. Click OK to save the attribute.

13. Click theSave button to save attribute changes to the CI type.

How to Add the CI Attribute to the TQL Layout
To add a CI attribute to the integration, youmust add this attribute to the layout setting from the TQL
query that synchronizes the CI type. Youmust know what CI type contains the CI attributes you
want to add to the integration.

Keep a list of the attributes that you enable, because you will need to create amatching XSL
transformation for each attribute you enable.

To add a CI attribute to the TQL layout:
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1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. For Resource Type, select Queries.

4. From theQueries navigation tree, click Integration > SM Sync > 9.xx.

5. Select the query that manages the CI type whose attributes you want to add to the integration.
For example, SM Computer Push. UCMDB displays the TQL for the integration query.

6. Select the node from the TQL layout that contains the CI attribute you want to add to the
integration. For example, Root.

7. Right-click the node and select Query Node Properties. TheQuery Node Properties window
opens.

8. Click Element layout tab. The Layout Settings tab opens.

9. Select the CI attribute you want to include in the integration from theAvailable Attributes list,
and click theAdd button to add it toSpecific Attributes list. For example, OsVendor.
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10. Click OK to save the node properties.

11. Click theSave button to save the TQL query.

How to Add the CI Attribute to the Service Manager Table
The integration uses only a subset of the CI attributes available from your ServiceManager system.
Before creating a new ServiceManager CI attribute, you should determine if there are any existing
CI attributes in your ServiceManager system that provide the data you want. In most cases, there
is an existing attribute tracking the data you want to add to the integration. For example, if you
review the attributes of the Computer CI type, you see that there aremany attributes available to be
added to the integration.

The following steps illustrate how to add a new CI attribute to an existing CI type.

The integration does not require any special steps to add a CI attribute to the ServiceManager
table. You can use the standard table attribute creation procedures to add a CI attribute. For more
information on table attribute creation, see the ServiceManager help andServiceManager Tailoring
Best Practices Guide.
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To add a CI attribute to the ServiceManager table:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring > Database Dictionary.

3. In File Name, type the name of the table where you want to add the new CI attribute. For
example, node.

4. Click theSearch button .
The node dbdict record opens.

5. Click the Fields tab.

6. Click theNew Field/Key button.
The Add Attribute window opens.

7. In Name, type the name you want to use for the new CI attribute. For example,
os.manufacturer.

Caution: The name cannot include any of the following characters: ' / \ [ ] : | <

> + = ; , ? *.

8. In Type, select a type from the list. For example, select character.

9. Click theAdd Field button to save the attribute.

10. Click theOK button to save attribute changes to the table.

How to Create a Web Service Field to Support the CI
Attribute

UCMDB uses the ServiceManager ucmdbIntegration web service to send CI data. This web
service publishes the objects that match the out-of-the-box CI types and CI attributes provided by
the UCMDB-SM integration. For a list of the out-of-the-box web service fields and their mappings to
ServiceManager tables, see "Managed Fields" on page 115.

If you add a CI attribute to the integration on your UCMDB system, youmust create a
corresponding web service field on your ServiceManager system to receive the incoming CI data
from UCMDB. Each web service field must map to a valid ServiceManager table and column.

To create a web service field for the OSVendor attribute described in previous sections:

1. Log in to ServiceManager with an administrator account.

2. Navigate to Tailoring >Web Services >WSDL Configuration. The External Access
Definition form opens.

3. For Service Name, type ucmdbIntegration.
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4. Click Search. ServiceManager displays a record list of the objects that make up the
ucmdbIntegration web service.

5. Select an existing web service object to which you want to add the CI attribute. For example,
select ucmdbNode.

6. Click the Fields tab. ServiceManager displays the fields published as web service fields.

7. Select an empty row in the Fields list.

8. For Field, select the ServiceManager column namewhere you want to store the incoming CI
attribute values. For example, os.manufacturer.

Note: ServiceManager displays the fields from all join tables associated with the table
listed in the Name field. For example, for joinnode ServiceManager displays the fields
from the device and node tables.

9. For Caption, type the name you want ServiceManager to use when publishing the field as a
web service field. For example, OSVendor.

Caution: The Caption namemust match the object name you listed in the XSL
transformation file in Universal CMDB, or ServiceManager will not receive any CI updates
from your Universal CMDB system.

10. Click Save.
The new web service field is available immediately; you do not need to restart the Service
Manager system.
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How to Add a Managed Field to Support the CI Attribute
In order for a CI attribute you add to the integration to trigger the automated ChangeManagement
validation and verification processes, youmust add amanaged field for the CI attribute. Service
Manager managed fields are part of the Discovery Event Manager Rules. For a list of fields that
trigger ChangeManagement validation and verification, see "ServiceManager Discovery Event
Manager Rules" on page 121.

To add amanaged field to the integration:

1. Log in to ServiceManager with an administrator account.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules. Service
Manager displays a record search/creation form.

3. Click Search to display a list of all Discovery Event Manager rules.

4. Select the rule ID that matches the web services object where you mapped the
incoming CI attribute. For example, ucmdbNode. See "How to Create aWeb Service Field
to Support the CI Attribute" on page 140.
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ServiceManager displays the rules for this web service object.

5. Click theManaged Fields tab. ServiceManager displays the list of fields that trigger Change
Management validation and verification.

6. Select an empty row in theManaged Fields list.

7. For Field Name, select the caption name of the ServiceManager column that you previously
selected to store the incoming CI attribute values. For example, Os Manufacturer.

Note: ServiceManager displays the fields from all join tables associated with the table
listed in the Table Name field. For example, joinnode displays fields from the device and
computer tables.

Tip: If you want to add all fields that are exposed in theWSDL definition, you can click the
Load Fields button. For more information, see "How do I Use the Load Fields Button to
AddMultiple Managed Fields" on page 104.

8. If the field you use to store the incoming CI attribute is an array of structure, use the Structure
field to select the name of the array of structure where the column can be found. For example,
Os Manufacturer is a primitive character field and therefore does not need to identify an array
of structure name.

9. If the field you use to store the incoming CI attribute is an array of structure, use the Index field
to select the index number that identifies the column in the array of structure. For example, Os
Manufacturer is a primitive character field and therefore does not need to identify an array of
structure index.

10. Click Save.
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How to Map the CI Attribute to a Web Service Field
The integration uses an adapter to transform UCMDB CI attributes to web services objects
recognized by ServiceManager. The adapter in turn specifies what XSL transformation files the
integration should use to convert UCMDB TQL queries into properly formatted ServiceManager
web services messages.

Out-of-the-box, each integration query has a corresponding XSL transformation file that maps to a
particular CI type in UCMDB. In addition, each attribute for which you enabled calculation requires
its own entry in the XSL transformation file. Without an XSL transformation entry, ServiceManager
cannot receive any CI attribute updates from your UCMDB system.

If you want to add a new attribute to the integration, youmust edit the XSL transformation file for the
parent CI type and add an entry for the CI attribute. For information about which CI types each
query manages, see "TQLQueries for Push" on page 111. In order to create a proper XSLmapping,
youmust be familiar with the service and object names ServiceManager publishes as web
services. For information on publishing tables and columns as web service objects, see theService
ManagerWeb Services Guide available from the ServiceManager help.
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The following steps illustrate how tomap a UCMDB CI attribute called host_vendor to a Service
Manager web service object called OSVendor.

To map a CI attribute to a web service field:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Double-click the XSL transformation file that manages the parent CI type of your CI attribute.
For example, open computer_push.xslt to add an attribute to theSM Computer Push TQL
query.

4. Find the element that defines the ServiceManager table namewhere the integration will store
CI attribute values. For example, the element <file.device>will store CI attributes in the
ServiceManager device table.

5. Within the table naming element (<file.device>), you will see an element of the following format
that defines how to transform each UCMDB CI attribute into a web service object:

<xsl:for-each select="@CI_attribute_name">

<SMAttributeName><xsl:value-of select="."/></SMAttributeName>

</xsl:for-each>

@CI_attribute_name is the name of attribute in the UCMDB system.

SMAttributeName is the name of a web service attribute published by the ServiceManager
system.

Caution: The web service attribute name is case-sensitive.

CI attributes in the computer_push.xslt XSL transformation file are illustrated in the following
screenshot:
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CI attributes in the sm_node_attributes.xslt XSL transformation file are illustrated in the
following screenshot:
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Matching CI attributes in the ucmdbNodeweb service are illustrated in the following screenshot:
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6. Copy an existing XSL transformation element to use it as a template to create a new
transformation entry.

7. Paste the new XSL transformation element within the proper table naming element. For
example, <file.node>.

8. Update the CI attribute name and web service object namewithin the new element to match
the attribute you want to add to the integration. For example, create the following XSL
transformation element to add an attribute to the integration.

<xsl:for-each select="@os_vendor">

<OSVendor><xsl:value-of select="."/></OSVendor>

</xsl:for-each>

New attribute in the computer_push.xslt XSL transformation file is illustrated in the following
screenshot:
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9. Save the XSL transformation file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a CI Type to the Integration for Data
Push

You can use the following steps to add a CI type to the integration.

1. Does the CI type already exist in the UCMDB class model?
Yes. Go to Step 3.

No. Go to Step 2.
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2. Add the CI type to the UCMDB class model.
See "How to Add the CI Type to the UCMDB Class Model" below.

3. Add CI attributes to the CI type as needed.
See "How to Add a CI Attribute to the Integration for Data Push" on page 135.

4. Create a TQL query to synchronize the CI type.
See "How to Create a TQLQuery to Synchronize the CI Type" on page 153.

5. Add the CI type’s attributes to the TQL layout.
See "How to Add the CI Type’s Attributes to the TQL Layout" on page 156.

6. Add the CI type to ServiceManagerServiceManager.
See "How to Add the CI Type in ServiceManager" on page 158.

7. Create web service fields to support the CI type.
See "How to CreateWeb Service Fields to Support the CI Type" on page 161.

8. Addmanaged fields to support the CI type.
See "How to AddManaged Fields to Support the CI Type" on page 163.

9. Map the CI type’s TQL query to an XSL transformation file.
See "How toMap the CI Type’s TQLQuery to an XSL Transformation File" on page 165.

10. Map the CI type’s attributes to web service fields.
See "How toMap the CI Type’s Attributes toWeb Service Fields" on page 167.

11. Add custom TQL queries to integration data push jobs.
See "How to Add Custom TQLQueries to Data Push Jobs" on page 178.

How to Add the CI Type to the UCMDB Class Model
Before creating a new UCMDB CI type, you should determine if there are any existing CI types in
your UCMDB system that provide the CI attributes you want. In most cases, you can create links
to one or more existing CI types to create a new logical CI type for use by the integration.

The following steps illustrate how to create a new CI type called SM RDBMS based on an existing
CI type called database.

Note: The integration does not require any special steps to add a CI type to the UCMDB class
model. You can use the standard CI type creation procedures to add a CI type. For more
information on CI type creation, see theHP Universal CMDB CI Attribute Customization
Guide.

To add a CI type to the UCMDB class model:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling > CI Type Manager.
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3. Select the base CI type you want to use for your new CI type from the CI Types navigation
tree:Managed Object > ConfigurationItem > Infrastructure Element > Running Software
> Database.

4. Click theNew button .
The Create Configuration Item Type window opens.

5. In Name, type the unique name you want to use for the new CI type. For example, sm_rdbms.

Caution: The name cannot include any of the following characters: ‘ / \ [ ] : | <

> + = ; , ? *.

6. In Display Name, type the name you want UCMDB to display in the interface. For example, SM
RDBMS.

7. In Description, type a description of the new CI type. This is an optional field. For example,
Hosts running relational databases.

8. In Base CI Type, verify that the proper base CI type is selected. Your new CI type will inherit
the attributes of the base CI type you select here. For example, Database.

9. Click Next. The wizard displays a list of CI attributes from the base CI type.

10. Add, edit, or remove CI attributes as needed for the new CI type. For example, accept the
default attributes inherited from Database.

11. Click Next. The wizard displays a list of qualifiers from the base CI type.

12. Add or remove qualifiers as needed for the new CI type. For example, accept the default
qualifiers.

13. Click Next. The wizard displays a list of icons associated with the CI type.

14. Select the icons associated with this CI type. For example, accept the default abstract class
icon.

15. Click Next to add any menu item properties or label definitions as needed. For example, accept
the default settings from the base CI type.
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16. Click Finish to create the CI type.

17. Select your new CI type from the tree. For example, SM RDBMS.

18. Browse to an existing CI type you want to link to, and control-click it to add it to your selection.
For example, Node.

Note: Choose an existing CI type that has the attributes that you want to be part of your
new logical CI type.

19. Right-click one of the selected CI types, and click Add/Remove Relationship. The
Relationships window opens.

20. Create an SM Link relationship from the existing CI type to the new CI type. For example, from
Node toSM RDBMS.

Note: You need to create a new SM Link relationship if it does not exist.
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21. Click OK to create the relationship.

22. Click theSave button to save the CI type.

How to Create a TQL Query to Synchronize the CI Type
The integration uses Topology Query Language (TQL) queries to gather CI attribute values and
pass them to your ServiceManager system. Youmust create a TQL query for any CI type you add
to the integration. Any TQL query you createmust conform to the "TQLQuery Requirements" on
page 114.

The following steps illustrate how to create a new TQL query called rdbmsData for the SM RDBMS
CI type described in previous sections.

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. From theQueries navigation tree, click Integration > SM Sync.

4. Right-click SM Sync, and select theNew > Query.
TheQuery Definition window opens.

5. Find the CI type that will be the root node of your query from the CI Type Selector. This CI type
is typically the one that provides themost attributes for the CI. For example, Managed Object
> ConfigurationItem > InfrastructureElement > RunningSoftware > Database > SM
RDBMS.
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6. Drag the root CI type from the CI Type Selector and drop it into the empty Editing pane.
UCMDB displays the icon of the CI type.

7. Select the CI type, and click Edit from the Information Pane. The Node properties window
opens.

8. Change the Element name toRoot.

9. Click OK to save the node properties.
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10. Find any additional CI types you want to add to the query from the CI Type Selector. These CI
types typically provide additional CI attributes. For example,Managed Object >
ConfigurationItem > Infrastructure Element > Node.

11. Drag the additional CI type from the CI Type Selector and drop it into the empty Editing pane.
UCMDB displays the icon of the additional CI type.

12. Create relationships between the Root CI type and the additional CI types as needed. For
example, create an SM Link betweenRoot andNode.
a. Select Root and control-click the additional CI type. For example, Node.

b. Right-click one of the selected items, and click Add Relationship. The Add Relationship
window opens.

c. Select SM Link.

d. Type a Relationship Name. For example SM Link.

e. Click OK to add the relationship.

13. Repeat step 10 to step 12 for each additional CI type you want to add to the TQL. For example,
SM RDBMS does not need any additional CI types.
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14. Click theSave button to save the TQL query.

15. In Query Name, type the unique name you want to use for the new query. For example,
rdbmsData.

16. In Description, type a description of the new query. This is an optional field. For example,
Query for hosts running relational databases.

17. In the folder tree, select the folder in which you want to save the TQL. For example, Root >
Integration > SM Sync.

18. Click OK. UCMDB adds your new query to the Queries list.

How to Add the CI Type’s Attributes to the TQL Layout
To add a CI attribute to the integration, youmust enable the calculation layout setting from the TQL
query that synchronizes the CI type. Because youmust enable calculation for each attribute you
want to add to the integration, you should be familiar with the integration CI types and the CI
attributes they contain.

Tip: Keep a list of the attributes you enable, because you will need to create amatching XSL
transformation for each one.

The following steps illustrate how to enable calculation for attributes of the SM RDBMS CI type
described in previous sections.

To add a CI type’s attributes to the TQL layout:
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1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. From theQueries navigation tree, click Integration > SM Sync.

4. Select the query that manages the CI type whose attributes you want to add to the integration.
For example, rdbmsData. UCMDB displays the TQL for the integration query.

5. Select theRoot node from the TQL layout, and then click theEdit button from the Information
Pane. The Node properties window opens.

Caution: Your integration query must contain a node called Root. See "TQLQuery
Requirements" on page 114 for more information.

6. Click theElement Layout tab, and select the optionSelect attributes for layout.

7. Select Specific Attributes from theAttributes condition list, and from the Available
Attributes list select each CI attribute you want to add to the Specific Attributes list. For
example, select the Product Name, Application Version Description, Vendor, Version,
Description, The Database Instance Name, and Port attributes.
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8. Click OK to save the query node properties.

9. Select any additional nodes that contain CI attributes you want to add to the integration. For
example, Node.

10. Click theEdit button from the Information Pane. The Node properties window opens.

11. Click Element Layout tab, and select the optionSelect attributes for layout.

12. Select Specific Attributes in Attributes condition, and from the Available Attributes list select
each CI attribute you want to add to the Specific Attributes list. For example, select attributes
for the OS Vendor, and name attributes.

13. Click OK to save the query node properties.

14. Repeat step 9 to step 13 for each additional node that contains CI attributes that you want to
add to the integration.

15. Click theSave button to save the TQL query .

How to Add the CI Type in Service Manager
Before creating a new ServiceManager CI type, you should determine if there are any existing CI
types in your ServiceManager system that provide the CI attributes you want. In most cases, you
can reuse the existing CI types for the integration.

The integration does not require any special steps to add a CI type to ServiceManager. You can
use the standard CI type creation procedures to add a CI type. For more information on CI type
creation, see the HP ServiceManager online help.

To add a new CI type in ServiceManager:

1. Create a table for storing the specific attributes of this new CI type.

2. Create a join definition to join the device table.

3. Create an erddef definition that defines a relationship between the two tables.

4. Create a view form and a bulk update form for the new CI type.

5. Add the CI type.

The following steps illustrate how to create a new CI type calledRDBMS.

Note: This example is provided only as an illustration of the steps. The best practice is to
reuse the existing ServiceManager CI typeRunningSoftware to map with UCMDB CI type
SM RDBMS.

To create a table in ServiceManager:
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1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring > Database Dictionary.

3. In File Name, type the table name you want to add. For example, rdbms.

4. Click theNew button .

5. Click the Fields tab.

6. Click theNew Field/Key button. The Add Field window opens.

7. In Name, type a field name you want to add. For example, logical.name, which is
mandatory for joining the device table.

Caution: The name cannot include any of the following characters: ' / \ [ ] : | <

> + = ; , ? *.

8. In Type, select a type from the list. For example, select character.

9. Click theAdd Field button to save the attribute.

10. Repeat step 7 to step 9 for each attribute you wish to add. For example, dbinstance and
port.

11. Click theKeys tab.

12. Place the cursor on the first line of the structure, and click theNew Field/Key button. The Add
Key window opens.

13. In Type, select unique from the list.

14. In Fields list, type the name of a field that you want to use as the unique key. For example,
logical.name.

15. Click Add Key button to save the key.

16. Click theOKbutton to save attribute changes to the table.

To create a join definition in ServiceManager:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring > Database Manager.

3. In Table, type the table name joindefs.

Universal Discovery Content Guide - ServiceManager Integration
Tailoring the Integration

Page 159 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



4. Click theSearch button .

5. In Join Table Name, type a name for the join definition. For example, joinRDBMS.

6. In File Names, select the names of the tables to join. For example, device and rdbms.

7. Click Add to save the join definition.

To create an ERD definition in ServiceManager:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring > Database Manager.

3. In Table, type the table name erddef.

4. Click theSearch button .

5. In First Filename, type the name of the first table of the join definition. For example, device.

6. In Second Filename, type the name of the second table of the join definition. For example,
rdbms.

7. In Relationship type, select a value from the list. For example, One to One.

8. In Field Names from First Filename, add the unique field name of first table. For example,
logical.name.

9. In Field Names from Second Filename, add the unique field name of the second table. For
example, logical.name.

10. Click theAdd button to save the ERD definition.

To create forms for view and bulk update in ServiceManager:

Create a view form named configurationItemRDBMS, and a bulk update form named
device.rdbms.bulkupdate.

You can create them in Forms Designer based on existing view forms and bulk update forms. To
view the form names of an existing CI type in ServiceManager, click Configuration Management
> Resources > Device Types > Search, and then open the CI type record.

To access Forms Designer in ServiceManager, type fd in the command line or go to Tailoring >
Forms Designer.

For more information about creating forms in ServiceManager, see the ServiceManager 9.31 online
help and the Tailoring Best Practices Guide.

To add a CI type to ServiceManager:
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1. Log in to ServiceManager as a system administrator.

2. Navigate toConfiguration Management > Administration > Add New Device Type, and
click Next.

3. In Device Type Name, type a descriptive name for the new CI type. For example, RDBMS.

4. In Device Type, type a name for the new CI type. For example, rdbms.

5. Click Next.

6. In View Form, type the name of the view form you created for the new CI type. For example,
configurationItemRDBMS.

7. In Bulk Update Form, type the name of the bulk update form you created for the new CI type.
For example, device.rdbms.bulkupdate.

8. Click Next.

9. In Attribute File, select the table you created for the CI type. For example, rdbms.

10. Click Next.

11. Click Next to keep the default setting for Fields Specific to the Attribute File.

12. In Join Def Record, select the join definition you created for this CI type. For example,
joinRDBMS.

13. Click Next.

14. In Subtypes, add necessary subtypes for the CI type. For example, Oracle and SQL
Server.

15. Click Next.

16. Check theActivate Device Type check box.

17. Click Next to save the new CI type.

How to Create Web Service Fields to Support the CI Type
In order to add a CI type to the integration, youmust create a ServiceManager web service object
for each CI attribute for which you created an XSL transformation on the UCMDB system. Service
Manager uses the web service object to determine which ServiceManager table and column to
store the incoming CI attribute values.

The following steps illustrate how to create a web service object necessary to support the SM
RDBMS CI type described in previous sections.
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Note: This example of creating a new web service object (ucmdbRDBMS) is provided only as
an illustration of the steps. The best practice is to reuse the existing ServiceManager web
service object ucmdbRunningSoftware to map with Universal CMDB CI type SM RDBMS.

To create web service fields to support your new CI type:

1. Log in to ServiceManager with an administrator account.

2. Navigate to Tailoring >Web Services >WSDL Configuration.

3. In Service Name, type ucmdbIntegration.

4. In Name, select the name of the join file you have created for the new CI type. For example,
joinRDBMS.

5. In Object Name, type a name. For example, ucmdbRDBMS.

6. Click theAllowed Actions tab, and specify the actions as shown in the following figure.

Caution: For UCMDB integrationWSDL configurations, be sure to use the “Create only”
action type for the “add” and “save” actions, and “Application Pass Through” for the “delete”
action. For more information about the action types, see theServiceManager 9.31Web
Services Guide.

7. Click Add to create theWSDL configuration.

8. Click the Fields tab, select fields from the list and type a caption for each of them, as shown in
the following figure.
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9. Click Save to saveWSDL configuration changes.
The new web service fields are now available to the integration.

How to Add Managed Fields to Support the CI Type
In order for your custom CI type to trigger the automated ChangeManagement validation and
verification processes, youmust add amanaged field for each CI attribute within your CI type.
ServiceManager managed fields are part of the Discovery Event Manager Rules. For a list of fields
that trigger ChangeManagement validation and verification, see "ServiceManager Discovery
Event Manager Rules" on page 121.

The following steps illustrate how to add themanaged fields for the SM RDBMS CI type described
in the previous sections.

To addmanaged field to support your CI type:

1. Log in to ServiceManager as a system administrator.

2. Navigate to Tailoring >Web Services > Discovered Event Manager Rules.

3. In ID, type the ID you want to create for the new Discovered Event Manager Rule. For
example, ucmdbRDBMS.

4. In Table Name, select the table or join definition you want to associate to the new Discovered
Event Manager Rule. For example, joinRDBMS.
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5. Click New.

6. Click Next.

7. Click theManaged Fields tab.

Note: The list of fields you will add here will trigger ChangeManagement validation and
verification.

8. Select an empty row in theManaged Fields list.

9. For Field Name, select the caption names of the ServiceManager fields that you previously
selected to store the incoming CI attribute values. See "How to CreateWeb Service Fields to
Support the CI Type" on page 161.

Note: ServiceManager displays the fields from all join tables associated with the table
specified in the Table Name field. For example, for the joinRDBMS table, the fields from
the device and rdbms tables are available from the Field Name list.

Tip: If you want to add all fields that are exposed in theWSDL definition, you can click the
Load Fields button. For more information, see "How do I Use the Load Fields Button to
AddMultiple Managed Fields" on page 104.

10. If the field you use to store the incoming CI attribute is an array of structure, use the Structure
field to select the name of the array of structure where the column can be found. For example,
Vendor is a primitive character field and therefore does not need to identify an array of structure
name.

11. If the field you use to store the incoming CI attribute is an array of structure, use the Index field
to select the index number that identifies the column in the array of structure. For example,
Vendor is a primitive character field and therefore does not need to identify an array of structure
index.
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12. Click Save.

How to Map the CI Type’s TQL Query to an XSL
Transformation File

The integration uses a configuration file called smSyncConfFile.xml to map each Universal CMDB
TQL query to an XSL transformation file. In order for custom TQL queries to be part of the
integration, youmust add amapping entry for each TQL query in the configuration file.

The following steps illustrate mapping the TQL query rdbmsData described in previous sections to
the ServiceManagerucmdbRDBMS web service.

Tip: Wildcard support for TQL names in smSyncConfFile.xml

When adding a TQL name in the smSyncConfFile.xml file, you can use a wildcard (an
asterisk) in the TQL name. This is helpful in the debugging phase when youmay have updated
an out-of-the-box TQL query and saved it as several TQL names. For example, if you have
saved the <TQL_name> query to <TQL_name>_1, and <TQL_name>_2, you can specify the
TQL name as <TQL_name>* in the configuration file, and the integration will automatically use
this mapping entry on all of the three TQLs.

Note: Out-of-the-box, all TQL names in the smSyncConfFile.xml file are suffixed with a
wildcard (an asterisk).

Tomap a TQL query to an XSL transformation file:
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1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Click the smSyncConfFile.xml file.

4. Add a TQLmapping element to the file by copying an existing one. A TQLmapping element
uses the following format:

<tql name="TQL_query" xslFile="XSL_File">

<!-- Description of mapping -->

<request type="Create" name="Create_web_service"/>

<request type="Update" name="Update_web_service"/>

<request type="Delete" name="Delete_web_service"/>

</tql>

TQL_query is the name of the UCMDB TQL query you created.

XSL_File is the name of the XSL transformation file the integration will use tomapUniversal
CMDB attributes to ServiceManager web service fields.

Create_web_service is the name of the ServiceManager web service you want to the
integration to use to create CIs from this TQL query.

Update_web_service is the name of the ServiceManager web service you want to the
integration to use to update CIs in this TQL query.

Delete_web_service is the name of the ServiceManager web service you want to the
integration to use to delete CIs from this TQL query.

See the following screenshot for an excerpt of smSynchConfFile.xml:
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5. Add or update TQLmapping elements for each TQL query you want to add to the integration.
For example, the following TQL creates amapping between the rdbmsData TQL query and the
rdbms_push.xslt file.

<tql name="rdbmsData" xslFile="rdbms_push.xslt">

<!-- this is database tql -->

<request type="Create" name="CreateucmdbRDBMSRequest"/>

<request type="Update" name="UpdateucmdbRDBMSRequest"/>

<request type="Delete" name="DeleteucmdbRDBMSRequest"/>

</tql>

6. Save the configuration file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Map the CI Type’s Attributes to Web Service
Fields

The integration uses the ServiceManager Adapter to transform UCMDB CI attributes to web
services objects recognized by ServiceManager. The ServiceManager Adapter ServiceManager
Adapter uses XSL transformation files to convert UCMDB TQL queries into a properly formatted
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ServiceManager web services messages. Out-of-the-box, each integration query has a
corresponding XSL transformation file. In addition, each attribute you enable for synchronization
from Advanced layout settings requires its own entry in the XSL transformation file.

If you want to add a CI type to the integration, youmust create amatching XSL transformation file
that defines how the ServiceManager Adapter transforms each CI type into a ServiceManager web
service object. See "Integration TQLQueries" on page 110 for information about which CI types
each query manages. In order to create a proper XSLmapping, youmust be familiar with the
service and object names ServiceManager publishes as Web services. See the ServiceManager
help for information on publishing tables and columns as Web service objects.

The following steps illustrate creating an XSL transformation file for the rdbmsData TQL query
described in previous sections.

Tomap aCI type’s attributes to web service fields:

1. Log in to UCMDB with an administrator account.

2. Navigate toData Flow Management > Adapter Management.

3. Click theCreate New Resource button .

4. Select New Configuration File.

5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name: <AdapterID>/<filename>. For example,
ServiceManagerAdapter9-x/rdbms_push.xslt.

7. Copy the content of an existing XSL transformation file (for example, runningsoftware_
push.xslt) to the new XSL transformation file.

8. Find the CI type definition element in the new file. The CI type definition element uses the
following format:

<xsl:template match="/CI_type_name">

CI_type_name is the name of CI type in the UCMDB system.

The following is an example from the runningsoftware_push.xslt file:

<xsl:template match="/running_software">

9. Update the CI type name tomatch the CI type you want to add to the integration. For example,
create the following CI type definition element to add the database CI type to the integration.

<xsl:template match="/sm_rdbms">

10. Add or update table naming elements as needed. By default, UCMDB sends CI attribute data
to the ServiceManager device table. If you want to send CI attributes to one of the join tables
of device, youmust add an element to specify the table name using the format <file.table_
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name>. For example, you do not need to specify an additional jointable to define a database CI
type since ServiceManager does not use a separate jointable tomanage database CI types.

11. Find the elements that transform UCMDB CI attributes into ServiceManager web service
fields. The CI attribute transformation elements use the following format:

<xsl:for-each select="@CI_attribute_name">

<WSFieldName><xsl:value-of select="."/></WSFieldName>

</xsl:for-each>

@CI_attribute_name is the name of attribute in the UCMDB system.

WSFieldName is the name of a web service field published by the ServiceManager system.

The following figures show an example. CI attributes in runningsoftware_push.xslt shows one
CI attribute named product_name is mapped to a web service field with a caption of
ApplicationName; Mapping CI attributes in the ucmdbRunningSoftware web service object
shows the web service field name and caption defined in the ucmdbRunningSoftware web
service object; Mapping CI attributes in the UCMDB RunningSoftware CI type shows how the
product_name attribute is mapped in the RunningSoftware CI type in UCMDB.

See the following screenshot for CI attributes in runningsoftware_push.xslt:

Refer to the following screenshot to map CI attributes in the ucmdbRunningSoftwareweb
service object:
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Refer to the following screenshot to map CI attributes in the UCMDBRunningSoftwareCI
type:
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12. Add or update CI attribute transformation elements for each CI attribute you want to add to the
integration. For example, create the following XSL transformation elements for the database CI
type.

UCMDBattribute Sample transformation elements

port <xsl:for-each select="@port">

<Port><xsl:value-of select="."/></Port>

</xsl:for-each>

database_dbsid <xsl:for-each select="@database_dbsid">

<DBInstance><xsl:value-of select="."/></DBInstance>

</xsl:for-each>

description <xsl:for-each select="@description">

<Description><xsl:value-of select="."/>
</Description>

</xsl:for-each>

Sample XSL transformation elements for database CIs

New attributemappings in rdbms_push.xslt are illustrated in the following screenshot:
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13. Save the new XSL transformation file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a CI Type’s Relationship Types to the
Integration for Data Push

Once you have added a new CI type to the integration and have created relationships between it
and other CI types in UCMDB, for each of these relationship types you need to perform the
following tasks so that UCMDB can push the relationships to ServiceManager.
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As an example, the following steps illustrate how you add a relationship type namedOwnership
(between the Cost and CostCategory CI types) to the integration for data push. These steps
assume that you have already added the Cost and CostCategory CI types to the integration and
have created anOwnership relationship between them in UCMDB.

1. Add amapping entry for each relationship type in the push relationship mapping definition file.
See "How to Add a PushMapping Entry for Each Relationship Type of the CI Type" below.

2. Create a TQL query to push relationships of the CI type.
See "How to Create a TQLQuery to Push Each Relationship Type of the CI Type" on the next
page.

3. Map the relationship TQL to an XSL transformation file in the push configuration file.
See "How toMap Each Relationship Type TQL to an XSL Transformation File" on page 176.

How to Add a Push Mapping Entry for Each Relationship
Type of the CI Type

For data push, the SM_CIT_Subtype_list.xml file defines how UCMDB relationship types are
mapped to SM ones.

Note: This XML file can be found from Adapter Management > ServiceManagerAdapter9-x
> Configuration Files.

If this file does not contain amapping entry for a new relationship type, you need to add an entry for
it.

To add a pushmapping entry for the Ownership relationship type:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Double-click the SM_CIT_Subtype_list.xml file.

4. Go to the RelationshipType list section, and add amapping entry for Ownership.

<list name="RelationshipType">

<!--ucmdb is link display lable, ucmdbType is link type, sm is the relations
hip type.
compound link will use root_* as the lable -->

<entry ucmdb="Aggregation" ucmdbType="aggregation" sm="Aggregation" />

...

<entry ucmdb="Ownership" ucmdbType="ownership" sm="Ownership" />

...
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</list>

Where:

ucmdb: the display name of the UCMDB relationship type (see Name and Display Name of
Ownership).

ucmdbType: the name of the UCMDB relationship type (see Name and Display Name of
Ownership).

sm: the name of the relationship type in ServiceManager.

Name and Display Name of Ownership are illustrated in the following screenshot:

5. Click OK to save the file.

How to Create a TQL Query to Push Each Relationship
Type of the CI Type

Once you have created CI Relationship types for the new CI type, youmust create a TQL query for
each relationship type to push it to ServiceManager.

Note: Any TQL query you createmust conform to the "TQLQuery Requirements" on page 114.

To create a new TQL query called cost_costcategory_ownership_relation_push for Ownership
relationships between the Cost and CostCategory CI types:

1. Log in to UCMDB as an administrator.

2. Navigate toModeling >Modeling Studio.

3. Click New > Query. TheQuery Definition pane displays.
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4. From the CI Type Selector, drag the Cost and CostCategory CI types to the query pane.

5. Create anOwnership relationship from Cost to CostCategory.
a. Click theCreate Relationship button.

b. Click theCost node, and drag the arrow from it to the CostCategory node.

c. Select Regular Relationship, and click OK.

d. Select Connection > Ownership, and click OK. An Ownership relationship is created
between the CI types.

6. Right-click the relationship arrow, and select Relationship Properties.

7. Change the element name fromOwnership toRoot (or a name starting with “Root_”), and then
click OK.
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8. Click theSave button, and save the query as described in the following.
a. Enter a query name. For example, cost_costcategory_ownership_relation_

push.

b. Select the Integration > SM Sync > 9.xx folder.

c. Click OK.

The TQL query is now created. You are ready tomap this TQL to an XSL transformation file.

How to Map Each Relationship Type TQL to an XSL
Transformation File

Once you have created a TQL query for a relationship type, you need tomap the TQL to an XSL
transformation file as described in the following steps.

Tip: Out-of-the-box, there is a common XSL transformation file (common_relations.xslt),
which is used for pushing all types of CI relationships. For this reason, you do not need to
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create a new XSL transformation file; instead, you only need tomap the new relationship TQL
query to this existing XSLT file.

1. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

2. Click the smSyncConfFile.xml file.

3. Add an TQLmapping entry by copying an existing one for relationship push. For example, copy
the following TQLmapping entry.

<tql name="SM Layer2 Topology Relations Push*" xslFile="common_relations.xsl
t">

<request type="Create" name="CreateRelationship"/>

<request type="Update" name="UpdateRelationship"/>

<request type="Delete" name="DeleteRelationship"/>

</tql>

4. Change the TQL name to the name of the query you created for the relationship type. For
example, cost_costcategory_ownership_relation_push.

<tql name="cost_costcategory_ownership_relation_push" xslFile="common_relati
ons.xslt">

<request type="Create" name="CreateRelationship"/>

<request type="Update" name="UpdateRelationship"/>

<request type="Delete" name="DeleteRelationship"/>

</tql>

5. Click OK to save the configuration file.

Now, you have added the new relationship type to the integration. Next, you need to add the new
relationship TQL query to a data push job (see the following figure and "How to Add Custom TQL
Queries to Data Push Jobs" on the next page).

Refer to the following screenshot to add a new relationship TQL query to a data push job:
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How to Add Custom TQL Queries to Data Push Jobs
In order for the integration to send your custom CI types and attributes to your ServiceManager
system, youmust add your custom TQL queries to the data push job between your Changes data
store and your ServiceManager data store. The following steps illustrate how to add an custom
TQL query named rdbmsData, which is described in the previous sections.

To add custom TQL queries to a data push job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Click the name of your ServiceManager integration point. For example, SM Integration.

4. Click theData Push tab.

5. Click the name of your data push job. For example, SM Configuration Item Push job.

6. Click theEdit button .

7. Click theAdd button.

8. Click Integration > SM Sync > rdbmsData.

9. Click OK to add the custom query.

10. Enable theAllow Integration Job to delete removed data option for the query.

11. Click OK to close the Update Job Definition window.
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How to Add a CI Attribute to the Integration for
Population

To add a CI attribute to the integration for population, perform the following tasks:

1. Create a web service field to support the CI attribute.
See "Create aWeb Service Field to Support the CI Attribute" below.

2. Map the CI attribute to the web service field.
See "How toMap the CI Attribute to theWeb Service Field" below.

Create a Web Service Field to Support the CI Attribute
UCMDB uses the ServiceManager ucmdbIntegration web service to retrieve CI data from Service
Manager. This web service publishes the objects that match the out-of-the-box CI types and CI
attributes provided by the UCMDB integration.

If you want to populate an additional CI attribute from ServiceManager to your Universal CMDB
system, youmust create a corresponding web service field on your ServiceManager system to
provide the CI data from ServiceManager. Each web service field must map to a valid Service
Manager table and column.

For the steps of creating a web service field, see "How to Create aWeb Service Field to Support
the CI Attribute" on page 140.

How to Map the CI Attribute to the Web Service Field
The integration uses an adapter to transform ServiceManager web service fields to Universal
CMDB CI attributes. The adapter in turn specifies what XSL transformation files the integration
should use to convert ServiceManager web services messages into a properly formatted Universal
CMDB CI and/or relationship.

Out-of-the-box, each integration query has a corresponding XSL transformation file that maps to a
particular CI type in Universal CMDB. Without an XSL transformation entry, Universal CMDB
cannot receive any CI attribute updates from your ServiceManager system.

Unlike for the Push feature, you do not need to create real Topology Query Language (TQL) queries
for Population on the UCMDB server.

If you want to add a new attribute to the integration, youmust edit the XSL transformation file for the
parent CI type and add an entry for the CI attribute. For information about which CI types each
population query manages, see "Integration TQLQueries" on page 110. In order to create a proper
XSLmapping, youmust be familiar with the service and object names that ServiceManager
publishes as Web services. For information on publishing tables and columns as Web service
fields, see the ServiceManager help.

The following steps illustrate how tomap a UCMDB CI attribute called host_vendor to a Service
Manager web service field called OSVendor.

Tomap a CI attribute to a web service field:
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1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management.

3. Navigate to the ServiceManager Adapter configuration files path: ServiceManagerAdapter9-
x > Configuration Files.

4. Click the XSL transformation file that manages the parent CI type of your CI attribute. For
example, open computer_population.xslt to add an attribute to theSM Computer Population
TQL query.

5. Find the element that defines the name of the Universal CMDB CI Type where the integration
will store CI attribute values. For example, the element <ci class="node">will store CI
attributes in the Universal CMDB Node CI Type.

6. Within the ci naming element (<ci class="node">), you will see an element of the following
format that defines how to transform each web service field into an Universal CMDB CI
attribute:

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI_attribute_type" ign
oreCIIfEmpty="true">
<xsl:value-of select="SMAttributeName "/></attribute>

UCMDB_CI_attribute_name is the name of attribute in the Universal CMDB system.

UCMDB_CI_attribute_type is the type of attribute of the Universal CMDB system which this
integration supports. Currently the following types are supported: String, StringList, Integer,
Long, Double, Boolean, IPAddress, Date, Float, and IntList.

ignoreCIIfEmpty is a parameter that specifies whether or not to ignore the CI during
population if this attribute has an empty value (true: ignore; false: not ignore).

Note:
n A StringList is a list of strings separated by a semicolon (;). For example, str1;str2;str3.

An IntList is a list of integers separated by a semicolon (;). For example, 1;2;3.

n For information about time zone and date format configuration of the Date type, see
"How to Update the Time Zone and Date Format for the Integration Adapter" on page
33.

SMAttributeName is the name of a web service attribute published by the ServiceManager
system.

CI attributes in the computer_population.xslt file are illustrated in the following screenshot:
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Refer to the following screenshot to match CI attributes in the ucmdbNodeweb service object:

7. Copy an existing XSL transformation element to use it as a template to create a new
transformation entry.
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8. Paste the new XSL transformation element within the proper table naming element. For
example, <ci class="node">.

9. Update the CI attribute name and web service field namewithin the new element to match the
attribute you want to add to the integration. For example, create the following XSL
transformation element to add the os_vendor attribute to the integration.

<attribute name="os_vendor" type="String"><xsl:value-of select="file.node/OS
Vendor"/></attribute>

New attribute in the computer_population.xslt file is illustrated in the following screenshot:

10. Save the XSL transformation file.

When you create/edit and then save a configuration file in Adapter Management, UCMDB
automatically restarts the adapter with the new configuration file.

How to Add a CI Type to the Integration for
Population

You can use the following steps to add a CI type to the integration for population.

1. Create a TQL query to populate the CI type.
See "Create a TQLQuery to Populate the CI Type" on the next page.

2. Map the CI type's TQL query to an XSL transformation file.
See "How toMap the CI type's TQLQuery to an XSL Transformation File" on the next page.

3. Map the CI type's attributes to web service fields.
See "How toMap the CI Type's Attributes toWeb Service Fields" on page 188.
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Create a TQL Query to Populate the CI Type
Unlike for push, for population the integration does not require you to create custom Topology Query
Language (TQL) queries in Universal CMDB to save CI attribute values.

The population feature only needs the smPopConfFile.xml file and population XSL transformation
files to synchronize CI/CI Relationship types and attributes; however for each CI/CI Relationship
type you still need to define a TQLmapping in the smPopConfFile.xml file, and the TQL query does
not necessarily have to exist in UCMDB. It is simply a query name, which will appear in the query
list when you add queries to a population job.

HP still recommends you to create TQL queries to help you better understand what CI types or
attributes are part of population. For information on how to create a TQL query in UCMDB, see
"How to Create a TQLQuery to Synchronize the CI Type" on page 153.

How to Map the CI type's TQL Query to an XSL
Transformation File

The integration uses a configuration file called smPopConfFile.xml to map each Universal CMDB
TQL query to an XSL transformation file. In order for custom TQL queries to be part of the
integration, youmust add amapping entry for each TQL query in the configuration file.

Tomap the TQL query rdbmsData described in previous sections to the Service
ManagerucmdbRDBMS web service:

Tomap a TQL query to an XSL transformation file:

1. Log in to UCMDB with an administrator account.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files > smPopConfFile.xml.

3. Add a TQLmapping element by copying an existing one. A TQLmapping element uses the
following format:

<tql name="TQL_query" xslFile="XSL_File">

<request type="Retrieve"

dataType="Data_Type"

retrieveFileList="Retrieve_SM_Tables"

retrieveKeysQueryName="Retrieve_keys_web_service"

retrieveListQueryName="Retrieve_Objects_web_service"

ballQueryCondition="Full_Query_Condition"

changedUpdateQueryCondition="Changed_Update_Condition"

changedDeletionQueryCondition="Changed_Deletion_Condition"/>

Universal Discovery Content Guide - ServiceManager Integration
Tailoring the Integration

Page 183 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



</tql>

TQL_query is a TQL query name. The TQL query does not have to exist in UCMDB.

XSL_File is the name of the XSL transformation file that the integration will use tomap Service
Manager web service fields to Universal CMDB attributes.

Data_Type is the type of the object retrieved from ServiceManager. The possible values are
“ci” and “relationship”.

Retrieve_SM_Tables is the table name list in the ServiceManager web service configuration;
if you define theWSDL on a join definition, you need to list all the table names of the join
definition to which the fields of XSLT mapping belongs; if you define theWSDL on a simple
table, simply leave Retrieve_SM_Tables empty. You can also check this by opening the
WSDLURL: http://<SM server>:<port>/SM/7/<object name>.wsdl. For example, out-
of-the-box, the instance type of ucmdbNode is as shown in the following figure, so the
Retrieve_SM_Tables value is file.device, file.node.

SM tables of the ucmdbNode instance type in the ucmdbNodeWSDL are illustrated in the
following screenshot:
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Retrieve_keys_web_service is the name of the ServiceManager web service that you want
the integration to use to retrieve a CI Key list from ServiceManager.

Retrieve_Objects_web_service is the name of the ServiceManager web service that you
want the integration to use to retrieve a CI Object list from ServiceManager.

Basic_Query_Condition is an internal Query Condition of ServiceManager that you want the
integration to use to retrieve a CI list from ServiceManager for a CI type; it is used as the basic
condition for a full or changes population.

Full_Query_Condition is an additional internal Query Condition of ServiceManager. Along
with the Basic_Query_Condition, it is used to retrieve a list of all CIs from ServiceManager for
a full population.
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Changed_Update_Condition is an additional internal Query Condition of ServiceManager;
along with the Basic_Query_Condition, it is used to retrieve a list of updated CIs from Service
Manager since the last job execution; it includes both updated CIs and newly created CIs. It is
used for a changes population.

Changed_Deletion_Condition is an additional internal Query Condition of ServiceManager;
along with the Basic_Query_Condition, it is used to retrieve a list of deleted CIs from Service
Manager since the last job execution. It is used for a changes population.

The following figure shows an excerpt of the smPopConfFile.xml:

4. Add or update TQLmapping elements for each TQL query you want to add to the integration.
For example, the following TQL creates amapping between the rdbmsData TQL query and the
rdbms_population.xslt file.

<tql name="rdbmsData" xslFile="rdbms_population.xslt">

<request type="Retrieve" dataType="ci"

retrieveFileList="file.device,file.rdbms"

retrieveKeysQueryName="RetrieveucmdbRDBMSKeysListRequest"

retrieveListQueryName="RetrieveucmdbRDBMSListRequest"

basicQueryCondition="type#&quot;rdbms&quot;"

fullQueryCondition="istatus~=&quot;Disposed/Retired&quot;"

changedUpdateQueryCondition="(devicemodtime>'{fromDate}' or (devicem
odtime=NULL and created.by.date>'{fromDate}')) and istatus~=&quot;Disposed/R
etired&quot;"
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changedDeletionQueryCondition="devicemodtime>'{fromDate}' and istatu
s=&quot;Disposed/Retired&quot;"/>

</tql>

The following figure shows the above-mentioned TQLmapping elements in the
smPopConfFile.xml file:

The following figure shows an excerpt of the ucmdbRDBMSWSDL for your reference:
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5. Save the configuration file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Map the CI Type's Attributes to Web Service
Fields

The integration uses the ServiceManager Adapter to transform ServiceManager web services
objects to Universal CMDB CI attributes. The ServiceManager Adapter uses XSL transformation
files to convert a properly formatted ServiceManager web services messages into Universal
CMDB CI. Out-of-the-box, each integration query has a corresponding XSL transformation file. In
addition, each attribute you want to populate to Universal CMDB requires its own entry in the XSL
transformation file.

Universal Discovery Content Guide - ServiceManager Integration
Tailoring the Integration

Page 188 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



If you want to add a CI type to the integration, youmust create amatching XSL transformation file
that defines how the ServiceManager Adapter transforms each ServiceManager web service field
into a CI type. In order to create a proper XSLmapping, youmust be familiar with the service and
object names that ServiceManager publishes as Web services. For information on publishing
tables and columns as Web service fields, see theServiceManager 9.31Web Services Guide.

To create an XSL transformation file for the SM RDBMS CI type, which is described in previous
sections:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management.

3. Click theCreate new resource button .

4. Select New Configuration File.

5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name using this format: <AdapterID>/<filename>. For example,
ServiceManagerAdapter9-x/rdbms_population.xslt.

7. Copy the content of an existing XSL transformation file to use it as a template to create the
new transformation file. For example, copy the content of business_service_
population.xslt to the new file.

8. Find the web service response name definition element, which uses the following format:

<xsl:template match="/SM_WEBSERVICE_RESPONSE_NAME">

SM_WEBSERVICE_RESPONSE_NAME is the name of web service response in the ServiceManager
system.

The following figure shows an example of Web Service response definition in business_
service_population.xslt:
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9. Update the web service response name tomatch the response name that you want to add to
the integration. For example, you can create the following CI type definition element to add the
database response of retrieve object list to the integration.

<xsl:template match="/RetrieveucmdbRDBMSListResponse">

10. Find the Universal CMDB CI type definition element, which uses the following format:

<ci class="UCMDB_CI_TYPE_NAME">

UCMDB_CI_TYPE_NAME is the CI type name in the Universal CMDB System.

The following figure shows an example CI type definition in business_service_
population.xslt:

11. Update the Universal CMDB CI type definition name tomatch the name you want to add to the
integration. For example, create the following CI type definition element to add the database
response of retrieve object list to the integration.

<ci class="sm_rdbms">

12. Find the elements that transform ServiceManager web service fields into Universal CMDB CI
attributes. The CI attribute transformation elements use the following format:

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI_attribute_type" ign
oreCIIfEmpty="true">
<xsl:value-of select="SMAttributeName "/></attribute>

UCMDB_CI_attribute_name is the name of the CI attribute in the Universal CMDB system.

UCMDB_CI_attribute_type is the type of the CI attribute in the Universal CMDB system that
this integration supports. Currently the following types are supported: String, StringList,
Integer, Long, Double, Boolean, IPAddress, Date, Float, and IntList.

ignoreCIIfEmpty is a parameter that specifies whether or not to ignore the CI during
population if this attribute has an empty value (true: ignore; false: not ignore).
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Note:
n A StringList is a list of strings separated by a semicolon (;). For example, str1;str2;str3.

An IntList is a list of integers separated by a semicolon (;). For example, 1;2;3.

n For information about setting a time zone and date format for the Date type, see "How
to Update the Time Zone and Date Format for the Integration Adapter" on page 33.

SMAttributeName is the name of a web service attribute published by the ServiceManager
system.

See the following figure for an example of CI attributes in business_service_
population.xslt:

Refer to the following screenshot to match CI attributes in the Universal CMDB
BusinessServiceCI type:
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Refer to the following screenshot to match CI attributes in the ServiceManager
ucmdbBusinessServiceweb service:

13. In the SM RDBMS population example, there are no sub items of a CI. If you want to populate
the sub items of a CI, for example, to populate the IP addresses of a computer together with
the computer CI, you need to add a “link” element under the “ci” element. A link transformation
element uses the following format:
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<link direction="Link_Direction" linkType="UCMDB_Link_Type">

<ci class="UCMDB_SUB_CI_TYPE_NAME">

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI_attribute_typ
e">
<xsl:value-of select="SMAttributeName "/></attribute>

<attribute name="UCMDB_CI_attribute_name2" type="UCMDB_CI_attribute_ty
pe2">
<xsl:value-of select="SMAttributeName 2"/></attribute>

</ci>

</xsl:for-each>

</link>

Link_Direction is the direction between a parent CI and sub CI. The supported directions
are:

n outgoing: The link direction is from an upstream CI to the current downstream CI (for
example, from node to ip_address).

n incoming: The link direction is from a downstream CI to the current upstream CI.

UCMDB_Link_type is the relationship type in the Universal CMDB system.

The following figures show the out-of-the-box configurations for populating the Computer CI
together with its IP addresses:
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Link definition in the import xslt file (ips_mapping_population.xslt) is illustrated in the
following screenshot:

Refer to the following screenshot to match CI attributes and links in the ServiceManager
WSDL(http://<SM server>:<port>/SM/7/ucmdbNode.wsdl):
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Refer to the following screenshot to match CI links in UCMDB at the TQL level:

Note: TheMatching CI links in UCMDB at the TQL level figure is provided here only to
give you a graphic view of how relevant CIs are stored in UCMDB. You do not need to
create the TQL query, since the population feature does not require it.

Refer to the following screenshot to match CI type and attributes in the UCMDB CI Type
(IpAddress):
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14. Add or update the CI attribute transformation elements for each CI attribute you want to add to
the integration. For example, you can use the following XSL transformation elements for the
database CI type.

UCMDB
attribute Sample transformation elements

discovere
d_product_
name

<attribute name="discovered_product_name" type="String">
<xsl:value-of select="file.device/CIIdentifier"/></attribute>

product_
name

<attribute name="product_name" type="String">
<xsl:value-of select="file.device/ApplicationName"/></attribut
e>

application_
version

<attribute name="application_version" type="String">
<xsl:value-of select="file.device/ProductVersion"/></attribute>

vendor <attribute name="vendor" type="String">
<xsl:value-of select="file.device/Vendor"/></attribute>

Sample XSL transformation elements for database CIs
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UCMDB
attribute Sample transformation elements

version <attribute name="version" type="String">
<xsl:value-of select="file.device/Version"/></attribute>

dbinstance <attribute name="dbinstance" type="String">
<xsl:value-of select="file.rdbms/DBInstance"/></attribute>

port <attribute name="port" type="String">
<xsl:value-of select="file.rdbms/Port"/></attribute>

description <attribute name="description" type="String">
<xsl:value-of select="file.rdbms/Description"/></attribute>

Sample XSL transformation elements for database CIs, continued

Attributemappings in rdbms_population.xslt are illustrated in the following screenshot:

15. Save the XSL transformation file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.
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How to Add a CI Type’s Relationship Types to the
Integration for Population

Once you have added a new CI type to the integration for population, you need to add the new CI
type’s relationship types to the integration. For each relationship type, perform the following tasks.

As an example, the following steps describe how to add theOwnership relationship type to the
integration; these steps assume that you have already added the Cost and CostCategory CI types
to the integration for population.

1. Create an XSL transformation file to map each relationship type’s attributes to web service
objects.
See "How toMap Each Relationship Type's Attributes toWeb Service Objects" below.

2. Add a TQLmapping for each relationship type to the population configuration file.
See "How to Define a TQLMapping for Each Relationship Type" on page 200.

How to Map Each Relationship Type's Attributes to Web
Service Objects

This example illustrates how to create an XSL transformation file to map the attributes of the
Ownership relationship type to web service objects.

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management.

3. Click theCreate new resource button .

4. Select New Configuration File.

5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name using this format: <AdapterID>/<filename>. For example,
ServiceManagerAdapter9-x/cost_to_costcategory_population.xslt.

7. Click Yes to ignore the file extension warning. The file is added to the Configuration Files
folder.

8. Copy the content of an existing relationship population XSLT file (for example, computer_to_
computer_connects_population.xslt) to the new XSLT file.

Note: In the next step, you will update the <ci class> names and linkType value.

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transfor
m">
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<xsl:template match="/Retrievecirelationship1to1ListResponse">

<topology>

<xsl:for-each select="instance">

<ci class="node">

<attribute name="name" type="String"><xsl:value-of selec
t=
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of sele
ct=
"upstreamci.id"/></attribute>

<link direction="outgoing" linkType="tcp">

<ci class="node">

<attribute name="name" type="String"><xsl:value-
of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-
of select=
"downstreamci.id"/></attribute>

</ci>

</link>

</ci>

</xsl:for-each>

</topology>

</xsl:template>

</xsl:stylesheet>

9. Change the <ci class> names to cost and cost_category, and linkType to ownership.

...

<ci class="cost">

<attribute name="name" type="String"><xsl:value-of selec
t=
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of sele
ct=
"upstreamci.id"/></attribute>

<link direction="outgoing" linkType="ownership">
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<ci class="cost_category">

...

ci class: the name (not display name) of the each CI type involved in the relationship. It
should be the Name field value on theGeneral Details tab of the CI type definition.

linkType: the name of the relationship type. It should be the Name field value on theGeneral
Details tab of the relationship type definition.

Note: In this example, you do not need to change the link direction (outgoing). This is
because the relationship (Ownership) direction is from cost to cost_category, that is, from
a <ci class> outside of the <link> element to a <ci class> inside it).

10. Save the XSL transformation file.

How to Define a TQL Mapping for Each Relationship Type
For each relationship type of the new CI type, you need to define a TQLmapping in the
smPopConfFile.xml file.

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files > smPopConfFile.xml.

3. In the smPopConfFile.xml file, add a TQLmapping for the relationship type, by copying an
existing TQLmapping element.

Note: In the next step, you will update the highlighted values with values of the new
relationship type.

<tql name="SM Biz To Biz With Usage"
xslFile="businessservice_to_businessservice_usage_population.xslt">

<request type="Retrieve" dataType="relationship"

retrieveKeysQueryName="Retrievecirelationship1to1KeysListRequest"

retrieveListQueryName="Retrievecirelationship1to1ListRequest"

basicQueryCondition="upstreamci.type=&quot;bizservice&quot; and
downstreamci.type=&quot;bizservice&quot; and
relationship.subtype=&quot;Usage&quot;"

fullQueryCondition="status~=&quot;Removed&quot;"

changedCreationQueryCondition="create.datetime&gt;'{fromDate}' and
status~=&quot;Removed&quot;"
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changedUpdateQueryCondition="created.datetime&lt;='{fromDate}' and
update.datetime&gt;'{fromDate}' and status~=&quot;Removed&quot;"

changedDeletionQueryCondition="update.datetime&gt;'{fromDate}' and
status=&quot;Removed&quot;"/>

</tql>

4. Update the TQP mapping element with the values of the new relationship type.

Note: For the TQL name, you can enter any descriptive name as you like (for example, SM
Cost to CostCategory with Ownership). This TQL query does not really exist,
since population does not require it.

The upstreamci.type, downstreamci.type, and relationship.subtype values are defined in
the cirelationship1to1 table in ServiceManager.

<tql name="SM Cost to CostCategory with Ownership"
xslFile="cost_to_costcategory_population.xslt">

<request type="Retrieve" dataType="relationship"

retrieveKeysQueryName="Retrievecirelationship1to1KeysListRequest"

retrieveListQueryName="Retrievecirelationship1to1ListRequest"

basicQueryCondition="upstreamci.type=&quot;cost&quot; and
downstreamci.type=&quot;costcategory&quot; and
relationship.subtype=&quot;Ownership&quot;"

fullQueryCondition="status~=&quot;Removed&quot;"

changedCreationQueryCondition="create.datetime&gt;'{fromDate}' and
status~=&quot;Removed&quot;"

changedUpdateQueryCondition="created.datetime&lt;='{fromDate}' and
update.datetime&gt;'{fromDate}' and status~=&quot;Removed&quot;"

changedDeletionQueryCondition="update.datetime&gt;'{fromDate}' and
status=&quot;Removed&quot;"/>

</tql>

5. Save the population configuration file.

Note:When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

Now the relationship type is added to the integration for population. Next, you need to add the
relationship TQL name you specified in the population configuration file (in this example, SM Cost
to CostCategory with Ownership) to a relationship population job, so that the integration can
populate this type of relationships to UCMDB. See the following figure and also "How to Add
Custom TQLQueries to Integration Population Jobs" on page 204.
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Refer to the following screenshot to add a new relationship TQL name to a relationship population
job:

How to Customize UCMDB ID Pushback for a CI
Type

Out-of-the-box, UCMDB pushes the UCMDB ID of each CI type back to ServiceManager during
population, by calling a ServiceManager web service (ucmdbIDPushBack) based on the
ucmdbid.pushback.request and ucmdbid.pushback.xslt settings in the sm.properties file in
UCMDB (see "How to Update the Integration Adapter Configuration File (sm.properties)" on page
124).

To better suit your business needs, you canmake the following tailorings to the ucmdb id pushback
feature, using the <idPushbackConfigurations> element in the ServiceDeskConfiguration.xml
file:

l "How to Disable the UCMDB ID Pushback Feature for a Specific CI Type" on the next page

l "How to Define a Custom Pushback Web Service and xslt File for a Specific CI Type" on the
next page

Note: For a specific UCMDB class (CI type), its definitions in the
ServiceDeskConfiguration.xml file supercede the following global settings in the
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sm.properties file:

l idPushbackEnable: In the sm.properties file, this setting is not present; however, out-of-
the-box, it is set to true for all CI types.

l idPushbackRequest: In the sm.properties file, its out-of-the-box value is
UpdateucmdbIDPushBackRequest.

l idPushbackXSLT: In the sm.properties file, the out-of-the-box value is ucmdbid_
pushback.xslt.

How to Disable the UCMDB ID Pushback Feature for a
Specific CI Type

Youmay want to disable the pushback feature for certain UCMDB CI types, for example, UCMDB
classes that aremapped to a sub-item type (IP Address, CPU, etc.) in ServiceManager. Doing so
can aviod unnecessary system overload.

To disable the pushback feature for a UCMDB CI type (class), use this format:

<idPushbackConfiguration ucmdbClassName="<ucmdbClassName>" idPushbackEnable="fal
se"/>

Where, <ucmdbClassName> is the name of the UCMDB CI type.

Here are the out-of-the-box settings in the ServiceDeskConfiguration.xml file:

<idPushbackConfigurations>

<idPushbackConfiguration ucmdbClassName="interface" idPushbackEnable="false"/>

<idPushbackConfiguration ucmdbClassName="cpu" idPushbackEnable="false"/>

<idPushbackConfiguration ucmdbClassName="disk_device" idPushbackEnable="fals
e"/>

<idPushbackConfiguration ucmdbClassName="file_system" idPushbackEnable="fals
e"/>

<idPushbackConfiguration ucmdbClassName="ip_address" idPushbackEnable="false"/>

</idPushbackConfigurations>

To enable the pushback feature for a CI type, set idPushbackEnable="true" for it.

How to Define a Custom Pushback Web Service and xslt
File for a Specific CI Type

There are occasions when you need to define a custom pushback web service and XSLT for a
specific CI type (class), for example, when a CI type you want to populate is not stored in the
device table in ServiceManager. This is because the out-of-the-box ucmdbIDPushBack web
service is based on the device table.
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For example, you have tailored the integration in order to populate the Functional Group from
ServiceManager to UCMDB. If the Functional Group in ServiceManager is not stored in the device
table, you can define a custom web service and XSLT like the following:

<idPushbackConfigurations>

<idPushbackConfiguration ucmdbClassName="functional_group"
idPushbackEnable="true"
idPushbackRequest="UpdateucmdbIDPushBackForFunctionalGroupRequest"
idPushbackXSLT="ucmdbid_pushback_functionalgroup.xslt"/>

......

</idPushbackConfigurations>

Note: To support your pushback customizations, you need to create the specified custom web
service record in ServiceManager and XSLT file in UCMDB.

How to Add Custom TQL Queries to Integration
Population Jobs

In order for the integration to send your custom ServiceManager web service object and fields to
your UCMDB system, youmust add your custom TQL queries to the population job between your
ServiceManager data store and your UCMDB data store. The following steps illustrate how to add
the custom rdbmsData TQL query described in previous sections.

To add custom TQL queries to population job definitions:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Double-click the name of your ServiceManager integration point. For example, SM
Integration.

4. Click thePopulation tab.

5. Select a population job. For example, SM Configuration Item Population job.

6. Click theEdit Integration Job button .

7. Click theAdd button .
The TQL names configured in the smPopConfFile.xml file are listed.

8. Click Root > rdbmsData.

9. Click OK to add a custom query.

10. Click OK to close the Update Job Definition window.
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How to Add an Attribute of a Supported CI Type for
Federation

Out-of-the-box, the integration supports federation for three external CI types in UCMDB: Incident,
Problem, and RequestForChange.

For each of the supported CI types, there is a list of attributes in UCMDB that you canmap to
ServiceManager web service objects for federation. The following figure shows the out-of-the-box
UCMDB CI attributes available for the Incident CI type.

Incident CI attributes supported for federation are illustrated in the following screenshot:

For example, to add an SM Incident attribute for federation, you need to expose the field in the SM
UcmdbIncident web service object and thenmap it to an appropriate UCMDB attribute (if one does
not already exist, you need to create it in UCMDB first).

The following figure shows the fields that are exposed in the UcmdbIncidentweb service object in
ServiceManager:
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You can exposemore fields so that more Incident attributes can be federated to UCMDB. As an
example, the following describes how to add the “action” field in the ServiceManager probsummary
(Incident) file for federation, by mapping it to a new UCMDB attribute named “details”.

Note: On the Incident form in ServiceManager, the “action” field is labeled “Description”, which
describes the incident ticket in more detail. See the following figure.

To add an attribute of a supported CI type for federation:

1. Add the SM attribute to its web service object.
The following example describes how to expose the SM “action” field of Incident in the
UcmdbIncident web service object.

a. Log in to ServiceManager as a system administrator.

b. Navigate to Tailoring >Web Services >WSDL Configuration.
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c. Enter the following field values, and then click Search.
o Service Name: ucmdbIntegration

o Name: probsummary

The UcmdbIncident web service object displays.

d. On the Fields tab, add the following row:
o Field: action.

o Caption: Description

e. Save the web service object.

2. Map the SM attribute to a UCMDB attribute.
The following example describes how tomap the SM “action” attribute to a new UCMDB
attribute named “details”.

a. Log in to UCMDB as an administrator.

b. Navigate toModeling > CI Type Manager.

c. Browse to ItProcessRecord > Incident, and open its properties pane.
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d. Click theAdd button to add a new attribute named “details” to the Incident CI type.

o name: details

o Display Name: Details

o Description: Incident details

o Attribute Type: Primitive > List of strings (this is because the “action” field in SM is an
array)

e. Save the Incident CI type record.

f. Navigate toData Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files.

g. Click the ServiceDeskConfiguration.xml file.

h. Add amapping entry for the “details” attribute in the Incident attributeMappings section, as
shown in the following.

<ucmdbClassConfiguration ucmdbClassName="incident">

<attributeMappings>
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<attributeMapping ucmdbAttributeName="reference_number"
serviceDeskAttributeName="IncidentID"/>

<attributeMapping ucmdbAttributeName="name"
serviceDeskAttributeName="BriefDescription"/>

...

<attributeMapping ucmdbAttributeName="incident_status"
serviceDeskAttributeName="IMTicketStatus"
converterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToUpperAndReplaceUnderscoreWithSpace"
reversedConverterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToLowerAndReplaceSpaceWithUnderscore"/>

...

<attributeMapping ucmdbAttributeName="urgency" serviceDeskAttribut
eName="Urgency"/>

<attributeMapping ucmdbAttributeName="details" serviceDeskAttributeName="
Description"/>

</attributeMappings>

Tip: The attributemapping entry uses the following format:

<attributeMapping ucmdbAttributeName="details" serviceDeskAttributeNam
e="Description"/>

Where:

ucmdbAttributeName is the UCMDB attribute name in the Incident CI type definition
to which you want to map the SM attribute;

serviceDeskAttributeName is the field caption you defined in the SM web service
object.

For an SM attribute (for example, problem.status) that is a drop-down list, the attribute
mapping uses the following format (you only need to change the attribute names):

<attributeMapping ucmdbAttributeName="incident_status"
serviceDeskAttributeName="IMTicketStatus"
converterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToUpperAndReplaceUnderscoreWithSpace"
reversedConverterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToLowerAndReplaceSpaceWithUnderscore"/>
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i. Click OK to save the file.

Now the Description (field name: action) attribute of SM Incident has been added to the
integration for federation. You can run an Incident federation query in the UCMDB Modeling
Studio to see if the SM Description data is properly federated. For details, see "Examples of
Using Federation" on page 44.

The following figure shows an example where the Description of an SM incident ticket has
been federated to UCMDB as Details:
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Troubleshooting
When data push and population errors occur, you can check the error messages and the integration
log files to identify the root causes and fix the errors. This chapter describes the general
troubleshooting steps, as well as typical errors and solutions.

This section includes:

l "Troubleshooting Data Push Issues" below

l "Troubleshooting Population Issues" on page 237

Troubleshooting Data Push Issues
When data push errors or problems occur, you can check the error messages and the log file to
figure out the root causes and then fix the errors.

This integration uses the following error codes for data push.

Error
code Description

-1 Unspecified error.

0 Success.

3 Resource unavailable.

28 Not authorized.

51 Recordmodified since last retrieved.

70 Invalid SOAP action / unrecognized application action.

71 Validation failed.

881 CI does not exist in ServiceManager.

882 Unable to remove the relationship because at least one of CIs involved in the
relationship does not exist in ServiceManager.

Data push error codes

When a data push job has failed, the job status becomes Failed. Troubleshoot the failed job as
follows:

l Check the error messages of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Push Job" on the next page.

l Check the log file for more details.
See "How to Check the Push Log File" on page 217.
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When a data push job was completed, but with partial records failed, the job status becomes
Passed with failures. Troubleshoot the failed records as follows:

l Check the error messages of failed CIs in the Universal CMDB studio.
See "How to Check the Error Messages of Failed CIs/CI Relationships in a Push Job" on the
next page.

l Check the log file for more details.
See "How to Check the Push Log File" on page 217.

Once you have fixed the issues with the failed records, you can re-push them one by one or in
batches. For details, see "How to Re-push Failed CI/CI Relationship Records" on page 222.

How to Check the Error Message of a Failed Push
Job

To check the error message of a failed job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration from Integration Point list.

4. Click theData Push tab.

5. Select the job from Integration Jobs.

6. Click the Job Errors sub-tab, and double-click the Severity of amessage from the list.
A popup window displays the detailed error message of this failed job. Following is an excerpt
of a sample error message indicating that an XSLT file was not found.
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How to Check the Error Messages of Failed CIs/CI
Relationships in a Push Job

When a data push job is completed with partial records failed, in the Universal CMDB studio, you
can check the source CI XML of Universal CMDB, the XSLT-transformed XML and the response
XML from ServiceManager to see if the failure is caused by data issues.

To check the error messages of failed records in a data push job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration from Integration Point list.

4. Click theData Push tab.

5. Select the job from Integration Jobs.

6. Click theQuery Status sub-tab.

7. Double-click a query with failures. The Error Message and CI Count for each failed CI Type
display.

8. Double-click an error message. A list of failed records displays.

9. Double-click a failed record.
The detailed error message of the record displays.
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The following is a sample error message that indicates a validation failure, and the root cause
is that a not-null key (key definition #18 of the device table) contains an empty value.
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How to Check the Push Log File
You need to set the Development adapter log level to DEBUG so that you can check the source
tree XML file of UCMDB, the XSLT-transformed XML file, and the response XML file from Service
Manager.

Tip: You are recommended to enable the Development Mode for the integration point so that
the above-mentioned three XML files are in a good format. See the following for the steps.

To set the Development adapter log level to DEBUG:

1. Log in to the UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation
folder>\UCMDBServer\conf\log\fcmdb.properties file. For example:
C:\HP\UCMDB\UCMDBServer\conf\log\fcmdb.properties.
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3. Open the fcmdb.properties file in a text editor.

4. Update the log4j.category.fcmdb.adapters log level toDEBUG.

5. Save the file.

To enable the Development Mode for the integration point:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration.

4. Click theEdit Integration Point button.

5. For Development Mode, select True from the list.

6. Click theOK button to save the integration point.

To check the push log file:

1. Log in to the UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation
folder>\UCMDBServer\runtime\log\fcmdb.adapters.<integration_point_name>.log
file. For example: C:\HP\UCMDB\UCMDBServer\runtime\log\fcmdb.adapters.SM
Integration.log

3. Open the log file in a text editor.
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4. Search for text strings Source tree XML:, Transformed XML:, and Response message from
SM:.
The following is a sample log file.
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How to Re-push Failed CI/CI Relationship Records
The push error handlingmechanism allows you to re-push failed CI/CI Relationship records either
one by one or in batches.

To re-push failed data in a query of a data push job:

1. Select the data push job.

2. On theQuery Status tab, double-click the failed query.

The query failure details (Error Message, CI Type, and CI Count) display.

3. Double-click the Error Message, to seemore details of the failed records.

4. Double-click each failed record to see the detailed error message of the record.

5. Fix the issues with each failed record according to the error information.
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6. Select a failed record, and then click thePush selected failed data button to re-synchronize
the record.

Alternatively, click the query name link (in this example, “SM Node Relations Push”), select the
error message of the query, and then click thePush selected failed data button to re-push all
failed records in the query.

Typical Push Errors and Solutions
This section describes typical error messages that may occur during data push, as well as their
solutions.

This section includes:

l "TQL not Configured in smSyncConfFile.xml" on the next page

l "Non-Existing XSLT File NameDefined for a TQL in smSyncConfFile.xml" on page 225

l "Request Name not Found for a TQL in smSyncConfFile.xml " on page 226

l "Wrong ServiceManagerWS Request NameDefined in smSyncConfFile.xml" on page 228

l "XSLT file not Well Formed" on page 229

l "Wrong UCMDB Attribute Name in XSLT File" on page 231

l "Wrong ServiceManager Field Name in XSLT File" on page 232

l "Empty Value for No Nulls Key in ServiceManager" on page 233

l "CI Logical Name Truncated or CI not Pushed due to Logical Name Truncation" on page 236

l "ServiceManager Database Case-Sensitivity Issue" on page 236

l "Global ID and Customer ID Missing in XSLT" on page 237
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TQL not Configured in smSyncConfFile.xml
Sample configuration

The TQL query used for populating business service CIs is named SM Business Service Push,
however you have not configured it (or have commented it out) in the smSyncConfFile.xml file:

Error message

The push job fails with a “Failed” status. From both the log file and the detail error message of the
failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed Push
Job" on page 212), you receive an error like the following:

Solution

Search for text No mapping is found for TQL to find the TQL name that is not yet configured,
and then configure the TQL name in the smSyncConfFile.xml file.

For instructions on how to add amapping for a TQL, see "How toMap the CI Type’s TQLQuery to
an XSL Transformation File" on page 165.
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Non-Existing XSLT File Name Defined for a TQL in
smSyncConfFile.xml

Sample configuration

The XSLT file for populating business service CIs is named business_service_push.xslt,
however you have configured a wrong name business_service_push_wrong_name.xslt in
smSyncConfFile.xml.

Error message

The data push job fails with a “Failed” status. From both the log file and the detail error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 212), you receive an error like the following:
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Solution

Search for text java.io.FileNotFoundException: Resource: to find the wrong XSLT file name,
and then correct the XSLT file name in the smSyncConfFile.xml file.

For instructions on how to configure an XSLT file name for a TQL, see "How toMap the CI Type’s
TQLQuery to an XSL Transformation File" on page 165.

Request Name not Found for a TQL in
smSyncConfFile.xml

Sample configuration

The ServiceManager web service request of the Create type is named
CreateucmdbBusinessServiceRequest, however you have not configured it (or have commented
it out) in the smSyncConfFile.xml file.
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Error message

The data push job fails with a “Failed” status. From both the log file and the detail error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 212), you receive an error like the following:

Solution

In the error message find the TQL name for which a request namewas not found, and then in the
smSyncConfFile.xml file add the request name for the TQL name.

For instructions on how to configure a request for a TQL, see "How toMap the CI Type’s TQL
Query to an XSL Transformation File" on page 165.
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Wrong Service Manager WS Request Name Defined in
smSyncConfFile.xml

Sample configuration

The ServiceManager web service request of the Create type is named
CreateucmdbBusinessServiceRequest, however you have configured a wrong request name
CreateucmdbBusinessServiceRequest_wrongname in the smSyncConfFile.xml file.

Error message

The data push job is completed with a “Passed with failures” status. From both the log file and the
detailed error messages of the failed CIs in the Universal CMDB studio (see "How to Check the
Error Messages of Failed CIs/CI Relationships in a Push Job" on page 213), you receive an error
like the following:
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Solution

In the Transformed XML section of the error message, check the Request name (which is
configured as CreateucmdbBusinessServiceRequest_wrongname in this sample), andmake sure
that the request name specified in smSyncConfFile.xml is the exact name defined in theWSDL.

For instructions on how to configure a ServiceManager web service request for a TQL, see "How to
Map the CI type's TQLQuery to an XSL Transformation File" on page 183.

XSLT file not Well Formed
Sample configuration

The end tag of “instance” should be </instance>, however you have configured a wrong end tag
</instance_wrong_end_tag>.
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Error message

The data push job fails with a “Failed” status. From both the log file and the detailed error message
of the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 212), you receive an error like the following:

In addition, you can findmore detailed error message in the log file to see which XSLT file is not well
formed. You should see something like following:
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Solution

Search for text Not valid XSLT file to find the XSLT file name, and then validate the XSLT file in
an XML editor (for example, XMLSpy). You can easily find and fix any validation issues.

Wrong UCMDB Attribute Name in XSLT File
Sample configuration

The Universal CMCB attribute name is provider, however you have configured a wrong attribute
named provider_wrong.
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Error message

Youwill NOT get any error messages either in the log file or in the Universal CMDB studio, however
the Universal CMDB attribute value will not be pushed to ServiceManager.

Solution

If you find a UCMDB attribute value that cannot be pushed to ServiceManager, double-check the
UCDMB attribute name and ServiceManager field name of themapping in the XSLT file.

For instructions on how to configure an attributemapping, see "How toMap the CI Attribute to a
Web Service Field" on page 144.

Wrong Service Manager Field Name in XSLT File
Sample configuration

The ServiceManager field name is ServiceProvider, however you have configured a wrong
attribute named ServiceProvider_wrong in the XSLT file. This error also commonly occurs since
the attribute is case-sensitive.
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Error message

Youwill NOT get any error messages either in the log file or in the Universal CMDB studio,
however, the Universal CMDB attribute value will not be pushed to ServiceManager.

Solution

If you find a Universal CMDB attribute value that cannot be pushed to ServiceManager, check both
the Universal CDMB attribute name and ServiceManager field name of themapping in the XSLT
file.

For instructions on how to configure an attributemapping, see "How toMap the CI Attribute to a
Web Service Field" on page 144.

Empty Value for No Nulls Key in Service Manager
Sample configuration

In ServiceManager you have configured a NoNulls key for field “testnotnullfield” of the device
table, however you have not mapped this field in the XSLT file.
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Error message

The data push job is completed with a “Passed with failures” status. From both the log file and the
detailed error messages of the failed CIs in the Universal CMDB studio (see "How to Check the
Error Messages of Failed CIs/CI Relationships in a Push Job" on page 213), you receive an error
like the following.
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Solution

Find the key number in the <messages> section to see which NoNulls key has a NULL value. For
example, if you find amessage “Key #1 is empty”, check the first key definition of the device table
to see which field(s) this key is for, and thenmake sure that a non-NULL value has beenmapped to
the field(s) in the XSLT file.

For instructions on how to configure an attributemapping, see "How toMap the CI Attribute to a
Web Service Field" on page 144.

CI Logical Name Truncated or CI not Pushed due to
Logical Name Truncation

Sample configuration

The length of a UCMDB CI name exceeds 200 characters, which is themaximum allowed field
length for logical.name (CI Identifier) in ServiceManager. When this CI is pushed to Service
Manager, the CI name is truncated.

TwoUCMDB CIs have the sameCI name that is 200 characters in length. When the second CI is
pushed, it is supposed to be renamed if the DEMDuplication Rule is configured so; however, the
renamed logical namewill be truncated to be same as the first CI’s logical name. As a result, the
second CI will not be able to be pushed to ServiceManager due to an invalid duplicate key error.

Error message

You receive an error message that contains this string: This record contains an invalid
duplicate key.

Solution

Update the CI type’s XSL transformation file so that, before running a push, the integration can
make sure that all CI names are significantly less than 200 characters in length.

Service Manager Database Case-Sensitivity Issue
Sample configuration
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Your ServiceManager database is case-insensitive. You have two UCMDB CIs with a name of
CINAME1 and ciname1, respectively.

When running a push job to push these CIs, the integration considers the second CI a duplicate of
the first one, and therefore either renames it or returns an error according to the Duplication Rule
setting of the relevant DEM Rule record.

Solution

HP recommends using a case-sensitive ServiceManager database to avoid this issue.

Global ID and Customer ID Missing in XSLT
Sample configuration

You create an XSL transformation file for push without the following element:

<!--import:cmdb_root_attributes.xslt-->

The cmdb_root_attributes.xslt file contains Global ID and Customer ID, which are required for
data push:

<UCMDBId><xsl:value-of select="@id"/></UCMDBId>

<CustomerId><xsl:value-of select="@customer_id"/></CustomerId>

Error message

No error message occurs, however when you update or delete a CI record in UCMDB, the update or
deletion will not be pushed to ServiceManager.

Solution

In the XSL transformation file, include themissing element:

<!--import:cmdb_root_attributes.xslt-->

Troubleshooting Population Issues
When population errors or problems occur, you can check the error messages and the population
log file to identify the root causes and then solve the problems.

When a population job has failed, the job status becomes Failed. Troubleshoot the failed job as
follows:

l Check the error message of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Population Job" on the next page and "Typical
Error Messages and Solutions" on page 244.

l Check the log file for more details.
See "How to Check the Population Log File" on page 239.
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How to Check the Error Message of a Failed
Population Job

While a population job fails, you can check the detailed error messages in the Universal CMDB
studio.

To check the error message of a failed population job:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

3. Select the integration point for this integration.

4. Click thePopulation tab.

5. Select the failed job from Integration Jobs, and click the Job Errors sub-tab.

6. Double-click an error message from the list.
A pop-up window opens to display the error details. The following is a sample error message
about a non-existing XSLT file:
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How to Check the Population Log File
You can set the Development adapter log level to DEBUG to check the incoming CI XML file of
ServiceManager, and the XSLT-transformed XML file.

Tip: You are recommended to enable the Development Mode for the integration point so that
the above-mentioned two XML files are in a good format.

To set the adapter log level to DEBUG:

Universal Discovery Content Guide - ServiceManager Integration
Troubleshooting

Page 239 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



1. Log in to the UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation folder>\DataFlowProbe\conf\log
\fcmdb.properties file. For example:
C:\HP\UCMDB\DataFlowProbe\conf\log\fcmdb.properties

3. Open the fcmdb.properties configuration file in a text editor.

4. Update the log4j.category.fcmdb.adapters log level toDEBUG:

5. Save the file.

6. Wait a while for the change to take effect.

To enable the Development Mode of the integration point:

For detailed steps, see "How to Check the Push Log File" on page 217.

To check the population log file:

1. Log in to the UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation
folder>\DataFlowProbe\runtime\log\fcmdb.adapters.<integration_point_name>.log
file. For example: C:\HP\UCMDB\DataFlowProbe\runtime\log\fcmdb.adapters.SM
Integration.log

3. Open the log file in a text editor.

4. Search for text strings Source SM CI XML, Transformed XML, Source tree XML for ID
Pushback, Transformed XML for ID Pushback and Response message from SM For ID
Pushback. The log looks like the following:
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Typical Error Messages and Solutions
The following describes typical error messages that may occur during population, and their
solutions.

This section includes:

l "No TQLConfigured in smPopConfFile.xml " below

l "Non-Existing XSLT File NameDefined for a TQL in smPopConfFile.xml" on the next page

l "No “Retrieve” Type Request Defined for a TQL in smPopConfFile.xml" on page 246

l "Wrong Request Name of retrieveKeysQueryNameConfigured for a TQL in
smPopConfFile.xml" on page 247

l "Wrong Request Name of retrieveListQueryNameConfigured for a TQL in smPopConfFile.xml"
on page 248

l "XSLT File not Well Formed" on page 250

l "Wrong UCMDB Attribute Name in XSLT File" on page 251

l "Wrong ServiceManager Field Name in XSLT File" on page 252

l "Wrong Universal CMDB Attribute Data Type in XSLT File" on page 253

l "UCMDB CI Attribute sm_id not Mapped to the Right ServiceManager Field in XSLT" on page
254

No TQL Configured in smPopConfFile.xml
Error message

If you have not yet added a TQL to your job, you cannot select this TQL from the list while you
create/update your job.

If you have already added this TQL to your job before removing this TQL from smPopConfFile.xml,
you will get a “Failed” status while you run this population job. In addition, in the Universal CMDB
studio, you will get an error message like the following (see "How to Check the Error Message of a
Failed Population Job" on page 238):
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Solution

Search for text is not supported by this adapter to find the TQL name that has not yet been
configured, and then configure it in the smPopConfFile.xml file.

For instructions on how to add amapping to a TQL, see "How toMap the CI type's TQLQuery to an
XSL Transformation File" on page 183.

Non-Existing XSLT File Name Defined for a TQL in
smPopConfFile.xml

Error message

Youwill get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:
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Solution

Search for text No XSLT file is found to find the wrong XSLT file name, and then correct the
name in the smPopConfFile.xml file.

For instructions on how to configure an XSLT file name for a TQL, see "How toMap the CI type's
TQLQuery to an XSL Transformation File" on page 183.

No “Retrieve” Type Request Defined for a TQL in
smPopConfFile.xml

Error message

Youwill get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:

Solution
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Search for text No request was configured for operation to find the TQL name for which a
retrieve type request is missing, and then add themissing request name in the smPopConfFile.xml
file.

For instructions on how to configure a request for a TQL, see "How toMap the CI type's TQLQuery
to an XSL Transformation File" on page 183.

Wrong Request Name of retrieveKeysQueryName
Configured for a TQL in smPopConfFile.xml

Error message

Youwill get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:

Further more, you can findmore detailed error message in the log file that indicates which request of
retrieving CI keys is wrong. The following is an example:
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Solution

Search for text Web Service Request XMl For getting SM CI keys to find the wrong request
name, and then specify the right request name in the smPopConfFile.xml file for the TQL name.

For instructions on how to configure a request for a TQL, see "How toMap the CI type's TQLQuery
to an XSL Transformation File" on page 183.

Wrong Request Name of retrieveListQueryName
Configured for a TQL in smPopConfFile.xml

Error message

Youwill get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:
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Further more, you can findmore detailed error message in the log file that indicates which request of
retrieving CI list is wrong. The following is an example.

Solution
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Search for text Web Service Request XMl For getting SM CI List to find the wrong request
name, and then specify the right request name in the smPopConfFile.xml file for the TQL name.

For instructions on how to configure a request for a TQL, see "How toMap the CI type's TQLQuery
to an XSL Transformation File" on page 183.

XSLT File not Well Formed
Sample configuration

The end tag of “ci” should be </ci>, however you configured a wrong end tag </ci_wrong>.

Error message

If you have not yet created your integration point, when you create it an error message similar to the
following example will occur in the Universal CMDB studio or the log file, causing the creation to
fail.

If you have already created your integration point, but not yet activated it, you can no longer activate
it, because when you attempt to activate it you will get a detailed error message in the probe error
log file (probe-error.log), similar to the following example.

If you have created and activated your integration point, you will get a “Failed” status when you run
the population job. In addition, from both the population log file (see "How to Check the Population
Log File" on page 239) and the Universal CMDB studio (see "How to Check the Error Message of a
Failed Population Job" on page 238), you will get an error message similar to the following example.
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Solution

Search for text Got SAXException while parsing the XSLT file to find the name of the
problematic XSLT file, and then validate the file in an XML editor (for example, XMLSpy). You can
easily find and fix any validation issues.

Wrong UCMDB Attribute Name in XSLT File
Sample configuration
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The UCMDB attribute name is provider, however you configured a wrong attribute provider_
wrong. This error also commonly occurs since the attribute name is case-sensitive.

Error message

Youwill NOT get any error messages either in the log file or the Universal CMDB studio, however
the ServiceManager field value will not be populated to Universal CMDB.

Solution

If you find that a ServiceManager field value cannot be populated to Universal CMDB, check both
the UCDMB attribute name and the ServiceManager field name of themapping in the XSLT file.

For instructions on how to configure an attributemapping, see "How toMap the CI Attribute to the
Web Service Field" on page 179.

Wrong Service Manager Field Name in XSLT File
Sample configuration

The ServiceManager field name is ServiceProvider, however you configured a wrong attribute
ServiceProvider_wrong:
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Error message

Youwill NOT get any error messages either in the log file or the Universal CMDB studio, however
the ServiceManager field value will not be populated to Universal CMDB.

Solution

If you find that a ServiceManager field value cannot be populated to Universal CMDB, check both
the UCDMB attribute name and the ServiceManager field name of themapping in the XSLT file.

For instructions on how to configure an attributemapping, see "How toMap the CI Attribute to the
Web Service Field" on page 179.

Wrong Universal CMDB Attribute Data Type in XSLT File
Sample configuration

The data type of Universal CMCB attribute “provider” is String, however you configured a wrong
type Integer:
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Error message

The CIs will be populated to Universal CMDB, but the field value with a wrong data type
configuration will not be populated to Universal CMDB.

When you run the population job, you will get a “Failed” status. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message similar to the following:

Solution

Search for text The value "xxx" of field "yyy" is not to find the name of the attribute with a
wrong data type, and then specify the right data type in the XSLT file.

For instructions on how to configure an attribute data type, see "How toMap the CI Attribute to the
Web Service Field" on page 179.

UCMDB CI Attribute sm_id not Mapped to the Right
Service Manager Field in XSLT

The ServiceManager CI ID must bemapped to Universal CMDB CI attribute sm_id, since it is
used to push the Universal CMDB CI ID back to ServiceManager.

Universal Discovery Content Guide - ServiceManager Integration
Troubleshooting

Page 254 of 256HP Universal CMDB (UCMDB 10.10, CP 13.00)



Out-of-the-box, this attributemapping is configured in XSLT file cmdb_root_attributes_
population.xslt, which is imported by the other XSLT files as a common field mapping, and the
ServiceManager CI ID field is exposed as the caption CIName.

Sample configuration

If you configured themapping for sm_id in one of the following ways:

l You did not configure themapping for sm_id;

l You did not expose the ServiceManager CI ID field in the ServiceManager web service;

l You exposed the ServiceManager CI ID field with a caption other than CIName;

l The ServiceManager CI ID field was exposed in the web service as the caption CIName, but you
configured a wrong name (for example, CIName_wrong) in the XSLT file (see the following
figure).

Error message

When you run the population job, you will get a “Failed” status. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message similar to the following:

Solution
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Search for text The Universal CMDB attribute "sm_id" of CI type to find the CI type, and
then configure the attributemapping for this CI Type in the XSLT file.

For instructions on how to configure an attributemapping, see "How toMap the CI Attribute to the
Web Service Field" on page 179.
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